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Introduction

ou aren’t a dummy, of course. But here’s the deal: You don’t have to be

some sort of technogeek or financial wizard to manage your financial
affairs on a PC. You have other things to do, places to go, and people to meet.
And that’s where Quicken 2005 For Dummies comes in.

In the pages that follow, I give you the straight scoop on how to use Quicken
Premier for Windows, without a lot of extra baggage, goofy tangential infor-
mation, or misguided advice.

About This Book

This book isn’t meant to be read from cover to cover like some John Grisham
page-turner. Rather, it’s organized into tiny, no-sweat descriptions of how to
do the things you need to do. If you're the sort of person who just doesn'’t feel
right not reading a book from cover to cover, you can, of course, go ahead and
read this thing from front to back.

[ can recommend this approach, however, only for people who have already
checked the TV listings. There may, after all, be a SpongeBob SquarePants
rerun on.

How to Use This Book

I always enjoyed reading those encyclopedias my parents bought for my sib-

lings and me. I could flip open, say, the F volume, look up elephants, and then
learn just about everything [ needed to know about elephants for a fifth-grade
report: where elephants live, how much they weigh, and why they eat so much.

You won'’t read anything about elephants here, but you can use this book in
the same way. If you want to learn about something, look through the Table
of Contents or Index and find the topic — printing checks, for example. Then
flip to the correct chapter or page and read as much as you need or enjoy.
No muss. No fuss.

If you want to find out about anything else, you can, of course, just repeat the
process.
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What You Can Safely Ignore

Sometimes I provide step-by-step descriptions of tasks. I feel very bad that I
have to do this. So to make things easier for you, I highlight the tasks with
bold text. That way, you’ll know exactly what you’re supposed to do. I also
often provide a more detailed explanation in regular text. You can skip the
regular text that accompanies the step-by-step descriptions if you already
understand the process.

Here’s an example that shows what | mean:

1. Press Enter.

Find the key that’s labeled Enter. Extend your index finger so that it rests
ever so gently on the Enter key. In one sure, fluid motion, press the Enter
key by using your index finger. Then release the key.

Okay, that’s kind of an extreme example. I never go into that much detail.
But you get the idea. If you know how to press Enter, you can just do that
and not read further. If you need help — say with the finger depression part
or something — just read the nitty-gritty details.

Can you skip anything else? Let me see now. . . . You can skip the paragraphs
with the Technical Stuff icons next to them. See the “Special Icons” section,
later in this Introduction, for an example of the Technical Stuff icon. The infor-
mation I've stuck in those paragraphs is really only for those of you who like
that technical kind of stuff.

What You Should Not Ignore
(Unless Vou're a Masochist )

Don’t skip the Warnings. They’re the text flagged with the picture of the
nineteenth-century bomb. They describe some things you really shouldn’t do.

Out of respect for you, I'm not going to put such stuff in these paragraphs as
“Don’t smoke.” I figure that you're an adult. You can make your own lifestyle
decisions.

So I'll reserve the Warnings for more urgent and immediate dangers — things
akin to “Don’t smoke while you're filling your car with gasoline.”
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Three Foolish Assumptions

[ assume just three things:

v You have a PC with Microsoft Windows 95, Windows 98, Windows Me,
Windows 2000, Windows NT, or Windows XP.

v You know how to turn it on.

1 You want to use some flavor of Quicken 2005.

The Flavors of Quicken

Okay. [ lied in the previous section. I'm going to assume one more thing: You
own or somehow have access to a copy of Quicken.

You may be interested to know that Quicken comes in several versions. It
doesn’t really matter which one of the several versions you have. Each ver-
sion works in basically the same way, and this book applies to all of them.

But because each version has a few unique features, you may find that your
screen doesn’t look exactly like the screens shown in this book. You may, for
example, have a few buttons that you don’t see in the figures I show you. Don’t
worry if this happens. It probably means that you're working with a different
version than I am.

Just to let you know, [ used the Premier version to write this book. You can
determine this because at the top of some of the figures it says “Quicken 2005

Premier” in the application-window title bar. If you have a different version,
the title bar says something different at the top of your screen.

How This Book Is Organized

This book is organized into six mostly coherent parts.

Part I: Zen, Quicken, and the Big Picture

Part I covers some up-front stuff you need to take care of. [ promise I won’t
waste your time here. I just want to make sure that you get off on the right foot.
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Part II: The Absolute Basics

This second part of the book explains the core knowledge you need to know
in order to keep a personal or business checkbook with Quicken: using the
checkbook, printing, reporting on your finances, using online banking, bal-
ancing your bank accounts, and using the Quicken calculators.

Some of this stuff isn’t very exciting compared to Dr. Phil — which really is a
good show, isn’t it? — so I'll work hard to make things fun for you.

Part I11: Home Finances

Part Il talks about the sorts of things you may want to do with Quicken if
you're using it at home: credit cards, loans, mutual funds, stocks, and bonds.
You get the idea. If you don’t ever get this far — hey, that’s cool.

If you do get this far, you’ll find that Quicken provides some tools that elimi-
nate not only the drudgery of keeping a checkbook, but also the drudgery of
most other financial burdens.

While I'm on the subject, I also want to categorically deny that Part Il contains
any secret messages if you read it backward.

Part 1U: Sevious Business
The “Serious Business” part helps people who use Quicken in a business.

If you're pulling your hair out because you’re using Quicken in a business,
postpone the hair-pulling — at least for the time being. Read Part IV first. It
tells you about preparing payroll, tracking the amounts that customers owe
you, and other wildly exciting stuff.

Part U: The Part of Tens

By tradition, a For Dummies book includes “The Part of Tens.” It provides a
collection of ten-something lists: ten answers to frequently asked questions
about Quicken, ten ways not to become a millionaire, and ten tips for trou-

bleshooting Quicken when you encounter a problem.
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Part Ul: Appendixes

It’s an unwritten rule that computer books have appendixes, so I've included
two. Appendix A gives you a quick and dirty overview of Windows for those
new to the world of Windows. Appendix B is a glossary of key business, finan-
cial, and computer terms.

Conventions Used in This Book

To make the best use of your time and energy, you should know about the fol-
lowing conventions I use in this book.

When I want you to type something, such as Hydraulics screamed as the
pilot lowered his landing gear, | put it in bold letters. When I want you to
type something that’s short and uncomplicated, such as Hillary, it still
appears in bold type.

By the way, with Quicken, you don’t have to worry about the case of the stuff
you type (except for passwords, which are case sensitive). If I tell you to type
Hillary, you can type HILLARY. Or you can follow e. e. cummings’s lead and
type hillary.

Whenever [ describe a message or information that you see on the screen, |
present it as follows:

Surprise! This is a message on-screen.

Special Icons

Like many computer books, this book uses icons, or little pictures, to flag
things that don’t quite fit into the flow of things. For Dummies books use a
standard set of icons that flag little digressions, such as the following:

This icon points out nerdy technical material that you may want to skip (or
read, if you're feeling particularly bright).

Here’s a shortcut to make your life easier.
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This icon is just a friendly reminder to do something.
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And this icon is a friendly reminder not to do something . . . or else.

Where to Next?

If you're just getting started, flip the page and start reading the first chapter.

If you have a special problem or question, use the Table of Contents or the
Index to find out where that topic is covered and then turn to that page.
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In this part . . .

Wlen you go to a movie theater, some prerequisites
are necessary for the show to be truly enjoyable.
And I'm not referring to the presence of Angelina Jolie or
Will Smith. Purchasing a bucket of popcorn is essential,
for example. One should think strategically both about
seating and about soda size. And one may even have
items of a, well, personal nature to take care of — such
as visiting the little boys’ or girls’ room.

I mention all this stuff for one simple reason: To make get-
ting started with Quicken as easy and fun as possible, you
have to complete some prerequisites, too. And this first
part of Quicken 2005 For Dummies talks about these sorts
of things.




Chapter 1

Setting Up Shop

In This Chapter

Installing Quicken

Touring Quicken

Setting up your bank (or other) accounts if you're a first-time user

Retrieving existing Quicken data files

WMBER
@%
&

f you've never used Quicken, begin here. This chapter tells you how to
install Quicken (if you haven’t already) and how to start the program for
the first time. You also find out how you go about setting up Quicken accounts
to track banking activities — specifically, the money that goes into and out of

a checking or savings account.

If you've already begun to use Quicken, don’t waste any time reading this
chapter unless you want the review. You already know the stuff it covers.

By the way, if you have Windows, [ assume that you know a little bit about it.
No, you don’t have to be some sort of expert. Shoot, you don’t even have to
be all that proficient. You do need to know how to start Windows applications
(such as Quicken). It also helps immensely if you know how to choose com-
mands from menus and how to enter stuff into windows and dialog boxes. If
you don’t know how to do these kinds of things, flip to Appendix A. It provides
a quick-and-dirty overview of how you work in Windows. Read the stuff in the
appendix, or at least skim it, and then come back to this chapter.

When | say Windows, [ mean a recent version of Windows — something
Microsoft is either currently selling or has sold in the last few years. Quicken
2005 won’t run on Windows 3.1, so if you want to run the latest version, I'm
afraid it’s time to upgrade.

Installing and Starting Quicken

You install Quicken the same way that you install any program in Windows. If
you already know how to install programs, you don’t need any help from me.
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|
Figure 1-1:
The first
Quicken
installation
window.
|

Stop reading here, do the installation thing, start your newly installed Quicken
program, and then start reading the next section, “Finishing Setup If You've
Used Quicken Before.”

If you need help installing Quicken, here are the step-by-step instructions.
Installing Quicken from a CD-ROM is as easy as one, two, three, four:

1. Insert the CD-ROM into the CD-ROM drive.

In a short amount of time, Quicken should display the Quicken 2005
installation window, shown in Figure 1-1. Your window may appear
slightly different if you're installing some other version of Quicken than
Quicken Premier — which is what | am installing in Figure 1-1.

Note: If nothing happens when you put the CD-ROM into the CD-ROM
drive, don’t panic! First try removing the CD and then putting it in again.
If Windows still doesn’t recognize the CD, you need to tell Windows that
it should install your Quicken program. In many versions of Windows
(but not necessarily with your version), you do this with the Windows
Control Panel by using a tool called Add/Remove Programs. To do this,
refer to your Windows user guide or a good book about your version of
Windows (such as Windows XP For Dummies, written by Andy Rathbone
and published by Wiley Publishing, Inc.).

Welcome
J\ay"‘??\. B

‘Welcome to the installation for Quicken 2005

“welcome to the Quicken 2005 installation

2. Click Next.
Quicken then asks you a few questions:

¢ The first question is whether you accept the Quicken license
agreement.

¢ The next, as shown in Figure 1-2, asks whether you want to perform
an Express or Custom installation. Unless you want to spend time
figuring out which features you’ll use and muck about storing all
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the bits and pieces of Quicken in different places, go with the
Express installation.

¢ The installation program may also ask whether you want to install
the U.S. version or the Canadian version. Obviously, you're a patri-
otic guy or gal, and you want to install the version for your country.
(Even if you aren’t a patriotic guy or gal, install the version for your
country. Quicken uses different expense categories for the countries
because their taxes work differently.)

Type of Installation

Quicken 2005

Manage Your Personal Finances In One Place

Choose type of installation /‘gé

Select the type of installation you prefer, and then click Mext.

' Express Fiogram wil be installed with the most common options. Recommended for
most users.

- Quicken
- Installed to CARUICKENWY

You may choose the options you want ta install. Recommended for advanced

[ |
uzers,

Figure 1-2:
The Type of
Installation
dialoq bOX. < Back ’W‘ Cancel
|
3. Answer these three questions by clicking the appropriate buttons.
Click Next to move to the next question. Then click the Install Now
button when you answer the last question.
Quicken installs itself. This process takes a few minutes. Along the way,
you see several screenfuls of messages, including marketing information
about the features new to Quicken 2005 and some progress reports on
the installation itself.
V?‘“\NG! If you're upgrading from an earlier version of Quicken to Quicken 2005,
& the installation program also displays a message at the start of the
installation. It says that if you install Quicken 2005 in the same default
quickenw directory, it’ll need to uninstall the current version of Quicken.
Because this uninstallation of “old” Quicken is sort of a big deal — what
if you want to use the old Quicken? — the installation program asks you
® to confirm this bit of minor risk-taking.

When in doubt about some installation option, just accept the default
suggestion by pressing Enter.

11
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After the installation is complete, Quicken displays an installation com-
plete message.

4. Click Finish.

Congratulations. You're done.

After you install Quicken, you need to start it to finish the setup process. If
you told the installation program to launch Quicken 2005, you should see the
Quicken program window on your screen. If you didn’t tell the installation
program to launch Quicken, you need to start Quicken.

The easiest way to start Quicken is to double-click the Quicken shortcut icon
that (post-installation) appears on your Windows desktop. The Quicken pro-
gram window appears, almost like magic.

Finishing Setup If You've Used
Ouicken Before

If you've used a previous version of Quicken, the Quicken program might
show option buttons to indicate what you want to do next: Open the found
data file. (Alternatively, you can also indicate that you want to open some
other data file.) You're done. You're ready to begin Quicken-ing.

Finishing Setup If You Haven'’t
Used Quicken Before

If you haven’t used Quicken before — or if you have but you want a fresh
start and a fresh set of accounts — you need to set up a new data file. (A data
file is the place where all your financial records are stored.) What happens
next depends on whether you’'ve used Quicken before:

v If you haven’t used Quicken before, Quicken automatically sets up a data
file for you (you don’t need to worry about it) and starts the Quicken
Guided Setup (see Figure 1-3). This Guided Setup process walks you
through the steps for setting up the Quicken data file. (You can find out
much more on this process in the next section.)

v If you have used Quicken before, Quicken asks you to name the new data
file (using a familiar-looking dialog box named something like Create
New Data File), and then it starts the Quicken Guided Setup, as shown
in Figure 1-3.
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[ Quicken Guided Setup
1. Welcome Welcome to Quicken Guided Setup
2. About You . .
Before you start using Quicken...
3. Set Your Goals Guicken Guided Setup helps you get the most from Guicken. After you select your financial goals, Guicken Guided
Setup leads you through a personalized setup process so that you set up only the parts of Quicken vou need to
4, Add Accounts mest vour goals.
Cash Flow
Quicken Guided Setup will help you:
Investments Enter some basic information about yourself,
Select your financial goals,
Property & Debt Set up the parts of Quicken you need to meet your goals.
Paycheck
Bills

5. SetpSummary [T

|
Figure 1-3:
The Quicken
Guided
Setup
window.

Running the Quicken Guided Setup

Okay. Here’s the deal. The Quicken Guided Setup walks you through a three-
step process that asks about your personal financial affairs as well as a few
other questions. (You walk through the steps by clicking the Next Step button
in the lower-right corner of the window.)

The first step asks you to provide some personal information: your name, your
spouse’s name, your birth date, number of dependents, and so on. You're
also asked whether you own a home, invest in rental property, or run a small
business. Figure 1-4 shows the window that collects this information. Answer
the questions by typing information into the appropriate boxes or clicking
the appropriate buttons. That’s it. Simple stuff.

The second step asks you to check boxes that correspond to financial manage-
ment tasks you want to accomplish with Quicken (see Figure 1-5). (You can
check as many boxes as you want, but at a minimum, you want to check the
Manage My Checkbook and Bills box.)
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|
Figure 1-4:
The Tell Us
About
Yourself
window.
|

|
Figure 1-5:
The What
Do You Want
To Get Out
Of Quicken?
window.
|
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[ Quicken Guided Setup
1. Welcome About You
2, About You
Tell us about yourself
3. Set Your Goals This information will be used to personalize Guicken and to generate categories that best fit your needs,
4, Add Accounts -
First Last
Cash Flow Your Mame: [steve [etean
Investments
Your Birth Date: 11/26]1959
Property & Debt
Paycheck Are you martied? « ves Mo
Bills First Last
Spouse's Name: Susan Nelson
5, Setup Summary = |
Spouse's Birth Date:  [4/B/1956
How many dependents do vou haves z 5
Do you own a home? {+ ‘es " Mo
Do you own any rental properties? ™ Ves * Mo
Do you want ta use Quicken ko track a business? (+ Yes " Mo
Your Comparry Name: | Stephen L. Nelsan, CPA) (Optional)
"
Exit Setup Wakch Quicken Tour ‘ | { Previous Step | | Mexk Step b |
[Ed Quicken Guided Setup
1. Welcome Set Your Goals
2. About You .
What do you want to get out of Quicken?
3. Set Your Goals
B uicken Guided Setup uses this icon ko highlight the areas of setup that are most important for addressing
4, Add Accounts your goals,
Cash Flow = Information about setup that relates to your goals will appear in a box like this one.
Investments -
I want Quicken to help me:
Property & Debt S b
Paycheck [+ Manage my checkbook and bills.
~ Use Quicken to balance your checkbaook,
Bills = Have Quicken remind you when bills are due.
5. Setup Summary ¥ Know where my money is qoing.
Identify how much vou spend in areas like housing and entertainment.
Save time by downloading transactions Fram your bank and cateqgarizing them autamnatically.
[ save more money.
See how you're spending your money and identify areas where you can save,
Create a budget ko manage and meet your savings goals.
I Track all of my investments in one place.
Track the value and performance of all your investments.
Save time by downloading transactions and haldings information From your brokerage.,
I~ Get out of debt.
Track &ll of your debts {including home and car loans, credit cards, and other liabilities).
Create a plan and timeline for becoming debt free,
[~ Make tax preparation easier.
Cateqgorize tax-related expenses so you avoid surprises at bax kime.
Save time by linking Guicken to TurboTax to prepare your taxes,
"

Wakch Quicken Tour ‘ | { Previous Step | | Mexk Step b |

Exit Setup
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|
Figure 1-6:
The Add
Cash Flow
Accounts
window.
|

The third step — and this one is key — provides buttons that you click to
describe the accounts that you want to manage with Quicken, as shown in
Figure 1-6.

Now I need to explain something here. The Quicken Guided Setup assumes
that you're going to set up everything you need or will ever need in Quicken
all at once and in the beginning. You can do that if you want, but that’s not
my suggestion. You can easily add stuff later, when you want it, so [ suggest
that you set up your principal checking account or accounts in the beginning.
(Yes, like right now when you and I are talking about this stuff.) Later on, if
you want to set up credit card accounts or manage your investments or track
a rental property, you can quickly set up the accounts and other stuff you
need then. Sound okay? (I do explain how to set up these other accounts in
other chapters.)

My reasoning for this suggestion is that I'd like you to have some experience
working with Quicken before you go hog wild. Focus first on those personal
accounting tasks that you absolutely will want to perform. This approach gets
you started working with Quicken — happily, productively, and successfully —
from day one. If you want to do more in a week or a month or a year, great.
You can easily do more tasks, and by then, you’ll know so much more about
Quicken that adding these other tasks will be a snap.

[ Quicken Guided Setup
1. Welcome Cash Flow
2. About You
Add cash flow accounts
3. Set Your Goals
EEBased on the goals you selected, make sure you include accounts you use ko:
4. Add Accounts Frequently write checks and pay bills.
cash Flow Gl Manage daily expenses, such as credit cards,
Investments
Add every cash flow account that you want to track in Quicken.
Property & Debt
Paycheck Checking Add Account Accounts you use ko pay bills or make ATM withdrawals From,
Bills Gial
Savings Add Account ACCOUNES you use ko save money, such as standard savings accounts
2. Setup Summary at your bank ar credit union.
Quicken Credit Card Add Accounk Track your existing Quicken Credit Card (YISA® or Mastercard®)
transactions.
Apply Mow Know where you're spending your money with virtually no
manual data entry. Learn more.
Other Credit Card Add Account Use these accounts to track credit card spending,
Cash Add Account Use this account ko track the cash you spend.,
Exit Setup | ‘ Einish Later | Watch Quicken Tour ‘ | 4 Previous Step | | Mexk Step (B |
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Setting up an account with
the Guided Setup

To set up an account for your principal checking account from within the
Quicken Guided Setup, display the Add Cash Flow Accounts window (refer to
Figure 1-6) by clicking the Cash Flow label, if necessary. (This button appears
on the left edge of the Quicken window and is cleverly labeled, “Cash Flow.”)
Then follow these steps:

1. Click the Add Account button that’s next to the Checking label.
Quicken displays the Quicken Account Setup dialog box (Figure 1-7).

Quicken Account Setup

What is the financial institution for this account?

% This account is held at the following institution:

|
Figure 1-7:
The first
Quicken
Account
Setup dialog
box.

" This account iz not held at a financial institution.

2. Identify the financial institution — usually a bank — by typing your
institution’s name into the text box provided.

As you type, Quicken displays a list of financial institutions that match
what you’ve typed so far. The more you type, the shorter the list of pos-
sible matching institutions. If you see your bank or whatever listed, select
it. If you don’t see your bank listed, mark the This Account Is Not Held
At A Financial Institution button.

When you click Next, Quicken displays the third Quicken Account Setup
dialog box, as shown in Figure 1-8.

3. Tell Quicken whether you want to use the online setup for your
account or manually set up your account.

For most banks, the third Quicken Account setup dialog box looks like the
one shown in Figure 1-8. This dialog box suggests that you let Quicken set
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|
Figure 1-8:
The third
Quicken
Account
Setup dialog
box.
|

up your account by directly connecting to the bank’s computer system.
But, in a gesture of courtesy, Quicken also admits that you can manually
set up the account. I'm going to suggest, since you’re just starting out, that
you set up your account manually. You have plenty of time later on to
find out how online banking works. (Online banking is really cool, though.
Refer to Chapter 6 for more information.) To indicate that you’ll manu-
ally set up your account, select the Manual button and then click Next.

Quicken Account Setup

How do pou want to set up your U.5. Bank [PFM Direct Connect] account(s)?

" Online: Let Quicken set up my accounts and download informstion. [Recommended.]
@ Manual: Set up my accounts by entering information marualy.
IF you shaose this option you can download later
Download Availability
-U.5. Bank [PFM Direct ... offers Quicken download for the following accounts:

= Banking + Credit Card
- Get your Customer 1D and PIM the same day.

Leamn more about downloading pour accounts.

FETR -

4. Tell Quicken the name you want to use for the checking account. Then

click Next.

You do so by typing a name in the Name This Account text box, as shown
in Figure 1-9. By the way, you can be as general or as specific as you want.
But remember, brevity is a virtue; be as concise as you can. The reason
is that Quicken uses your account name to label stuff within the Quicken
window and on Quicken reports. If you use a long account name, the name
may not always fit on reports and screens.

. Enter the ending bank statement date by referring to your bank

statement.

When Quicken asks for the ending statement date, enter the date of your
last bank statement. This date, by the way, is when you will start using
Quicken. Enter the date in MM/DD/YYYY fashion. Figure 1-10 shows the
dialog box that Quicken uses to ask for this information.

“Geez, Steve,” you're now saying to yourself, “what’s MM/DD/YYYY
fashion?” Okay. Here’s an example. If your bank statement is dated
June 2, 2005, type 06/02/2005, or you can type 6/2/2005.

17
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|
Figure 1-9:
The first
Quicken
Account
Setup dialog
box you use
to provide
checking
account
information.
|

|
Figure 1-10:
The second
Quicken
Account
Setup dialog
box used

to provide
checking
account
information.
|

Quicken Account Setup
Tell us about this checking account
Mame this account Checkind
= [
Quicken Account Setup

Enter the ending date and balance from pour statement. if you have it

B Enter the ending date on the statement.

Statement Date: 5/12/2006

B Enter the ending balance on the statement.
Ending B alance: 4.16
This becomes the opening balance of your Guicken account

Dion't worry if you den't have your last statement - yau can make shange s to yaur accaunt later.

= )|

6. Enter the ending bank statement balance by referring to your bank

statement.

This balance is whatever appears on your bank statement. This balance
is also the amount of money in your account on the date you begin your
financial record keeping. If you have $4.16 in your checking account,
type 4.16 into the Ending Balance text box.

7. After you type the bank statement balance, click the Done button.

Quicken removes the Checking Account Setup dialog box and redisplays
the Add Cash Flow Accounts version of the Quicken Guided Setup window
(refer to Figure 1-6). If you want to add another account, simply repeat

Steps 1 through 6.
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|
Figure 1-11:
The Quicken
Home
window.
|

8.

After you add the accounts you need — and, again, I think you can
start with one or, if you really want, two — click the Next Step button
to continue moving through the Guided Setup.

Eventually, you really do finish, although you need to click Next Step
another four or five times, depending on how much stuff you've said you
want to do with Quicken from the get-go.

Click Done and OK.

Quicken will ask you whether you want to set up other accounts for
tracking your debts and maybe even your investments. But you know
what? Go ahead and skip setting up this other stuff for now. I recommend
keeping stuff simple in the beginning. If all you ever do with Quicken is
track your bank accounts, you get about 90 percent of the value of the
product anyway. And you save yourself a bunch of work.

In the end, voila! The Quicken Home window appears, as shown in
Figure 1-11.

Quicken 2005 Premier - qdata2 - [Quicken Home] ==
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help

|‘ [ ﬂ 'i,l ’;.- "‘I"’. "”.- ﬁl Nuicken Home

Create Mew View  How Do I?
/| Cash Flow Center Welcome, Steve & Susan
Checking 0.00
$0.00 Alerts Dptions
¥/ | Investing Center ‘fou currently have no alerts
$0.00 Show all alerts | | Set Up Alerts
)| Property & Debt
#0.00 Bills and Scheduled Transactions Options
Scheduling your
FECUFHNG payments
and deposits allows
Quicken to remind
you when they are
coming due,
Add a bill o other
scheduled
transaction.
Manage Full List | Add a Transaction ‘ Set Up Paycheck | G0 ko Cash Flow Center ‘
Mexrt Steps to Meet Your Financial Goals Options * Online Updates -
Finish setting up Quicken: One Step Update
RIS T Enter your bills with Quicken Guided Setup, 4
et Yor A Remember to secure your data with a file password. Mever connected.
Financial Overview & Go to the Cash Flow Center Sthedule Updates -
Customize Hide Amounts Pay vendors online the easy way - Quicken Bill Pay

Update  Reports Setup Services Quicken.com Cuskomize
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The best way to get started

Quicken wants you to use your last bank state-
ment to set up the bank account you track. This
way, your financial records synchronize with
the bank's records when you start using Quicken.

But | want to suggest something slightly differ-
entto you. Go back further than just to the begin-
ning of the previous month (which is what you
do when you use your last bank statement). Go
back to the beginning of the year and use the last
bank statement of the previous year — even
if it's now several months after the beginning
of the year. Now, I'm not trying to waste your
time. But let me point out two big advantages
to having a complete year's data in Quicken:

Tracking and tallying your tax deductions will be
a snap, and planning your finances will be easier.
As you enter the activity, be sure to enter any
outstanding checks or deposits from the prior
period with their correct dates also. That way,
they will be there to check off when you do your
first Reconcilement.

Going back to the beginning of the year isn't as
hard as you might think. Quicken provides a
bunch of tools to help you enter several months’
worth of data in a very short time, as you can
see in this chapter and in the two or three that
follow.

Steve’s Overview

You don’t need to know much about the mechanics of the Quicken interface —
the way its windows work — to begin working with Quicken, especially in any
chapters in this book in which I cover the basics. I provide plenty of detailed
instructions, but [ have a couple of quick comments now.

Starting Quicken for the second time

The second time you start Quicken — and every subsequent time — things
work pretty much the same way as the first time. Double-click the Quicken
icon on your desktop. Or, if you like doing things the hard way, click Start and
then choose Programs=>Quicken 2005.

Ouicken changes the way its
document windows look

Quicken doesn’t use document windows the way that some other Windows
applications do. Quicken basically turns document windows into pages that
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you leaf through by clicking the window buttons that appear along the left
edge of the program window. In Figure 1-11, for example, you see buttons for
Cash Flow Center, Investing Center, and Property & Debt. Go ahead and turn
back to that page. I'll just wait here for you until you get back.

A few words about financial activity
centers’ QuickTabs

Quicken arranges all of its features — whistles, bells, or whatever else you
want to call them — into financial activity centers. For example, the Cash Flow
Center, the Investing Center, and the Property & Debt Center are all financial
activity centers. You get the picture. Each of these centers gets its own button.
For example, refer to Figure 1-11 for a moment. See the button that’s labeled
Cash Flow Center?

Quicken lists the features within a financial activity center underneath the
financial activity center button. You can collapse and expand this list by
clicking the small button that’s just to the left of the big financial activity
center button. (The small button shows a picture of an arrowhead.) You can
also jump to a listed feature by clicking the feature — which Quicken calls a
QuickTab. For example, see the Cash Flow Center button in Figure 1-11? See
the word Checking beneath that button? Checking is a QuickTab, which you
can click to quickly jump to the Checking account.

If you're still confused, click the buttons and bits of text in the area of the
Quicken window that I'm talking about. You’ll clearly see how things work.

Solving Tricky Setup Problems

[ want to quickly go over a handful of annoying setup problems new Quicken
users may encounter. If you've got Quicken set up and are ready to roll, skip
this stuff.

Did somebody say Macintosh?

You can use the existing old Quicken files you’ve been working on with a
new version of Quicken. In fact, if the Quicken installation program can find a
version of old Quicken files on your computer, it gives you the option of just
skipping all the Quicken Guided Setup stuff. In this case, you just begin using
your existing files. (I mention this point earlier in this chapter, in fact.)
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|
Figure 1-12:
The Open
Quicken File
dialog box.
|

If you’ve been using Quicken for Macintosh, however, you have to export your
data from the Macintosh before you can read it in the Windows version. And I
can think of about a million things more fun to do than exporting Quicken data
from a Mac to Windows. See the section in Chapter 17 on importing data from
an old accounting system for a brief discussion on the procedure and some
suggestions for better ways to spend your time.

The mysterious case of the missing
Quicken data files

If Quicken doesn’t find the old files, you need to open the specific files. But if

you have this problem, you should be able to solve it yourself. What has hap-
pened, if you find yourself in this boat, is that you've moved or messed around
with the Quicken files with some other program, such as Windows Explorer. If
you did that, presumably you had a reason. And more to the point, you should
know where you put the files.

Using the Filec>Open command

You can use Filer>Open to select and open your existing Quicken files.
Here’s how:

1. Choose File=>Open from the menu bar by using your mouse (or you
can press Ctrl+0).

Figure 1-12 shows the Open Quicken File dialog box that appears after
you choose the command. Quicken uses this dialog box to ask the burn-
ing question, “Hey, buddy, what file you wanna open?”

E

Open Quicken File &)
Look in: |_}Quwckem j =k B

A, CIBACKUP

I_;.ﬁ Business

My Recent DUMMIES
et DUMMIESEKR

9 qdata
qdataz

Desktop

My Documents

My Computer
.i) File: narme: ‘ j ok
B
My Network  Files of type: | Buicken Files [*A0F:"GDB:%00T) | Cancel
Places
Help
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2. Tell Quicken in which folder the files are stored.

If the correct folder isn’t the one already shown in the Look In box in the
Open Quicken File dialog box, tell Quicken what the correct folder is.
Click the down arrow to the right of the Look In box. After you do,
Quicken drops down a list of the disk drives and folders your computer
has. (This is why the little Look In box is called a drop-down list box.)

From the list of drives and folders that appears, click the one that stores
your Quicken files. Quicken closes the drop-down list box and displays
your selection in the list box beneath the Look In box.

3. Select the file from the list box.

After you tell Quicken on which disk and in which folder you stored your
data files, the files in that location appear in the list box. Just click the
file you want.

4. Click OK after you find the file.

Quicken opens the file and displays the active account in the register
window. (Quicken also displays its Reminders window to show any
unprinted checks or scheduled transactions.)

Note: If the file you’re opening was created in a previous version of
Quicken, Quicken converts the data to the Quicken 2005 format.

What if you can’t find the Quicken file?

Uh-oh. This is a problem. But don’t worry. You’re not out of luck. You need to
look through all the folders on your hard drive. Or, if you have more than one
hard drive, look through all the folders on all your hard drives.

Fortunately, you can do this by using the Windows Find tool, also known as
the Windows Search tool. (The command name varies in different versions of
Windows.) Here’s how:

1. Click the Start button and then choose Search=>For Files Or Folders.

2. When Windows displays the Search Results window, type *.qdf in the
Search For Files Or Folders Named box and click the Search Now
button.

The list box on the right side of the Search Results window displays a
list of Quicken files — one of which will be the data file you lost.

By the way, maybe I should bring up a point here. If you're a new user, your
best bet is really to just go with whatever an application program (such as
Quicken) suggests. If Quicken suggests that you use the QUICKEN directory —
this is the suggestion for Windows versions of Quicken, by the way — just

do it. If Quicken suggests that you use drive C, just do it. If Quicken suggests
that you take all your money, put it in a coffee can, and bury the can in your
backyard. . .. Whoa, wait a minute. Bad idea.
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Maybe I can suggest a better rule. Hmmm. . . . How about this? Although you
shouldn’t follow suggestions blindly, you also shouldn’t ignore the Quicken
program’s suggestions unless you have a good reason. And “Just because,”
“I don’t know,” and “For the heck of it” aren’t very good reasons.

Migrating from Microsoft Money

Suppose that you're moving from Microsoft Money to Quicken. The question
of the hour is this: Can you reuse your old or existing Money files in Quicken?
The answer is, “Yes, sort of.”

Theoretically, you can do this by exporting your Money data file to a QIF file.
You can refer to the Money Help file or documentation to get instructions
about how to export your Money data file. You can then import this QIF file
into Quicken by using Quicken’s Import command. Choose File> Import>QIF
File, identify the file, and then follow the on-screen instructions.

Practically, however, moving financial information from Quicken to Money or
vice versa doesn’t work all that well. Transactions seem to get lost. Account
balances get messed up. People ruin their lives. Well, maybe that last comment
is a slight exaggeration. But, no kidding: Migrating is problematic. If you do
want to move from one program to another, [ suggest making sure that you
have a really good reason for doing so and that you allow yourself enough
time to track down and correct any errors.



Chapter 2
Introduction to the Big Picture

In This Chapter

Distilling Quicken down to its very essence

Setting up additional bank accounts
Adding categories

Removing categories

Modifying categories

Understanding classes

Before you spend a bunch of time and money on Quicken, you have to
understand the big picture. You need to know what Quicken can do.
You need to know what you want to do. And, as a practical matter, you need
to tell Quicken what you want it to do.

Boiling Quicken Down to Its Essence

When you boil Quicken down to its essence, it does six things:

It lets you track your tax deductions.

This feature makes preparing your personal or business tax return
easier for you or your poor accountant, Cratchit.

1~ It lets you monitor your income and outgo either on-screen or by
using printed reports.

Usually, this stuff is great fodder for discussions about the family finances.
v It lets you print checks.

This device is mostly a timesaver, but it can also be useful for people
who are neat freaks.

v~ It lets you track the things you own (such as bank accounts, invest-
ments, and real estate) and the debts you owe (such as home mortgage
principal, car loan balances, and credit card balances).

These things are really important to know.
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v~ It helps you make better personal financial planning decisions about
such matters as retirement, your children’s future college costs, and
your savings and investments.

[ think this stuff is really neat.

1~ It gives you the opportunity to pay bills electronically and, in some
cases, even do all your banking electronically.

This stuff is pretty neat, too. No, let me amend that. Online bill paying and
banking is really neat. I do have some minor (very minor) reservations
that [ discuss in Chapter 6, which deals with online banking in depth.

Tracking tax deductions

To track your tax deductions, make a list of the deductions you want to
track. To do so, pull out last year’s tax return. Note which lines you filled in.
(Perhaps mortgage interest, property taxes, state income taxes, and charita-
ble contributions?) This method works because there’s a darn good chance
that the tax deductions you claimed last year will also be the tax deductions
you’ll claim in the future.

I cover the Quicken categories, which you use to track your tax deductions, a
little later in this chapter.

Monitoring spending

At our house, we (my wife, Sue, and I, your humble author) use Quicken to mon-
itor our spending on the mundane little necessities of life: groceries, clothing,
dog food, cable television, and, well . . . you get the picture. To keep track of
how much we spend on various items, we also use the Quicken categories.

If you want to monitor a particular spending category, decide upfront what
the category should be before you begin recording your data.

Your list of spending categories, by the way, shouldn’t be an exhaustive list
of superfine pigeonholes, such as “Friday-night Mexican food,” “Fast food for
lunch,” and so on. To track your spending on eating out, one category named
something like “Meals” or “Grub” usually is easiest.

In fact, 'm going to go out on a limb. You can probably get away with a dozen
categories, more or less:

v Car
v Clothing

v Entertainment and vacation
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v Groceries

v Household expenses (besides food)

v Insurance

1 Medical and dental

+* Rent (or mortgage payments)

v Taxes

v~ Utilities (electric, water, cable television)

v Work expenses

If you want to, of course, you can expand this list. Heck, you can create dozens
and dozens of categories. My experience, though, is that you’ll probably use
only a handful of categories.

Printing checks

You can use Quicken to print checks. This little trick provides a couple of
benefits: It’s really fast if you have several checks to print, and your printed
checks look very neat and darn professional.

To print checks, you need to do just two things. First, look through the check
supply information that comes with Quicken and pick a check form that suits
your style. Then order the form. (The check forms that come with remittance
advices — or check stubs — work well for businesses.)

Preprinted check forms aren’t cheap. If you’re using Quicken at home with
personal-style checks (such as those that go in your wallet), using computer
checks may not be cost effective. Even if you're using Quicken for a business
and you're used to buying those outrageously expensive business-style checks,
you’ll still find computer checks a bit more expensive.

I'm pretty much a cheapskate, so I don’t use printed checks at home (although
[ do use them in my business). [ should admit, however, that I also don’t write
very many checks.

By the way, I've “checked” around. Although you can order Quicken check
forms from other sources (such as your local office supplies store), they're
about the same price from Intuit (the maker of Quicken). If you want to order
from Intuit, you can refer to the catalog that came in the Quicken packaging.
You can also visit Intuit’s Web site, Quicken.com (www.quicken.com).

One other comment here about printing checks: If you're going to pay bills
electronically, you don’t need to print checks with Quicken. Oh, sure, you can
print checks if you want. But you won’t want to. Paying some bill electroni-
cally is easier and cheaper than paying a bill with a Quicken-printed check.
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Tracking bank accounts, credit cards,
and other stuff

You must decide which bank accounts and credit cards you want to track. In
most cases, you want to track each bank account you use and any credit card
on which you carry a balance.

You may also want to track other assets and liabilities. Assets are just things
you own: investments, cars, a house, and so on. Liabilities are things you owe:
margin loans from your broker, car loans, a mortgage, and so on.

Shoot, | suppose that you could even track the things your neighbor owns —
or perhaps just those things you especially covet. 'm not sure that this is a
very good idea, though. (Maybe a healthier approach is to track just those
things that you’ve borrowed from your neighbor.)

Planning your personal finances

Your computer’s computational horsepower makes it the ideal tool for doing
complicated calculations. So maybe you’re not surprised that Quicken comes
with six powerful calculators that let you make smarter borrowing choices,
better mortgage-refinancing decisions, more accurate savings and investment
calculations, and extremely helpful retirement and college savings calculations.

[ believe that these financial planning tools are the most valuable features
that Quicken offers. I'm just sorry that I have to wait until Chapter 10 to talk
about them.

Banking online

If you want, you can tell Quicken that it should do the work of paying some
person or merchant electronically. In other words, at the same time that you
describe some check to Quicken — you do so by entering stuff into a window —
you can say to Quicken, “I not only want you to record this check for me, I also
want you to pay it for me.”

If your bank supports online banking, you may also be able to move money
between your accounts and get up-to-date statements electronically. Ask your
bank for details about this service if you're interested.

To perform this sort of online banking, you need to have an Internet connec-
tion, and you need to do a little bit of paperwork. But the Quicken Online
Banking features can save you scads of time. And the features are easy to use.
Basically, all you do is use Quicken in the usual way — which is what I talk
about in the chapters that follow — and then click a couple of extra buttons.
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Setting Up Additional Accounts

|
Figure 2-1:
The Cash
Flow Center.
|

When you first began working with Quicken — and this may have only been
a few minutes ago or several years ago — you were prompted to set up an
account. And you probably set up at least a checking account because this is
probably your most active bank account. If you want to track any additional
accounts — for example, a savings account — you must set them up, too.

Setting up another banking account

To set up an additional checking, savings, or money market account, you give
the account a name and then its balance as of a set date. Here’s how:

1. Display the Cash Flow Center by clicking the Cash Flow Center button
on the left edge of the window.
Quicken displays the Cash Flow Center, shown in Figure 2-1.

2. Click the Add Account button.

The Add Account button appears beneath the Spending & Savings
Accounts heading. When you click this button, Quicken displays the
Quicken Account Setup dialog box, shown in Figure 2-2.

Quicken 2005 Premier - gdataZ - [Cash Flow Center] ==
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help

@ G da P - =2

Back  Update Reports  Setup  Services Quicken.com Custamize

Quicken Home ﬁj Cash How Center My Data l Analysis & Reports

How Do I#
- _— )y ~
= SEEnE Cash Flow Alerts Options * Online Updates -
Checking 0.o0 You currently have no cash Flow alerts
s000
Show all alerts | | Set Up Alerts Mever connected.

= | Investing Center
Schedule Updates

$0.00 spending & Savings Accounts Options ¥
)| Property & Debt Account MinBal IntRate  Current Balance Ending Balance| | Save time --
spending download from your brokerage,
$0.00 "
Checking 0.00 Mok Set 0.00 4.16 Set Up Now
Subtotal 0.00 +.16
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Total 0.00 +.16 S M T WIT F 5
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Cash Flow Services

Scheduling your
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s L . you when they are
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Customize Hide &mounts Pay bills online the easy way - Quicken Bill Pay
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Quicken Account Setup

What is the financial institution for this account ?

& This account is held at the following institution:
[Big Marmmath Eank

" This account is nat held at & financial institution
Figure 2-2:
The first
Quicken
Account
Setup dialog
box.

3. Identify the financial institution and click Next.

To identify where you’re banking, enter your institution’s name into the
This Account Is Held At The Following Institution box.

4. Yet again, identify the financial institution and then click Next.

If you see your bank listed, click its name on the list. If you don’t, click
the None Of These button, which tells Quicken to use your original name,
and then click Next.

At this point, Quicken may ask whether you want to set up your account
manually or use an online setup. You want to set up your account manu-
ally, so make this indication if you're asked. (Quicken typically asks the
“manual versus online” question if you select a financial institution that
allows for online banking, something I talk about more in Chapter 6.)

5. Select the type of account by clicking one of the account buttons and
then click Next.

When Quicken displays the next Quicken Account Setup dialog box,
shown in Figure 2-3, tell Quicken which type of account you want to set
up by clicking one of the account buttons. I'm assuming that, at this
point, you want to set up either a checking or savings account. After
you identify the account type, click Next.

6. Name the account and then click Next.

Move the cursor to the Account Name text box and type a name in that
box. Click Next after you do this. You're almost done.

7. Enter the account balance date.

When Quicken displays the dialog box shown in Figure 2-4, enter the
date that you're going to start keeping records for the bank account with
Quicken. (Quicken wants you to start your record keeping for an account
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|
Figure 2-3:
Another
Quicken
Account
Setup dialog
box.
|

|
Figure 2-4:
The final
Quicken
Account
Setup dialog
box.
|

on a bank statement date because on a bank statement date you have a
really good bank statement balance from the bank.) Move the cursor to
the Statement Date text box and type the month number, a slash, the
day number, a slash, and the year number. If you start on May 12, 2005,
for example, type 5/12/2005. Or, if this is way too complicated for you,
click the button at the end of the Statement Date text box so that Quicken
displays a pop-up calendar. Then click the date. Use the << and > buttons
to move back and forth a month at a time

Note: If you want to keep your transaction records for tax purposes, of
course it makes sense to track whatever accounts you can from the first
of the year, assuming that you have all the necessary statements or your
own records of all the transactions.

Quicken Account Setup

Choose the type of account to add.

" Checking
Accounts vou uze to pay billz or make ATM withdrawals from.

i+ Sawvings

Accounts vou uze to save money, such as standard savings accounts at your bank. or
credit union.

" Credit Card
Use these accounts to track credit card spending,

" cash
Use thiz account to track the cash you spend.

]

Quicken Account Setup

Enter the ending date and balance from your statement. if you have it

B Enter the ending date on the statement,

Statement D ate: 5/12/2006

B Enter the ending balance on the statement.
Ending Balance: F00.00
This betomes the opening balance of your Quicken acoount,

Dion't worry if you don't have your last statement - you can make changes to your account later.

|
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8. Click inside the Ending Balance text box and enter the bank account
balance.

Use the number keys to enter the balance. The folks at Intuit, by the way,
really want you to use the balance from your bank statement. If you have
terrible financial records — for example, you haven’t reconciled your
account since Clinton left office — this idea is probably good advice. If
you have neat, accurate financial records, go ahead and use your check
register balance.

N If you do use the bank statement balance as your starting balance, be
sure to enter all the transactions that cleared or will clear after the bank
statement balance date. (This should make sense, right? If a check or
deposit isn’t reflected in the bank statement figure, you must enter it
with it’s correct date into Quicken.)

9. Click the Done button.

Quicken displays the new account in a register window, as shown in
Figure 2-5. I discuss the register window in detail in Chapter 4, but for
now, let me just say that this window is the one that you use to keep
track of the deposits into and the withdrawals from a bank account.

Quicken 2005 Premier - gdata2 - [Savings: Savings] EI=ES
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help

¥l s T )
@ 4 A P L @ =
Back  Update Reports  Setup  Services Quicken.com Custamize

Quicken Home 1

Savings: Savinis:

Register Overview
Delete  Find  Transfer Reconcile  Write Checks  Set Up Orline View Reportw Options »  How Do I?
~ | Cash Flow Center Datef A Tum PayesfCategaryMema Payment Cl Deposit EBalance |
Checking 0.00 S/12/ 2006 Opening Balance R 500 00 SO0 00 -
oings 000 —
$0.00 b1 2jz00¢ [BF Nm Fapes Payment Deposit
i Category Memo Enter | Edit | Spit
= | Investing Center
$0.00
~ | Property & Debt
$0.00
il
Ending Balance: 500,00
J Download Transactions | ‘ Scheduled Transactions {0 Dug) ‘ ﬂ |
1
| Sek Up Cnline Payment ‘ Pay vour bills electronically from this account using Quicken Eill Pay!
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A register
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Hey, Quicken, | want to use that account!

In Quicken, you work with one account at a time. The logic is simple: You
record income and expenses for a particular account — a specific checking
account, savings account, and so on. (You do this by using the register that
appeared in Figure 2-5, just for the record.)

You use the Cash Flow Center window (refer to Figure 2-1) to tell Quicken
which account you want to work with because Quicken provides clickable
hyperlinks (technically called QuickTabs) that you can use to move to the
account.

To display the Cash Flow Center window, click the Cash Flow Center button.
(If you're experiencing a sense of déja vu right now, it’s probably because |
described these techniques earlier in the chapter, too.) Let me mention that
you can also use the Cash Flow menu to get to the Cash Flow Center. To do
this, choose Cash Flow=>Go To Cash Flow Center from the menu bar.

After you display the Cash Flow Center window, select the account you want
by clicking the account name. Quicken displays the register window for that
account.

Whipping Your Category Lists into Shape

If you set up Quicken from scratch — you haven’t been using an earlier version
before — you indirectly tell it which of the predefined home categories you
want to use and whether you need to use business categories by answering
the questions that Quicken asks.

Quicken supplies categories to, well, categorize your spending. For example,
you would probably use the Rent category to categorize all the checks you
write to pay rent.

The predefined categories lists may be just what you want. Then again, they
may not. Table 2-1 shows the all-inclusive home categories list, and Table 2-2
shows the business categories list. If you tell Quicken to use all the home and
business categories, your actual category list combines the categories shown
in Tables 2-1 and 2-2.

QNING/ Your categories list may vary slightly from the categories shown in Tables 2-1
S and 2-2. Quicken may customize your starting categories list based on your
answers to questions it asks in the Quicken Guided Setup. I talk about the
Quicken Guided Setup briefly in Chapter 1.
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Take a minute to look through both lists. If you find categories you don’t need,
cross them off the list in the book. You can delete them in a minute or so. If you
need categories you don’t see, add them at the bottom of the list. You can add
them in about two minutes or so.

v To track a certain income or spending item for income tax purposes —
wages, property taxes, and so forth — you need a Quicken category.

v To track a certain income or spending item because you’re just interested
in knowing how much you spend on it (for example, renting DVDs), you
need a Quicken category.

v To budget by categories (because you need a category for any income or
spending item that you want to budget), you need a Quicken category.

Table 2-1 The Category List for Married
Homeowners with Children
Categories Descriptions

Income Categories

Bonus Bonus money you receive

Div Income Dividend income from stocks and mutual funds

Gift Received Gifts received from generous relatives and friends

Interest Inc Interest income from bank accounts, CDs, and
similar items

Invest Inc Investment income from, well, investments

Other Inc Other income that doesn't fit better in some other
category

Salary Salary income

Salary Spouse

Salary income for your spouse

Tax Refund

That check you get back from the taxman if you withhold
more than you owe

Unemployment Inc

Unemployment benefits

Expense Categories

Auto Automobile expenses
Fuel Auto fuel

Insurance Auto insurance

Loan Auto loan payments
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Categories

Descriptions

Registration

Auto registration, plates, or license tags

Service Auto service

Bank Charge Banking fees

Cash Miscellaneous cash purchases

Charity Charitable donations

Charity — Non Cash Charitable donations made with stuff rather than cash

Childcare Childcare

Clothing Clothing

Computer Hmmm. This is suspicious. A category for tracking
expenses, such as the money you spent on Quicken.

Dining Dining out

Education Education

Entertainment

Entertainment

Gifts Given Gift expenses
Groceries Groceries
Home Repair Repair expenses for the ol homestead

Homeowner's Fees

Homeowner's association fees

Household Miscellaneous household expenses

Housing Housing

Insurance Insurance

Disability Disability insurance (in case you or your spouse become

disabled)

Home Insurance

Homeowner’s insurance

Life Insurance

Life insurance premiums

Interest Expense

Interest expense

IRA Contrib Individual Retirement Account contribution

IRA Contrib Spouse Individual Retirement Account contribution for spouse
Medical Medical expense

Doctor Doctor and dental visits

(continued)
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Table 2-1 (continued)

Categories Descriptions

Medicine Medicine and drugs

Misc Miscellaneous

Mortgage Int Mortgage interest

Bank Mortgage interest paid to a financial institution
Individual Mortgage interest paid to a private individual (and not

reported on form 1098)

Personal Care

Personal expenses (shampoo, soap, and other accou-
trements of civilized life)

Recreation

Recreation expense

Rent

Housing rent

Subscriptions

Subscriptions

Tax Taxes

Fed Federal income tax

Medicare Medicare tax

Other Miscellaneous taxes

Property Property tax

SDI State disability insurance

Soc Sec Social Security tax

State State income tax

Tax Spouse Employment taxes for your spouse
Fed Federal income tax

Medicare Medicare tax

Other Miscellaneous taxes

SDI State disability insurance

Soc Sec Social Security tax

State State income tax

Utilities Water, gas, electric, and other stuff like this

Cable TV

Cable television
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Categories

Descriptions

Garbage & Recycling

Hauling away your junk

Gas and Electric

Gas and electricity

Internet Internet access fees

Telephone Telephone

Water Water

Vacation Vacation expenses

Lodging Motel/Hotel costs

Travel Transportation expense

Table 2-2 The Predefined Business Categories
Categories Descriptions

Income Categories

Consulting

Consulting revenue

Finance Charge

Finance charge revenue

Gr Sales

Gross sales revenue

Other Inc, Bus

Other income, such as interestincome

Services

Service revenue

Expense Categories

Ads

Advertising expenditures

Bad Debt Bad debt expenses

Car Car and truck

Commission Sales commissions

Discounts Discounts given expense

Dues and Dues and subscription expense

Subscriptions

Employee Benefit,
Business

Employee benefits for things like medical insurance

Insurance, Bus

Business insurance premiums

(continued)

37



Part I: Zen, Quicken, and the Big Picture

Table 2-2 (continued)
Categories Descriptions
Int Paid Interest and financing expense

Late Fees

Late payment fees . .. ouch

Legal — Prof Fees

Legal and professional fees . .. ouch again

Licenses and Permits

Licenses, permits, and other stuff like that

Meals & Entertn

Meals and entertainment

Miscellaneous, Bus

Miscellaneous business expense

Mortgage, Bus

Mortgage expenses on a business property

Office

Office expenses

Pension and Profit
Sharing

Profit and profit sharing costs — like for a 401(k) plan

Postage and Delivery
Expense

Postage, courier, and delivery

Printing and
Reproduction

Printing, photocopying, and reproduction

Rent on Equip

Rent — vehicle, machinery, or equipment

Rent Paid Rent paid

Repairs Repairs

Returns Returns and allowances
Supplies, Bus Business supplies

Tax, Business

Taxes and licenses

Fed Federal taxes
Local Local taxes
Property Property taxes
State State taxes
Travel, Bus Business travel
Utilities, Bus Business utilities

Telephone, Bus

Telephone bills

Wages

Wages, salaries, and job credits
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Subcategories . . . yikes, what are they?

You surely didn’t buy Quicken so that you could spend all day Saturday sit-
ting at your computer instead of taking the kids to the zoo. I realize this and
want to make Quicken easier for you to use. To do so, I figure I should tell you
which Quicken features you can ignore if you're feeling a bit overwhelmed.
Subcategories are among those things I think that you can ignore.

“Subcategories?” you say. “Yikes! What are they?”

Subcategories are categories within categories. If you look at the Taxes expense
category in Table 2-1, for example, you'll notice a bunch of categories that
follow the Tax category and are slightly indented: Fed (federal tax), Medicare
(Medicare tax), Other (miscellaneous taxes), Property, SDI (state disability
insurance), Soc Sec (Social Security tax), and State (state tax).

When you use subcategories, you can tag a transaction that pays, for example,
taxes; you can further break down this category into subcategories such as
federal income tax, Medicare tax, and Social Security tax. If you want to see a
list of the ways you’ve spent your money, Quicken summarizes your spending
both by category and, within a category, by subcategory. On a Quicken report,
then, you can see this level of detail:

Category Expense
Taxes

Federal tax 900
Medicare tax 100
Soc Sec tax 700
Total taxes 1,700

No doubt about it, subcategories are useful tools. But they make working with
Quicken a little more complicated and a little more difficult. As a practical
matter, you usually don’t need them. If you want to track a spending category,
it really belongs on your list as a full-fledged category. For these reasons, I'm
not going to get into subcategories here.

If you get excited about the topic of subcategories later on — after you have
the hang of Quicken — you can peruse the Quicken documentation for more
information.

If you do want to use the Quicken subcategories, don’t delete the subcategories
shown in Table 2-1. If you don’t want to use the subcategories, go ahead and
delete them. (I tell you how to remove categories in “Removing categories you
loathe,” later in this chapter.)
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Category groups . . . double yikes!

Category groups, which were known as supercategories in a previous version
of Quicken, combine categories into sets that you can use in reports and in
your budgeting. Sure, they’re sort of cool, but you don’t need to worry about
them if you're just starting with Quicken.

If you're dying to know more about category groups, you can refer to the
Quicken online help. Quicken Help works like help in other Windows programs.
If you don’t know Windows all that well — or least not well enough to comfort-
ably use Help — refer to Appendix A.

Four tips on categovization

I have just four tips for categorizing:

v Cross off any category you won’t use.

If you don’t pay state income taxes in the state you live in, for example,
get rid of the state tax category. Extra, unneeded categories just clutter
your list. I think it’s great if you can get down to just a handful of
categories.

v Don’t be afraid to lump similar spending categories together.

Take your utilities expense, for example. If you pay water, natural gas,
electricity, and sewer, why not use a single Utilities category? If you pay
different utility companies for your water, natural gas, electricity, and
sewer, you can still see what you spend on just electricity, for example,
even with a single catchall category for utilities.

v~ Be sure to categorize anything that may be a tax deduction.

Categorize educational, medical, and dental expenses; state and local
income taxes; real estate taxes; personal property taxes; home mortgage
interest and points; investment interest; charitable contributions; casualty
and theft losses; moving expenses; unreimbursed employee expenses; and
all those vague, miscellaneous deductions. (By the way, the foregoing is a
pretty complete list of itemized deductions in the United States at the time
this book was written.)

1 Don’t sweat this category stuff too much.

In spite of the preceding three tips, don’t let these category lists or the
work of customizing them scare you. If you want to spend a few minutes
cleaning up the list, hey, that’s great. If not, or if you're starting to get
anxious, just skip ahead to the next chapter.
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|
Figure 2-6:
The Cate-
gory List
window.
|

Ch-ch-changing a category list

You should now be ready to fix any category list problems. Basically, you need
to do three things: add categories, remove categories, and change category
names and descriptions.

Adding categories you'd love to use
Adding categories is a snap. Here’s all you have to do:

1. Choose Tools=>Category List from the menu bar.

Quicken displays the Category List window (shown in Figure 2-6). This
window lists the categories available and the accounts you've set up.
Because I talk about both personal use and business use of Quicken

in this book, careful readers may notice that the categories shown in
Figure 2-6 include categories from both Tables 2-1 and 2-2.

2. Click the New button on the Category List window.

The New button, by the way, is the first button on the left. Quicken, duti-
fully displays the Set Up Category dialog box (shown in Figure 2-7). You
probably aren’t surprised that you use this puppy to describe the new

category.
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|
Figure 2-7:
The Set Up
Category
dialog box.
|
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. Enter a short name for the category.

Move the cursor to the Name text box and type a name. Although you
can use up to 15 characters, use as short a name as possible to clearly
identify the category. Why? Because you use this category name every
time you want to tag a transaction to fall into the category.

. Enter a description for the category.

Move the cursor to the Description text box and then describe the cate-
gory. Quicken uses the category description on reports that show the
category. If you don’t add a description, Quicken just uses the category
name. You don’t need a description, obviously, if your category name is,
well, adequately descriptive.

. [Optional] Identify the category group.

If you've disregarded my earlier suggestion to not worry about category
groups, open the Group drop-down list box and select the appropriate

group.

. Indicate whether the category is an income category or an expense

category.

Select the appropriate Income, Expense, or Subcategory Of option
button — just click the appropriate button with your furry little friend,
the mouse. If you've totally blown off my admonition not to use subcate-
gories just yet, use the dialog box’s drop-down list to indicate into which
income or expense category a new subcategory falls.

. Indicate whether the category tracks an amount you will use on an

input line on next year’s tax return.

By line, | mean the actual tax form line — such as the line on the U.S.
1040 form that tracks alimony.
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Move the cursor to the Tax-Related check box and then select the check
box if the category is tax-related or deselect the check box if the category
isn’t tax-related. Just to clear up any confusion, vacationing in Hawaii
probably isn’t a tax deduction — even if your neighbor promises that it
is. Then identify the form and line by opening the Tax Line Item drop-
down list box and selecting one of its entries.

8. Click OK.

Quicken adds the new category to the Category List window (refer to
Figure 2-6) and then redisplays the window. Now that you understand the
stuff in the Category List window, note that it shows the category name,
its type, the notation that a category is tax-related (see the check mark in
the Tax column?), and, golly darn, even its description and group.

Removing categories you loathe

Removing categories takes only a couple of keystrokes. With the Category
List window displayed, follow these steps:

1. Right-click the category you want to remove and then choose the
Delete command from the shortcut menu that appears.

If there are no transactions in the category, Quicken displays a message
that asks you to confirm your decision.

2. If you want to remove the selected category, click OK.

Otherwise, press the Esc key or click the Cancel button.

Changing category names and descriptions

You can change a category name, its type, its description, and its tax-related
setting if you later discover you've made some mistake, such as misspelling a
word in a description.

To do so, follow these steps:

1. Display the Category List window (refer to Figure 2-6).

2. Use the arrow keys or click with your mouse to select the category
you want to change and then click the Edit button.

Quicken displays a dialog box that has text boxes and option buttons
describing the selected category’s information: its name, description,
type, and tax-related settings.

3. Make the changes you want by replacing text box contents or chang-
ing option button settings. Then click OK to save your changes and
return to the Category List window.
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Do Vou Need a Little Class?

Using categories isn’t the only way that you can summarize your financial
records. Quicken provides a second tool, called classes, which also lets you
summarize transactions in addition to the way you summarize transactions
with categories.

[ have mixed feelings about classes, and I'll tell you why. For my business, |
used to use them — with good success — to track the types of gross income
that my business produces (writing, consulting, teaching, and so on) and the
types of expenses my business incurs in these activities. (In fact, Writing,
Consulting, and Teaching are the names of three of my classes.)

Classes present a couple of problems, however. First, you can’t budget by
classes. (Before you say, “Ah, Steve, [ don’t want to budget,” please read the
next chapter.) Second, you need to remember to tag transactions with their
classes. (Quicken doesn’t remind you to include classes, but it does remind
you to include a category.) For these reasons, in past editions of this book, I
never described how to use classes. I just told people to skip them.

However, for one group of people, classes can be very useful: real estate
investors. Here’s why: If you invest directly in real estate, you're required to
report your income and expense by property. You can therefore collect the
information you need either by creating a cute little set of categories for each
and every property. (After you're the Donald Trump of your neighborhood and
have, say, seven different properties, this lots-of-categories approach means
that you have seven different sets of property-specific categories. Yikes!).
Alternatively, you can create a single class for each property and then use
the class — in combination with the category — to collect the information
you need.

Interested? For now, what you need to do is choose Tools=>Class List and then
click the New button to set up a class for each real estate property. (You might
use the street address as the class name.) When I talk about categorizing trans-
actions in Chapter 4, I also explain (in a sidebar) how to classify transactions.



Chapter 3
Maximum Fun, Maximum Profits

In This Chapter
Deciding whether you need a budget

Discovering tips for personal and business budgets
Setting up a budget

Reviewing a budget

Idon’t think that a budget amounts to financial handcuffs, and neither
should you. A budget is really a plan that outlines the way you need to
spend your money to achieve the maximum amount of fun or the way a
business needs to spend its money to make the most profit.

Should Vou Even Bother with a Budget?

A budget, as you probably know, is a list of the ways you earn and spend
your money. If you create a good, workable categories list with Quicken (see
Chapter 2), you're halfway to a good, solid budget. (In fact, the only step left
is to specify how much you earn in each income category and how much you
spend in each expense category.)

Does everybody need a budget? No, of course not. Maybe, at your house,
you're already having a bunch of fun with your money. Maybe, in your busi-
ness, you make money so effortlessly that you really don’t plan your income
and outgo.

For the rest of us, though, a budget improves our chances of getting to wher-

ever it is we want to go financially. In fact, I'll stop calling it a budget. The word
has such negative connotations. I know — I'll call it a Secret Plan.

Serious Advice about Vour Secret Plan

Before I walk you through the mechanics of outlining your Secret Plan (your
budget), [ want to give you a few tips.
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A Secret Plan for your business

The tips for personal Secret Plans also apply to
businesses. But | have two special tips for small
businesses using Quicken. (I'm going to write
very quietly now so that no one else hears. .. .)

Here's the first secret tip: Visit the http://
bizstats.comWeb site. It provides tons and
tons of good, interesting business statistics
about businesses just like yours!

Here's the second secret tip: Go to the library, ask
for the RMA (Risk Management Association)
survey, and look up the ways that other busi-
nesses like yours spend money. If it doesn’t have
the RMA survey, see whether it has the Dun &
Bradstreet survey or Troy's survey.

These surveys are really cool:

v The RMA surveys bank-lending officers,
creates a summary of the information these
bankers receive from their customers, and
publishes the results.

v+ Troy (who's actually a business Ph.D.) col-
lects Internal Revenue Service data and
publishes the same sort of financial results.

v+~ Dun & Bradstreet collects and summarizes
its own proprietary financial information.

Atboththe http://bizstats.comWeb site
and in the preceding surveys, you can get really
useful information about what businesses like
yours spend, make, and own. For example, you
can look up what percentage of sales the aver-
age tavern spends on beer and peanuts, the
average profit your CPA makes, and the profit a
car dealer makes on the average car sale. (Isn't
that all kinds of interesting stuff?)

By the way, neither the http://bizstats.
com Web site nor the surveys will actually have
a line on the taverns page labeled “beer and
peanuts,” for example. It'll be called “cost of
goods sold” or some similarly vague account-
ing term.

A\

Your personal Secret Plan

You can do four things to make your Secret Plan more likely to work:

 Plan your income and expenses as a family.

With this sort of planning, two heads are invariably better than one.
What’s more, though [ don’t really want to get into marriage counseling
here, a family’s budget — oops, I mean Secret Plan — needs to reflect
the priorities and feelings of everyone who has to live within the plan.
Don’t use a Secret Plan as a way to minimize what your spouse spends
on clothing or on long-distance telephone charges talking to relatives

in the old country. You need to resolve your clothing and long-distance
charges issues before you finalize your Secret Plan.

v Include some cushion in your plan.

In other words, don’t budget to spend every last dollar. If you plan from
the start to spend every dollar you make, you undoubtedly have to fight
the mother of all financial battles: paying for unexpected expenses when
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you don’t have any money. (You know the sort of things I mean — car
repairs, medical expenses, or that cocktail dress or tuxedo you absolutely
must have for a special party.)

1 Regularly compare your actual income and outgo to your planned
income and outgo.

This part of your plan is probably the most important and also the part
that Quicken helps you with the most. As long as you use Quicken to
record what you receive and spend, you can print reports showing what
you planned and what actually occurred.

v Make adjustments as necessary.

When you have problems with your Secret Plan — and you will — you’ll
know that your plan isn’t working. You can then make adjustments, by
spending a little less calling the old country, for example.

Two things that really
qgoof up Secret Plans

Because I'm talking about you-know-what, let me touch on a couple of things
that really goof up your financial plans: windfalls and monster changes.

The problem with windfalls

Your boss smiles, calls you into his office, and then gives you the good news.
You're getting a $5,000 bonus! “It’s about time,” you think. Outside, of course,
you maintain your dignity. You act grateful but not gushy. Then you call your
husband.

Here’s what happens next. Bob (that’s your husband’s name) gets excited,
congratulates you, and tells you he’ll pick up a bottle of wine on the way
home to celebrate.

On your drive home, you mull over the possibilities and conclude that you
can use the $5,000 as a big down payment for that new family minivan you've
been looking at. (With the trade-in and the $5,000, your payments will be a
manageable $300 a month.)

Bob, on his way home, stops to look at those golf clubs he’s been coveting,
charges $800 on his credit card, and then, feeling slightly guilty, buys you the
$600 set. (Pretend that you're just starting to play golf.)

You may laugh at this scenario, but suppose that it really happened. Further-
more, pretend that you really do buy the minivan. At this point, you’ve spent
$6,400 on a van and golf clubs, and you've signed up for what you’re guessing
will be another $300-a-month payment.

b7
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This turn of events doesn’t sound all that bad now, does it?

Here’s the problem: When you get your check, it’s not going to be $5,000.
You're probably going to pay roughly $400 in Social Security and Medicare
taxes, and maybe around $1,500 in federal and state income taxes. Other
money may be taken out, too, for forced savings plans — such as a 401(k)
plan — or for charitable giving. After all is said and done, you get maybe half
the bonus in cash — say $2,500.

Now you see the problem. You have $2,500 in cold hard cash, but with Bob’s
help, you've already spent $6,400 and signed up for $300-a-month minivan
payments.

In a nutshell, you face two big problems with windfalls:

»” You never get the entire windfall — yet spending as if you will is quite
easy.

v Windfalls, by their very nature, tend to get used for big purchases (often
as down payments) that ratchet up your living expenses. Boats. New
houses. Cars.

Regarding windfalls, my advice to you is simple:

v Don’t spend a windfall until you actually hold the check in your hot little
hand. (You're even better off to wait, say, six months. That way Bob can
really think about whether he needs those new golf clubs.)

v Don’t spend a windfall on something that increases your monthly living
expenses without first redoing your budget.

The problem with monster income changes

If your income changes radically, planning a budget becomes really hard.
Suppose that your income doubles. One day you're cruising along making
$50,000, and the next day you're suddenly making $100,000. (Congratulations,
by the way.) I'll tell you what you’ll discover, however, should you find your-
self in this position. You'll find that $100,000 a year isn’t as much money as
you may think. (By the way, this business about monster income changes is
true no matter what your income level. Like, if you're cruising along making
$500,000 and see your income double to $1,000,000, everything I'm saying
here still applies.)

Go ahead. Laugh. But for one thing, if your income doubles, your income
taxes almost certainly more than quadruple.

One of the great myths about income taxes is that the rich don’t pay very
much or that they pay the same percentage. But that’s not actually true. If
you make $50,000 a year and you’re an average family, you might pay about
$3,000 in federal income taxes. If you make $100,000 a year, you'll pay about
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$12,000 a year. So if your salary doubles from $50,000 to $100,000 (or perhaps
your spouse gets a good job), your income taxes quadruple, going from $3,000
to $12,000. I don’t bring this fact up to get you agitated about whether it’s right
or fair that you should pay a bunch of any extra income you make in taxes. I
bring it up so that you can better plan for any monster income changes you
experience.

Another thing — and I know it sounds crazy — you'll find it hard to spend
$100,000 smartly when you’ve been making a lot less. And if you start making
some big purchases, such as houses and cars and speedboats, you’ll not only
burn through a great deal of cash, but you’ll also ratchet up your monthly
living expenses.

Monster income changes that go the other way are even more difficult. If
you've been making, say, $100,000 a year and then see your salary drop to

a darn respectable $50,000, it’s going to hurt, too. And probably more than
you think. That old living-expense ratcheting effect comes into play here.
Presumably, if you've been making $100,000 a year, you’ve been spending it —
or most of it.

But other reasons contribute — at least initially — to making a monster
salary drop very difficult. You've probably chosen friends (nice people,
such as the Joneses), clothing stores, and hobbies that are in line with
your income.

Another thing about a monster salary drop is sort of subtle. You probably
denominate your purchases in amounts related to your income. Make $50,000,
and you think in terms of $5 or $10 purchases. But make $100,000 a year, and
you think in terms of $10 or $20 purchases. This observation all makes perfect
sense. But if your income drops from $100,000 down to $50,000, you’ll proba-
bly still find yourself thinking of those old $20 purchases.

So what to do? If you experience a monster income change, redo your Secret
Plan. And be particularly careful and thoughtful.

Setting Up a Secret Plan

Okay, now you’re ready to set up your budget — er, [ mean, Secret Plan.

Introducing the Budget window

To get to the window in which you enter your budget, choose Planning=
Budget.
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|
Figure 3-1:
The Create
Budget:
Automatic
dialog box.
|

Quicken displays the Setup tab of the Budget window. Click the Automatic
button if you want Quicken to create a starting budget using any existing
financial data. Otherwise, click the Manual button. After you make this
choice, click the Create Budget button.

If you indicate that you want to create an automatic budget by, essentially,
recycling your old “actual numbers,” Quicken displays the Create Budget:
Automatic dialog box, in which you can specify which old actual numbers

to use (see Figure 3-1). Use the From and To boxes to identify the range of
dates that span the months or the year you want to use. Use the Select Budget
Method buttons and boxes to indicate how you want Quicken to budget: using
average monthly amounts (the default), using the exact monthly amounts, or
using the exact quarterly amounts. Finally, use the Options check boxes to tell
Quicken how to handle rounding and one-time, extraordinary transactions.
(By default, Quicken rounds budget amounts to the nearest dollar and does
not exclude one-time transactions.) After you describe the automatic budget,
you click OK.

Create Budget: Automatic

Quicken will zcan your past ransactions and suggest a budget based on your actual
income and spending. Choose a date range far the transactions you want to bage wour
new budget on, choose a budgeting method, and then click "0K". To include
transfers or pick specific categories, click "Categories”.

1. Choose date range to scan
From: [61/2004 To: [4730/2005

2. Select budget method

—
& hverage amounts: tdarthiy -
© Monthly detai
" Quarterly detail
P

ategories...

¥ Round values ta nearest: # hd ==

™ Execlude one-time transactions

After you indicate that you want a manual budget (if you're creating a manual
budget) or after you describe how you want an automatic budget corrected

(if you'’re creating an automatic budget), Quicken displays a dialog box with
the message, To complete your budget, click the Choose Categories
button; underneath that, the Income tab of the Budget window appears, shown
in Figure 3-2.

You use the Income tab to enter your budget for income amounts and use the
Expenses tab to budget for expense amounts. If you want to budget savings,
you can enter these by using the Savings tab. (Budgeted savings, by the way,
are just planned account transfers — money you plan to move, for example,
into a savings account.)
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Figure 3-2:
The Income
tab of the
Budget
window.
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(3 Budget =EF)

Brint Reports = Options »  How Da I7

Setup I[m:ome T Expenses T Savings I Surnmary

Use this page to track all of the money you have coming into your budget. To enter or edit a budget amount, select the item in the list and Follow
the steps at the right. To add or remove a source of income, click "Choose categories” below,

Category/Account Budget | Period Monthly average _
— 1. Method
- =T
e [l

~

—— 2. Budget

Total income:
Total expenses:
Total transfers to savings:

Difference:

™ show category groups Totalst |Maorthly -
Choose cateqgories. .,

ocoo

Initially, none of the tabs shows categories or accounts, which are what you

use for your budgeting. To display categories and accounts, follow these
three simple steps:

1. Click the Choose Categories button so that Quicken displays the

Choose Categories dialog box. (Or, if you’re looking at the Savings tab,
click Choose Accounts so that Quicken displays the Choose Accounts

dialog box.)
2. Click the Mark All button.
3. Click OK.
Categories or accounts appear along the left edge of the window (see

Figure 3-3). Any categories with subcategories (if you have these) contain
subtotals for the total inflows and for the total outflows.

To move among the Income, Expenses, and Savings tabs, click the tabs.

In a pane along the right edge of the Budget window, Quicken displays but-
tons and boxes you use to budget the selected income, expense, or savings

amount, which I talk about in the next section.
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(3 Budget =EF)

Brint Reports = Options »  How Da I7

Setup I[m:ome T Expenses T Savings I Surnmary

Use this page to track all of the money you have coming into your budget. To enter or edit a budget amount, select the item in the list and Follow
the steps at the right. To add or remove a source of income, click "Choose categories” below,

Category/Account Budget | Period Monthly average “

- Bonus 0 Monthly 0:
E i 1. Method
-Consulting 0 Monthly 0 & R A I:I
.-D.w Incame 0 Mortthly O ¢ Morthly dekai l:l
~Finance Charge 0 Manthly 0~ iy A
-(Gift Received 0 Manthly 0
-Gt Sales 0 Manthly g — 2.Budget
-Interest Inc 0 Monthly 0 amount: [0.00
- Invest Inc 0 Manthly 0
--Cther Tne 0 Manthly g Perind: [Monthly x
- Other Inc, Bus 0 Manthly 0 Select the budget period and enter the
I --Galary 0 Manthly 0 average income For that period.
- . ~Salary Spouse 0 Manthly 0
Flg“re 3 3' ~Services 0 Manthly 1}
Categories - Tax Refund 0 Manthly 0
~Unemplaoyment Inc 0 Manthly 0
(and sub- -FROM Checking 0 Manthly 0
: --FROM Savings 0 Manth 0
categories) o !
appear Total income: 0
Total expenses: [1]
on the Ieft Total transfers to savings: 0
side of the Difference: 0
B ud g et ™ show category groups Totalst |Maorthly -
window. Choose categaries.
|

Entering budgeted amounts

To budget an income or expense amount, select the category and then enter
the budget into the amount box or boxes. Use the Method buttons to specify
how you want to budget the amount: using an average amount, using differ-
ent monthly amounts (indicated by marking the Monthly Detail button), or
using different quarterly amounts (indicated by marketing the Quarterly
Detail button). Different Amount boxes appear for different budgeting meth-
ods. After you specify your budget amounts, click the Apply button (which is
grayed out in Figure 3-4).

As you enter amounts, Quicken updates any subtotals and grand totals that
use those amounts.

Reviewing the options

If you click the Options menu, which appears near the upper-right corner of
the Budget window, Quicken displays a menu of several useful commands
and switches:
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Figure 3-4:
Entera
budgetin
the boxes at
the right
side of the
window.
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v~ Save Budget. Saves a copy of the current budget.

1~ Restore Budget. Replaces whatever information shows in the Budget
window with the information contained in the last saved copy of your
budget.

v Show Cents. Turns on and off the display of cents. This baby is a real
lifesaver if you need to literally watch your pennies.

v~ Separate View. Tells Quicken to separate income, expenses, and savings

budgeting information on separate Income, Expenses, and Savings tabs.

v Income Expense View. Tells Quicken to separate income and expense
budgeting information on different tabs. This is the default view.

v Combined View. Tells Quicken not to separate income, expenses, and
savings budgeting information on separate tabs.

v~ Set Up Alerts. Displays the Alerts Center dialog box, which lets you tell
Quicken that it should alert you when your actual spending begins to
approach a specified limit (see Figure 3-5).

To use a budget alert, select the Monthly Expenses check box, select the

category you want to monitor, enter the spending limit into the Spending

Limit column, and then click Apply and then Done.

r Budget =3

Print

Reports = Options »  How Do I7

Setup I[ncume T Expenses T Savings I Summary

Use this page to track all of the money you have coming into your budget. To enter or edit a budget amount, select the item in the list and Faollow
the steps at the right. To add ar remave a source of income, click "Choose categories” below,

Category/Account Budget | Period Monthly average “

Bonus : 4,000 Monkhly 4,000 1. Method
Consulking 0 Monthly 0 Average amount I:I
D.w Income 0 Manthly 0~ MontHly detal I:I
Finance Charge 0 Manthly 0~ Quarterly datal
Gift Received 0 Manthly 1}

-G Sales 0 Monthly 0 — 2.Budget

~Interest Inc 0 Monthly 0 amount: ,m—gng

- Invest Inc 0 Monthly [1}

-Other Inc 0 Monthly [1} Feriod: |Monihh :"

-Other Inc, Bus 0 Monthly 0 Select the budget period and enter the

-Salary 0 Mortthly 0 average income For that period,

--5alary Spouse 0 Monthly [1}

Services 0 Monthly [1}

-Tax Refund 0 Monthly [1}

Unemployment Inc 0 Monthly [1}

~FROM Checking 0 Manthly 0

~FROM Savings 0 Manthly 0

Total income: 4,000
Total expenses: 0
Total transfers to savings: [1]
Difference: 4,000
[ show category groups Totals! |Maorthly -

hoose categories. ..

Chapter 3: Maximum Fun, Maximum Profits

53



54 Part I: Zen, Quicken, and the Big Picture

( Alerts Center ==

Select an alert that ywou want to be notified of and enter values where appropriate. Click 'O ko commit your values, "Cancel' otherwise, Uncheck
the alert if vou do nat wish ta be natified of that alert again,

[+ Cash Flow

ceaunt min. belsnces i Enter Yalues for monthly expense limits.
crount max, halances ?

redi card limits i This alert notifies you when you've spent more on an expense category than you've
heck reorder notice set for the month,

Cateqgory Type Spending Limit

Expns
Expns

E-General Insurance Sub
ElReminders
+Online transactions B Laan Sub
Scheduled Transactions du... & Registration Sub
5end ta Quicken,com (Part... BA Service Sub
| " =
Mnsutrance raanpralsall é Bad Deht
- . *-Mortgage reappraisal
Figure 3-5:
The Setup Show me the alert as: ' Text inthe alert list
ta b Of the " Urgent {pop up dialog box)

Al erts keep the alert in the list For: One month hd
Center
dlal()g bOX. oK | ‘ Cancel | | Help
|

Reviewing your budget

After you enter your budget, click the Summary tab to see a summarized
version of your income and expense budgets and a pie chart of your budget
(see Figure 3-6). Use the Summary tab’s Top Yearly Budget Items drop-down
list box to select the budget data you want to plot in the pie chart.
¥ If a careful review of your budget shows things have become, well, rather
a mess, you can click the Setup tab and then the Start Over button to, er,
start over.

What to do after you enter your budget

After you create your Secret Plan, you don’t have to do anything special to save
your work. Oh, sure, you can tell Quicken to save your budget by choosing
Options>Save Budget from the Budget window. But you don’t have to. When
you leave the Budget window or close it, Quicken automatically saves your
work for you.

If you want to revert to the previously saved version of the budget, choose
Options>Restore Budget from the Budget window.
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( Budget

S]E]x]

Brint

Reports = Options »  How Da I7

Setup I Incorme TE@ensas Tsayings I ul

‘Your budget is working! You have enough money to cover all expenses and transfers to Quicken accounts,

Monthly Budget Summary
Jan
Total income: 8,000
Total expenses: -6,400
Total transfers ko savings: 1}
Difference: 1,600
4

Mar Apr May Jun Jul Aug Sep Ok Moy
§000 g,000 8,000 8000 8000 8000 8,000 8,000 8,000

6,400 -6,400 -6,400 -6,400 -6,400 -6,400 -5,400 -5,400 -6,400

i i i il i i i i il
LEO0 1,600 1,600 1,600 L,E00 1,600 1,600 1,600 1,600

Ta view the budget amounts For a specific manth, click on that
month in the list above and then click "Details".

Top yearly budget items:

All expenses -

Rent 46.887
TaxFed 23445
Groceries nrex
Medical TEN

| IRA Contrib 38065
| IRA Contrib Spouse 39082
AutoeFuel 2
Total $76,800.00

To Further analyze vour spending, run a budaet report,

I you intend ko save some of all of your budget surplus, consider setting up a
scheduled savings transfer or a savings goal to help you meet your target,

I talk more about using the budget in later chapters (such as Chapter 7, for
example). If you want to print a hard copy (computerese for paper) of the
budget, choose Reports=>Cash Flowr>Budget. If you have a printing question,

go to Chapter 5.

You’re not going to use the Secret Plan for a while. But don’t worry; in
Chapter 5, I explain how to print reports, including a report that compares
your actual spending with, uh, your budget.
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In this part . . .

Okay, you’re ready for the show to start (which is
good). This part covers all the nitty-gritty details

of using Quicken to keep your personal and business
financial records. Whether you're just starting to use the
Quicken program or you've just come from Part I, you’ll
find the stuff covered here dang important — dare I say
essential? — to using Quicken in even the most basic way.




Chapter 4
Checkbook on a Computer

In This Chapter

Recording checks

Recording deposits
Recording transfers
Splitting categories
Deleting and voiding transactions

Memorizing transactions

Fis is it. The big time. You're finally going to do those everyday Quicken

things: entering checks, deposits, and transfers. Along the way, you also

use some of the neat tools that Quicken provides for making these tasks easier,
more precise, and faster.

Getting Started

Okay. I'm going to start at the very beginning.

As you start working with Quicken, you probably want to work from the Cash
Flow Center (shown in Figure 4-1). “What’s the Cash Flow Center?” you may
ask. Good question. Basically, it looks and works (sort of) like a Web page
that provides clickable hyperlinks to some of the most popular banking and
bookkeeping features of Quicken and supplies interesting tidbits of financial
trivia.
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Some people like another starting point to work
from, the Quicken Home Page. To see the
Quicken Home Page, you click the Quicken
Home button, which appears in the top-left
corner of the Quicken window and is cleverly
labeled Quicken Home. The Quicken Home
window is just another starting point from which

A few words about the Quicken Home window

you move to financial activity centers or account
detail windows. You also see a potpourri of
hyperlinks you can use to explore various
Quicken features. But because I'm not going to
talk more about it in the pages of this book, | did
want to just mention that it's worth poking your
head around. And that’s all I'm going to say.

\\3 , . .
If you don’t see the Cash Flow Center window, you can click the Cash Flow
Center button, which appears at the left edge of the Quicken window and is
cleverly labeled Cash Flow Center.
Quicken 2005 Premier - gdataZ - [Cash Flow Center] ==
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help
@ @ d P L @ =3
Back  Update Reports  Setup  Services Quicken.com Custamize
Quicken Home ﬁj Cash How Center My Data | Analysis & Reports
How Do I#
~
Cash Flow Alerts Options * Online Updates -
Checking 0.00 ¥
‘ol currently have no cash Flow alerts
Savings 0,00
g0.00 | | | [Zhowalolerts] [Set L dlerts | Never connected,
- Schedule Updates
¥ | Investing Center spending & Savings Accounts Options ¥
$0.00 Account MinBal IntRate  Current Balance Ending Balance| | Save time --
spending download From your brokerage,|
+) | Property & Debt Checking 0.00 Mot Set 0.00 4.16| | (et p how
$0.00 Subtotal 0.00 4.16
- May 2005
Savings S M T WTF 5
Savings 0,00 Mot Set 0,00 500,00 1 B T 5 b 7
Subtotal 0.00 500.00
@ Ao {11 1z 13 14
Total 0.00 504.16| {5 |15 17 @ ho B0 21
Add Account | | Edit Accounts 23 Guicken Bill Pay b b3 ba b5 be b7 b
] Credit Card Accounts Options w | 2% PO Bl
Figure 4_1 : Track your credit card spending. Add credit card accounts. Full Calendar ﬂ ﬂ
The Cash Add Account | | Edit Accounts £ Quicken MasterCard
Cash Flow Services
Net Worth $0.00
FlOW Centel’ Bills and Scheduled Transactions Options Pay Eills Online
WindOW. Financial Overview g [ — | Download Banking Data h
Customize Hide Amounts i) Monitor receivsbles and payables with Quicken Premier Home & Business
|
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Finding Your Checkbook

|
Figure 4-2:
The Register
tab of the
Checking
window.
|

To enter checkbook transactions, use the Register tab of the Checking window
(shown in Figure 4-2). If you can see the bank account you want to work with
listed beneath the Cash Flow Center button, you can click it to display that
account’s register. If the Cash Flow Center window is displayed, you can also
click the bank account’s QuickTab hyperlink, which is shown in the Spending
& Savings Accounts list area. Finally, if you don’t see the account anyplace,
you can choose Cash Flowr>Cash Flow Accounts and then select the account
you want to work with.

Figure 4-2 shows the account name — Checking — to the left of the
Register tab.

The starting balance you specified as part of setting up the account is the first
amount that Quicken lists. In Figure 4-2, for example, the starting balance is
$4.16. Bummer.

Quicken 2005 Premier - qdataZ - [Checking] BE]x]
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help

@ G} d P L @ =2

Back  Update Reports  Setup  Services Quicken.com Custamize

Quicken Home ﬁj m- Register | Overview

Delete  Find Transfer Reconcile ‘\Write Checks  Set Up Online Wiew » Report »  Options »  How Do I#
¥ | Cash Flow Center Datef £ Hurm PayeefCategoryMema Fayment Clr Deposit Balance |
Checking 4.16 S/12/2005 Opening Balance R 416 416 &
o .00 [Checking]
avinds 4 '16 k1 3j200¢ [&F| A Fayes Fayment Deposit
b Catagory Mamo Enter | Edit | splt
¥ | Investing Center
$0.00
| Property & Debt
$0.00
-
Ending Balance: 4,16
J Download Transactions | ‘ Scheduled Transactions {0 Due) ‘ i‘
Set Up Download | Set Up Online Payment ‘ Save time - automatically keep this account up ko date!
Download transactions from U.S. Bank {PFM Direct Connect)
Customer 10t [ Frovideg by (05 Sank (R0 PING [ Frovided by D05 Bank (P | Sek Up Mow
Save time - Automatically keep this account up to date, Learn More
Need a customer 10 and PIN? U.5. Bank (PFM Direct Connect] 1-800-USBANKS
Net Worth $4.16
Financial Overview &

Customize Hide Amounts % Want ta track your business expenses the sasy way?
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The Pay Your Bills Electronically From This Account information, initially
shown at the bottom of the register window, lets you set up an account for
online banking or online bill payment. If you want to do this, follow the on-
screen instructions. (You can also click the Set Up Online Payment button on
the Register tab to set up the account for online banking and bill payment.)
If you need help or more information about online banking or bill payment,
see Chapter 6. To remove this online services stuff from the window, click
the button with the double-chevrons that’s to the right of the Download
Transactions and Scheduled Transactions tabs.

Recording Checks

First things first: You can enter checks by using either the Register tab (refer
to Figure 4-2) or the Write Checks window, which I describe in Chapter 5.

You use the Register tab for the checks that you don’t want to print or pay
electronically with Quicken; you use the Write Checks window to enter the
checks that you do want to print or pay electronically with Quicken. (This
rule isn’t etched in stone, but it does make things easier, so it’s the rule that
I'm going to follow.)

Entering a check into the register

Entering a check in the register is a simple matter of describing to whom you

wrote the check and how much you paid. Suppose, for example, that you paid
$25.50 to the cable television company for your monthly cable service. Here’s
how you enter this check:

1. Enter the check date.

Move the cursor to the Date field in the next empty row of the register

(if it isn’t already there) and type the date by using the MM/DD format.
To enter June 3, 2005, for example, type 6/3. You usually don’t have to

type the year because Quicken retrieves the current year number from
the little clock inside your computer.

You can adjust the date in a Date field by using the + and - keys on your
keyboard. The + key adds one day to the current date; the — key subtracts
one day from the current date.

2. Enter the check number.

Move the cursor (or tab) to the Num field and type the check number.
Alternatively, move the cursor to the Num field and then, when Quicken
displays a list box of entries (such as ATM, Deposit, EFT, Next Check
Number, Print Check, Send Online Payment, and Transfer Funds), select
Next Check Number if you want. Quicken then fills in the number with its
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guess as to the new check number — one more than the last check
number you entered. If this guess is right, you can just leave it in place.
If it isn’t right, type over what Quicken guessed with the correct number
or use the + or — key to increase or decrease the check number.

. Enter the payee.

Move the cursor to the Payee field. Type the name of the person or busi-
ness you're paying. If the cable company’s name is Movies Galore, for
example, type Movies Galore. (In the future, you can probably select
payee names from the payee list box.) The Payee field is the one labeled
with the phrase “Pay to the Order of.”

. Enter the check amount.

Move the cursor to the Payment field and type the check amount —
25.50 in this example. You don’t have to type the dollar sign, but you
do need to type the period to indicate the decimal place and cents.

. Enter the category.

Move the cursor to the Category field. Quicken displays a drop-down
list box of category names from your category list. You can select one of
these categories by using the arrow keys or the mouse. Or, if you're the
independent type, just type the name yourself. For example, if you use
the standard Quicken categories list, you may categorize a payment to
your cable company as Utilities:Cable TV. The first part of this entry,
Utilities, is the category. The second part, Cable TV, is the subcategory.

If you go with the typing approach and you’re not a superfast typist,
Quicken can probably guess which category you're entering before you
enter it. When you start typing Ut, for example, Quicken fills in the rest
of the category name, “ilities,” for you (“Ut” + “ilities” = “Utilities™). This
feature is called QuickFill, and I talk about it in more detail in the section
“Working with a kooky (and clever) little thing named QuickFill,” later in
this chapter.

. [Optional] Enter a memo description.

Move the cursor to the Memo field and describe the specific reason
that you're paying the check. You may identify the cable payment as the
June payment, for example. If you're using Quicken for a business, use
this field to identify the paid invoice — usually by entering the invoice
number you’re paying. You don’t have to enter anything into this field,
by the way.

. Click Enter.

Click the Enter button that appears in the transaction’s row of the regis-
ter. This option tells Quicken that you want to record the transaction
into your register. Quicken beeps in acknowledgment, calculates the
new account balance, and moves the cursor to the next slot, or row, in
the register.
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Interested in online banking and bill payment?

If you want to know more about how online register works. Everything you read about in
bill payment and banking work, read Chapter 6.  this chapter will help you more easily use the
For now, just pay attention to how the Quicken  Quicken Online Account Access feature.

Figure 4-3 shows the cable television check recorded into the register. You
can’t see it in the figure, but the amount in the Balance field after the $25.50
check shows up in red. This red ink indicates that you've overdrawn your
account. [ don’t need to tell you what that means: overdraft charges.

Packing more checks into the register

Normally, Quicken displays two rows of information about each check that
you enter. It also displays two rows of information about each of the other
types of transactions you enter. If you want to pack more checks into a visible
portion of the register, click the View button (which appears near the top-right
corner of the Register tab) and then choose the One-Line Display command
from the menu that Quicken displays. After you do, Quicken displays all the
register information — except the Memo field — in a single-line format (as
shown in Figure 4-4). To return to the double-line format, choose View=>
One-Line Display again.

What if you need to change a check that you've already entered? Suppose
that you make a terrible mistake, such as recording a $52.50 check as $25.20.
Can you fix it? Sure. Just use the arrow keys or click the mouse to highlight
the check transaction that you want to change. Use the Tab and Shift+Tab
keys to move the cursor to the field you want to change. (You can also select
the field by clicking it with the mouse.) Then make your fix. Click the Enter
button when you finish or press Enter on the keyboard.

If you click the View button, you notice that it also displays a bunch of com-
mands that begin with the word Sort. These commands all work the same
basic way. They let you reorganize the transactions shown in the register in
some new way: by date, amount, check number, and so on.

Don’t worry. I'm not going to waste your precious time telling you things like
the Sort By Date command sorts transactions by their date or that the Sort
By Amount (Largest First) command sorts transactions by descending size of
the transaction amount.
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A neat little trick

You can expand and edit the list box of Num 2. Click the New button and then complete
entries that Quicken displays. If you want to add the dialog box that Quicken displays.
some new Num entry to the Num drop-down list
box, for example, do the following:

1. Click the Edit List button, which appears at
the hottom of the Num drop-down list.

You can also remove any new Num entries
you add by using the Edit Num List dialog box.

| won't spend any more time describing how this
works, so if you want to figure it all out, just
Quicken displays the Edit Num List dialog box.  experiment. You can't hurt anything.

P If you point to the column heading for the Payee field, the Payment field, or
the Cleared Status field (labeled with Clr), Quicken displays a pop-up com-
mand that you can use to re-sort the transactions in the register. These
options are self-explanatory. The one that appears when you point to the
Payee field is Sort Payees In Alphabetic Order. And the one that appears
when you point to the Cleared Status field is Sort Transactions Into Groups
Of Reconciled, Cleared, And Uncleared Transactions. You get the picture.

Working with a kooky (and clever)
little thing named QuickFill

Here’s kind of a funny quirk about Quicken. If Quicken can guess what you're
typing into a field, it fills in the rest of the field for you. Earlier in this chapter,
[ mention how this QuickFill feature works when you type category names.
But it gets even better than that.

The second time you use a payee name, for example, Quicken knows that

it’s the second time. Quicken also figures that, “Hey, some stuff from the last
Movies Galore transaction will probably be the same for this transaction.”
When you type the first few letters of the payee name, Quicken supplies a
payee name for you. After you press the Tab key to accept the name, Quicken
uses the last transaction’s information to fill in all the current transaction’s
fields.

This feature is a real timesaver. Suppose that you did write a $25.50 check

to Movies Galore for your June cable television bill. When you type Movies
Galore to record July’s cable television check, the amount will probably be
the same. The complete payee name will certainly be the same, and the cate-
gory will also be the same. So Quicken fills in all these fields, too.



Chapter 4: Checkbook on a Computer

Memorized transactions

Quicken provides another feature — memorized
transactions — which is almost irrelevant to
day-to-day Quicken use now that the QuickFill
feature exists. But because you may hear about
this tool, I'll quickly describe how it works.

A memorized transaction is one that you've
stored or that Quicken has stored on a special list.
(To store the transaction, you select it in the reg-
ister and choose Edit=>Memorize Transaction.)

to display a list of previously memorized trans-
actions. When Quicken displays the list, select
the transaction you want to reuse and click Use.

A memorized transactions listis a handy tool. But
if you're feeling a little overwhelmed, don't spin
your wheels trying to get up to speed on this fea-
ture. QuickFill almost always does the job for you
because — get this — it automatically grabs
memorized transactions from the list.
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To later use or abuse a memorized transaction,
choose Cash Flow=>Memorized Transaction List

QuickFill doesn’t do everything for you, however. You still need to make sure
that the date and check number are correct. If Quicken quickfills a field with
the wrong information, just replace the wrong information with the right
information.

Recording Deposits

Recording a deposit works almost the same way as recording a check. The
only difference is that you enter the deposit amount in the Deposit field rather
than enter the check amount in the Payment field.

Entering a deposit into the register

Suppose that you receive $100 as a birthday gift from your elderly Aunt Enid.
Here’s how you record this deposit in the register:

1. Enter the deposit date.

Move the cursor to the Date field of the next empty row of the register
(if it isn’t already there) and type the date. Use the MM/DD format. You
enter June 3, 2005, for example, as 6/3. As with check dates, you have to
enter the year only if the current year number, which Quicken retrieves
from the little clock inside your computer, is wrong.
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You can adjust the date in a Date field in Quicken by using the + and -
keys. The + key adds one day to the current date; the — key subtracts
one day from the current date.

. Type the code DEP (for deposit) into the Num field.

Are you the meticulous type? Then go ahead and move the cursor to the
Num field. Open the Num drop-down list box and select Deposit.

. Type the name of the person from whom you received the deposit.

In this case, move the cursor to the Payee field and type Aunt Enid. (I
don’t mean to sound presumptuous, but, well, the next time Aunt Enid
sends you birthday money, you'll be able to select her name from the

Payee drop-down list box.)

. Enter the deposit amount.

Move the cursor to the Deposit field and type 100. Don’t type the dollar
sign — or any other punctuation. (If Aunt Enid sweats money and some-
times passes out $1,000 gifts, for example, you record the deposit as
1000 — not 1,000 or $1,000.)

. Enter the category.

You know how this works by now. Move the cursor to the Category

field. Open the Category drop-down list box, if necessary, and select

the appropriate category. Alternatively, if you like living on the edge, try
typing in the category name. You may describe Aunt Enid’s check as Gift
Received. (This income category is on the standard home category list.)
You can describe a customer receipt as Gr Sales.

To add a category, type a name in the Category field and move to another
field. When Quicken doesn’t recognize the category name, it asks you
whether you want to add the category. Click Yes, and Quicken displays
the Set Up Category dialog box. Refer to Chapter 2 if you have questions
about how this works.

. [Optional] Enter a memo description.

Move the cursor to the Memo field and describe something such as the
reason for the deposit. Aunt Enid’s money may be described as birthday
gift. If you're a business depositing a customer’s check, use this entry to
identify the invoice the customer is paying.

. Click Enter.

This command tells Quicken that you want to record the transaction in
your register. Quicken beeps in protest but then adds the transaction.

Figure 4-5 shows the Checking register after you enter Aunt Enid’s thoughtful
gift. Your account is no longer overdrawn — so you have that going for you.
Maybe before you go any further, you should call Aunt Enid to thank her.
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See the ending balance given at the bottom of the register window? The
ending balance shows the account balance after every register transaction.
If you enter future-dated transactions, the register window shows both a
current balance — the balance as of the current date — and an ending bal-
ance, which is the balance after all the transactions.

Quicken also includes a Paycheck Wizard that you can use to describe the
taxes withheld from your paycheck and categorize the deductions from your
paycheck. That much said, you probably don’t need to keep track of these
amounts unless, for some reason, you want precise estimates of the income
taxes you pay. Remember that your employer already does this accounting.
Also remember that you must use the employer’s data, which appears on
your W-2 form — and not your Quicken data — when you prepare your U.S.
taxes. If you do decide to use the Paycheck Wizard, just choose Taxes=>Tax
Activities=>Set Up My Paycheck. Quicken launches the Paycheck Wizard,
which asks you a few general questions about your deductions and then pro-
vides a dialog box similar to a Split Transaction window where you can enter
and categorize your deductions. For more information about splitting trans-
actions, refer to the “Splitting Transactions” section, later in this chapter.
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Changing a deposit you've already entered

Big surprise here — changing a deposit works just like changing a check.
First, use the arrow keys or click the mouse to select the deposit. Use the Tab
and Shift+Tab keys to move the cursor to the field you want to change. Tab
moves the cursor to the next field. Shift+Tab moves the cursor to the previ-
ous field. (You can also select the field by clicking it with the mouse.) Then
make your fix and click Enter.

Recording Account Transfers

Account transfers occur when you move money from one account, such as
your savings account, to another account, such as your checking account.
But jeepers, why am I telling you this? If you have one of those combined sav-
ings and checking accounts, you probably do this sort of thing all the time.

Oh, now I remember why I brought this up — Quicken makes quick work of
account transfers as long as you already have both accounts set up.

If you don’t have the second account set up, you need to do that first. If you
don’t know how, flip back to Chapter 2.

Entering an account transfer

Buckle up. [ speed through the steps for recording an account transfer. For
the most part, you record an account transfer the same way you record a
check or deposit.

Suppose that you want to record the transfer of $50 from your checking
account to your savings account. Maybe you want to set aside a little money —
little, presumably, being a key adjective — to purchase a gift for your generous
Aunt Enid.

Say that you’re working with your checking account and want to record a
transfer to your savings account. Here’s what you need to do:
1. Enter the transfer date.

Move the cursor to the Date field. Then type the date that you move the
money from one account to another.

2. Flag the transaction as a transfer.

Move the cursor to the Num field. Open the drop-down list box and
select the Transfer entry. Quicken abbreviates “transfer” as TXFR.
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3. Enter a description of the transaction.

Use the Description field to describe the transfer — for example, Birthday.
You know how this works by now, don’t you? You just move the cursor to
the field. Then you pound away at the keyboard. Bang. Bang. Bang.

4. Enter the transfer amount.

You enter amounts that you transfer out of an account in the Payment
field, and you enter amounts that you transfer into an account in the
Deposit field. So move the cursor to the right field (right as in right and
wrong, not right and leff) and then enter the transfer amount.

5. Indicate the other account.

Move the cursor to the Category field, which has a modified name of Xfer
Acct (standing for Transfer Account) and, when Quicken drops down a
list box of accounts, select the other account. In Figure 4-6, I show the
transfer as going to an account named “Savings.” | set up this account
secretly, while you weren’t watching. But note that the steps for setting
up a savings account parallel those for setting up a checking account.
Refer to Chapter 2 for more information.

6. [Optional] Enter a memo description.

Enter more information about the transaction (if you need to) in the
Memo field. Perhaps a gift idea for Aunt Enid?

7. Click Enter.

This command tells Quicken that you want to record the transfer trans-
action into your register.

Figure 4-6 shows the Checking register after you transfer money from your
checking account to your savings account so that you’ll have money to pur-
chase something nice for Aunt Enid’s next birthday — maybe that new Eminem
CD. In Figure 4-6, by the way, I've minimized the Download Transactions and
Scheduled Transactions tabs to provide room for more rows in the register.
You can minimize and unminimize these tabs by clicking the button showing
double chevrons that appears to the right of the tabs.

Take a look at the Category field. Notice that Quicken uses brackets — [ | —
to identify the Category field entry as an account and not as an income or
expense category.

Working with the other half of the transfer

Here’s the cool thing about transfer transactions. Quicken automatically
records the other half of the transfer for you. Figure 4-6 shows the $50 reduc-
tion in the checking account because of the transfer. Quicken uses this infor-
mation to record a $50 increase in the savings account. Automatically.
Biddabam. Biddaboom.

/1
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To see the other half of a transfer transaction, select the transfer transaction
by using the arrow keys or the mouse. Then choose Editz>Transaction=>Go
To Matching Transfer. Quicken displays the other account in a new register
window, as shown in Figure 4-7.

Changing a transfer you've
already entered

Predictably, this activity works just like changing a check or a deposit.
1. First, select the transfer by using the arrow keys or by clicking the
mouse.

2. Then use the Tab and Shift+Tab keys to move the cursor to the field
that you want to change.

3. Make your fix, click Enter, and then go to lunch.
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Splitting Transactions

Here’s a sort of Quicken riddle for you: Suppose that you have a check that
pays more than one kind of expense. You trot down to the grocery store, for
example, and pick up $10 worth of junk food and junk beverages (which you
should categorize as a Groceries expense) and $10 worth of 10W-40 motor oil
(which you should categorize as an Auto expense). How do you categorize a
transaction like this? Well, I'll tell you. You use a split category.

Here’s how a split category works. When you’re ready to categorize the check,
you click the Split button. When you click this button, Quicken displays the
Split Transaction window, shown in Figure 4-8.

Steps for splitting a check

Being a clever sort, you probably already know how the Split Transaction
window works. I go through the steps anyway. Suppose that you want to cate-
gorize a $20 check that includes $10 for groceries and $10 for motor oil.

/3
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|
Figure 4-8:
The Split
Transaction
window.
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To categorize a check in the Split Transaction window, do the following:

1. Enter the first category name in the first Category field.

Move the cursor to the Category field (if it isn’t already there). Activate
the drop-down list box by pressing Alt+S or by clicking the down arrow
and then selecting the category name.

(Despite what a dietitian may say, you can call the soda and candy
“Groceries.”)

2. Enter a memo description for the first categorized portion of the check.

Move the cursor to the first Memo field and then type whatever you
want. (Maybe a description of the food you bought. Er, then again,
maybe if you're buying real junk, you should just leave this blank.)

3. Enter the amount spent for the first category.

Move the cursor to the first Amount field and then type, well, the
amount. If the first category is what you're calling Groceries and you
spent $10 on this, you type 10.

4. Repeat Steps 1, 2, and 3 for each spending category.

If you spent another $10 on motor oil, for example, move the cursor to
the second Category field and enter the category and optionally the sub-
category you use to summarize auto maintenance expenses. In Figure 4-9,
for example, I use the category-subcategory combination Auto:Service.
Optionally, move the cursor to the second Memo field and enter a memo
description of the expenditure, such as motor oil. Move the cursor to the
second Amount field and enter the amount of the expenditure, such as 10.

Figure 4-9 shows a Split Transaction window that is complete. A split
transaction can have up to 30 pieces. Use the scroll bar and PgUp and
PgDn keys to scroll through the list of split amounts.
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the total.

5. Verify that the Split Transaction window shows no uncategorized
spending.

If you find extra spending — this shows up as the Remainder amount —
either add the category you need or delete the split transaction line that’s
uncategorized. To delete a split transaction line, move the cursor to one of
the fields in the line and choose Edit>Delete. You can also click the Adjust
button to get rid of the Remainder amount — but in this case, Quicken
adjusts the amount originally entered into the register so that it agrees
with the details you've supplied in the Split Transaction window.

If you want to insert a new line, move the selection cursor to the line
above where you want to make your insertion and choose Edit=>Insert.
If you're fed up and want to start over from scratch, choose Edit>Clear
All (which causes Quicken to erase all the split transaction lines).

. Click OK.

After you complete the Split Transaction window — that is, after you
completely and correctly categorize all the little pieces of the transac-
tion — click OK. Quicken closes the Split Transaction window. If you
didn’t enter an amount in the Payment column of the register before
opening the Split Transaction window, Quicken displays a dialog box
that asks whether the transaction is a payment or a deposit. You select
an option button to make your choice known.

To let you know that the transaction is one that you’ve split, the Category
field shows the word --Sp11it-- when you select the split transaction.
Take a peek at Figure 4-10 to see for yourself.

. Click Enter.

This command tells Quicken that you want to record the transaction in
your register.
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Splitting hairs

Quicken assumes that any transaction amount
you enter in the register should agree with the
total of the individual split transaction amounts
entered in the Split Transaction window.

If you're not sure what the split transaction
amount's total is, your best bet is to NOT — |
repeat, NOT— enter the amount on the Register
tab. Instead, enter the individual split transaction
amounts in the Split Transaction window. When
you leave the Split Transaction window, Quicken
totals your individual split amounts and then
prompts you to see whether the total is a pay-
ment or a deposit. Then it plugs this total into
either the Payment or the Deposit field.

If you've already entered either a payment
amount or a deposit amount but you're not sure
that the split transaction amounts agree with

what you entered, you can tell Quicken to adjust
the Payment or Deposit amount on the Register
tab to whatever the individual split transaction
amounts total. To do so, click the Split Transaction
window Adjust button. Quicken then adds up the
split transaction lines and plugs the total into the
register. (This approach may best be called “I
don't care if it's a round hole; | want to pound this
square peg into it.”)

By the way, Quicken shows any difference
between the amount shown on the Register tab
and the individual split transaction amounts. It
shows this difference as the last split transac-
tion line so you can tell whether the individual
splits agree with the payment or deposit amount
shown in the register.
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Sort of a voiding bug . ..

When you mark a transaction as void — you do
this by selecting a transaction and choosing
Edit->Transactionc>Void — Quicken does three
things: It sticks the word VO 1D at the start of the
Payee field, it marks the transaction as cleared,
and it erases the amount in the Payment or
Deposit field. So far, so good. But if you later fill
in the Payment or Deposit field and don't pay
attention to the warning from Quicken that
you're editing a reconciled transaction, Quicken
uses the payment or deposit amount that you

enter to adjust the account balance — even
though Quicken still shows the transaction as
void. | keep thinking the folks at Intuit will fix this,
but they haven’t — at least not yet. The bottom
line is that you need to make sure that you don't
edit transactions after you void them.
Otherwise, you can all too easily foul up your
account balance — perhaps even overdraw
your account. | won't tell you about how | hap-
pened to learn this. ...

Editing and deleting split categories

You can delete or change any individual line of a split category. To do so, first
select the transaction (to display the Split Transaction window) and then click
the check mark button, which appears in the register’s Category field after you
record the transaction. After Quicken dutifully displays the Split Transaction
window, you can edit a field by selecting it and then typing over its contents.
You can delete any line of the split category by choosing Edit=>Delete. (If you
want to delete all the lines of the split category so you can start over, choose
Clear All instead.)

If you want to unsplit the transaction so that you can assign it to a single
category, you need to use a little trick. Click the X button that appears in the
register’s Category field after you record the transaction.

Steps for splitting deposits and transfers

Wondering if you can split deposits and transfers? Well, you can. The steps for
doing so work just like the steps for splitting categories for a check transaction.
The basic trick — if you can call it a trick — is to use the Split Transaction
window to list all the category names and amounts.

One other point [ should make here is that you can mix and match categories
and transfers in the Split Transaction window. Some of the splits, for example,
can be categories, and some can be transfer accounts. This type of transac-
tion is common in a business setting. (See Chapter 15 for more information.)

/7
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Deleting and Voiding Transactions

You can delete and void register transactions by using the Edit button’s
Delete Transaction and Void Transaction commands. If you’ve looked at the
Edit button — it appears just beneath the selected transaction when you’re
entering data — you’ve probably already guessed as much.

Using either command is a snap. Just highlight the transaction you want to
delete or void by using the arrow keys or by clicking the mouse. Then click
the Edit button and choose the command. And that’s that.

Use the Void Transaction command any time you void a check. Quicken
leaves voided transactions in the register but marks them as void and erases
the Payment or Deposit amount. So by using the Void Transaction command,
you keep a record of voided, or canceled, transactions.

Use the Delete Transaction command if you want to remove the transaction
from your register.

The Big Register Phenomenon

If you start entering a bunch of checks, deposits, and transfers into your
registers, you’ll shortly find yourself with registers that contain hundreds
and even thousands of transactions. You can still work with one of these big
registers by using the tools and techniques I talk about in the preceding para-
graphs. Nevertheless, let me give you some more help for dealing with . . .
(drumroll, please) . . . the big register phenomenon.

Moving through a big register

You can use the PgUp and PgDn keys to page up and down through your reg-
ister a screenful of transactions at a time. Some people call this scrolling. You
can call it whatever you want.

You can press Ctrl+Home to move to the first transaction in a register and
Ctrl+End to move to the last transaction in a register.

You can also use the vertical scroll bar along the right edge of the Register
tab. Click either above or below the square scroll bar marker to page back
and forth through the register. Or, if you have no qualms about dragging the
mouse around, you can drag the scroll bar marker up and down the scroll
bar. If you drag the scroll bar marker to scroll through the register, Quicken
displays a pop-up box that shows the transaction date you've scrolled to.
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|
Figure 4-11:
The Quicken
Find dialog
box.
|

Finding that darn transaction

Want to find that one check, deposit, or transfer? No problem. The Find com-
mand provides a handy way for doing just that. Here’s what you do:

1.

Choose Edit~Find & Replace~Find, or click the Find button on the
Register tab.

Quicken, with restrained but obvious enthusiasm, displays the Quicken
Find dialog box (shown in Figure 4-11). You use this dialog box to describe
the transaction you want to find in as much detail as possible. (Notice that
you don’t click the Edit command on the Register tab to get to this com-
mand; you click the menu bar’s Edit menu.)

. Enter the piece of text or number that identifies the transaction you

want to locate.

Move the cursor to the Find text box. Then type the text or number. By
the way, the case of the text doesn’t matter. If you type aunt, for example,
Quicken finds AUNT or Aunt.

. Specify which pieces, or fields, of the register transaction you want

Quicken to look at.

Click the arrow to the right of the Search box and then from the drop-
down list, select the field Quicken should look at during the search:
Amount, Cleared Status (the Clr field), Memo, Date, Category/Class
(whatever is in the Category field), Check Number (what’s in the Num
field), or Payee. Or get truly crazy and pick the All Fields list entry so
that Quicken looks both high and low.

. Tell Quicken whether you’re using a shotgun or a rifle.

You need to specify how closely what you stuck in the Find text box
needs to match whatever you selected in the Search drop-down list box.
To do so, open the Match If drop-down list box. Then select the appro-
priate matching rule:

e Contains: Select this rule if the field or fields you're searching just
need to use a piece of text. If you enter Aunt into the Find text box
and use this matching rule to search Payee fields, Quicken finds
transactions that use the following payee names: Aunt Enid, Aunt
Enid and Uncle Joob, Uncle Harry and Aunt Edna, and — well, you
get the idea.

Quicken Find =

Search: all Fields -
Match if: | Contains - Find all

Find:

[ A Close
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¢ Exact: Select this rule if the field you're searching needs to exactly
match your Find text box entry. If you enter the Find text box entry
as Aunt, for example, and you’re searching Payee fields, Quicken
looks for transactions where the Payee field shows Aunt — and
nothing more or nothing less.

Starts With: Select this rule if the field you're searching for just
needs to start with what you entered in the Find text box. For
example, if you enter Aunt in the Find text box and you’re search-
ing the Payee fields, Quicken looks for transactions where the
Payee field starts with the word Aunt — such as Aunt Enid or Aunt
Enid and Uncle Joob. (Uncle Joob and Aunt Enid wouldn’t cut the
mustard in this case, though.)

Ends With: Select this rule if the field you’'re searching for just
needs to end with what you entered in the Find text box.

Greater: Select this rule if the field you're searching for needs to
hold a value that exceeds the number you entered in the Find text
box. This makes sense, right? Like you're looking for checks you
wrote for more than $100?

Greater Or Equal: Select this rule if the field you're searching for
needs to hold a value that either exceeds or equals the number
you entered in the Find text box.

¢ Less: Select this rule if the field you're searching for needs to hold a
value that is less than the number you entered in the Find text box.

¢ Less Or Equal: Select this rule if the field you're searching for needs
to hold a value that is less than or equal to the number you entered
in the Find text box.

5. Tell Quicken whether you want it to search forward or backward
from the selected transaction.

Select the Search Backwards check box if you want to look backward
starting from the selected transaction.

6. Let the search begin.

You click either the Find or Find All button to begin the search. If you
click Find, Quicken looks through the register, and if it can find a trans-
action like you describe, it highlights the transaction.

If you click Find All, Quicken looks through the register and builds a list
of all the transactions that are like the one you describe. Then it displays
the list in an expanded version of the Quicken Find window (as shown in
Figure 4-12).



Figure 4-12:
The Quicken
Find
window
with a
transaction
that
matches the
search
criteria.

|
Figure 4-13:
The Find
and Replace
dialog box.
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Quicken Find 2E)] %]
Print  Zoom Satt by - Help  Close

Date Acct
[/4iz005 Checking

Mum
CEP

Payee
Aurt Erid

Cat
Gift Received

Memo Clr Amount

100.00]

[v shaw Matches in Splic Item Found in 1 Transactions

Quicken supplies another command that is similar to Find. The Edit menu’s
Find/Replace command lets you both locate and modify transactions that
look like the one you describe. (To use the Find/Replace command, choose
Edit~>Find & Replace>Find/Replace.) For example, you may want to locate
transactions showing Aunt Enid as the payee so that you can replace Aunt
with Great Aunt. The Find/Replace command works in a similar fashion to the
Find command except that you need to describe what you want to modify in
the found transactions. After you complete the initial dialog box that Quicken
displays when you choose the command, Quicken displays a window listing
the transactions it has found. (This window looks like the one shown in Fig-
ure 4-13.) You mark — by clicking — the transactions you want to modify,
describe the replacement information, and then click the Replace button.

Find and Replace
Print Help
Search: All Fields - Find All
Match if: | Cantains 52
Find: [ Aunt
Replace:  |Payes &~
with: [ Great Aunt [2]

Date Acct MNum Payee Cat Memo Cir Amount

6/4/2005 Checking DEP  AuntEnid Gift Recsi.. 100.00

[v Show Matches in Splic

Found in 1 Txns
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|
Figure 4-14:
The recat-
egorize
window.
|

You can’t use the Find/Replace command to find and replace categories, but
you can use another command: Recategorize. (To use the Recategorize com-
mand, choose Edit=>Find & Replace>Recategorize.) For example, you may
want to recategorize all your cable television payments as the Entertainment
category (while earlier placing them in the Utilities category). When you
choose the Recategorize command, Quicken displays the Recategorize window
(shown in Figure 4-14). Enter the category you want to replace in the Search
Category text box and the new replacement category in the Replace With text
box. Next, click Find All to tell Quicken it should display a list of transactions
that use the category you want to replace. Click the transactions you want to
recategorize (to mark them), supply the replacement category, and then click
the Replace button.

Recategorize
Print Find + Help
Sesrch Category: | Gift Recetved (%]
Replace With: | \i‘ I:I
Date Acct MNum Payee Cat Memo Cir Amount
6/4/2005 Checking DEP  AuntEnid Gift Recei... 100.00
[ Show Matches in Split Found in 1 Txns

Pop-Up Calendars and Calculators

Can I tell you just a couple more things? (If not, skip this section. If so, read
on.) Quicken provides a pop-up calendar anytime you move the selection
cursor to a Date field. To get to the calendar, click the button that appears at
the right end of the Date field. Quicken displays a calendar for the current
month (as shown in Figure 4-15). All you have to do is select the day you
want as the date. (If you want to see a calendar for a different month, click
the << and > buttons.)

Quicken also provides a pop-up calculator anytime you move the selection
cursor to an Amount field. To get to the calculator, click the button that
appears at the right end of the Amount field.

Quicken displays a calculator like the one shown in Figure 4-16 when you
choose the Tools=>Calculator command. This baby works like a regular hand-
held calculator. You just type the math you want to perform. Quicken displays
the calculation result in the amount field.



|
Figure 4-15:
The pop-up
calendar.
|

|
Figure 4-16:
The pop-up
calculator.
|
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Do the calculator keys make sense? Table 4-1 shows how they work.

Table 4-1 A Handy Guide to the Quicken Calculator Keys

Key Name Operation

/ (slash) Division

X Multiplication

— (minus) Subtraction

+ (plus) Addition

. (period) Indicates the decimal point

% Indicates that the number you just typed is a percentage
and should be converted to a decimal value

= (equal sign) Calculates the amount and removes the pop-up calculator

<- Removes, or clears, the last digit you entered

CE Clears the last number entered into the calculator

C Clears the amount text box

If you type a number into the Amount field and then type any one of the math
operand keys (+ -/ *), Quicken pops open the calculator to continue the cal-
culation. You don’t have to click the calculator button first.
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In This Chapter
Printing a check
Recovering from a mistake after you've printed the check

Printing a register

Ibet you can’t guess what this chapter describes. Gee, you guessed it —
how to print checks and reports.

Printing Checks

Printing checks in Quicken is, well, quick. All you basically need to do is enter
the information you want to print on the check form and the number you want
Quicken to use to identify the check. Sounds simple enough, doesn’t it? It is,
as you can read in the steps that follow.

To enter the information on a check form, follow these steps:
1. Display the Write Checks window by choosing Cash Flow=>Write
Checks or by pressing Ctrl+W.
Figure 5-1 shows the Write Checks: Checking window.
2. Select the account on which you want to write the check.

QNG/ This step is very important! To select the account you want to use, open
Ry the Write Checks From drop-down list at the top of the window. (You can
do this by clicking the arrow button that’s just to the right of the box.)
When Quicken displays the list of accounts, choose the one you want
to use.
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|
Figure 5-1:
The Write
Checks
window.
|

|63 write Checks: Checking [S[=][]
Delete  Find  Edit +  Order Checks Repott +  Prink = Options  How Do 17

‘Write checks Fram: |Check|ng j
Hay to the Pate 5)13(2005
Ohder of 3] $ 0.00
Dhollars
Hibdress
Hlemo
| @&ym;( [2] Split. . | | Record Check |

Checks to Print

Date Tiia Paiae Cateiori Amaunt

Current Balance: 4,16 Ending Balance:  8.66

3. Enter the check date.

First, use the mouse or Tab key to move the cursor to the Date field.
Then type the date that you're going to print the check (probably today’s
date). Remember to type the date in a MM/DD/YY format — enter May
13, 2005, as 5/13/05. You don’t need to enter the year if the year number
that Quicken retrieves from your computer’s internal system clock is cor-
rect. You can adjust the date by a day by using + and — from the numeric
keypad. You can also click the button at the end of the Date field to dis-
play your friend, the pop-up calendar.

4. Enter the name of the person or business you’re paying.

Move the cursor to the Pay To The Order Of field and type away. For
example, to write a check to me, type Steve Nelson. (Feel free to do so,
by the way. If you send me a check, I'll even cash it as a sort of public
service.) If you've written a check to the payee before, when you start
to type the name, Quicken recognizes it and fills in the rest for you.

5. Enter the amount of the check.

Move the cursor to the $ text box and type the amount. (If you're sending
a check to me, be sure to make the amount nominal — for sure, not more
than $10 or $20. . ..) When you press the Tab key, the cursor moves down
to the next field, and Quicken writes the amount in words on the line
under the payee name and before the word Dollars.
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|
Figure 5-2:
A completed
check.
|

6. Enter the payee’s address.

If you plan to mail the check in a window envelope, move the cursor to
the Address field. (You can do this by clicking.) Then enter the name and
address of the person or business you're paying.

Here’s a little address-entry trick: You can copy the payee name from

the Pay To The Order Of text box to the first line of the Address field.
Click the mouse or select the first line of the address field. Then press
the ’ (apostrophe) key. Now fill in the rest of the address block, including
the street number and name, city, state and zip. Once entered, Quicken
memorizes these address details for the next time you use this payee.

7. [Optional] Enter a memo description of the check.

Move the cursor to the Memo field and enter a description (such as

an account number or an invoice number) of why you're sending your
money to this person or business. Or, if you're sending someone a check
because you didn’t have time to go out and buy a real gift, type Happy
Birthday in the Memo field. It’s the little things that make a difference.

8. Enter the category.

Move the cursor to the Category field and type the category name for the
expense you’re paying with the check. If you don’t remember the cate-
gory name, scroll down the category list to find the category. Figure 5-2
shows the completed window for a check payable to Movies Galore, the
local cable TV company.

[ Write Checks: Checking =0
Delete  Find  Edit = Order Checks Repork »  Prink =  Options  How Do 17
‘Write checks from: |Checking j
Hay to the Phate 5/13(2005
Order of Wovies alore 3 4 25.50
Twenty-Five and 507100 WM
Maovies Galore Address...
123 Main Street
Hdldress | Pine Lake, Wi 98123
Hlemo
| {adegory ities:Cable TY = gt | | Record Check |

Checks to Print

Date Tiia Paiae Cateiuri Amount

Current Balance: 4,16 Ending Balance:  B.66
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You can assign a check to more than a single category by using the Split
Transaction window. Using the Split Transaction window with the Write
Checks window works the same way as using the Split Transaction win-
dow with the Register tab. (I describe using the Split Transaction window
with the Register tab in Chapter 4.) Okay. So why do I bring this up? You
use the Split Transaction window when a check pays more than one type
of expense or is transferred to more than one account.

For example, if you're writing a check to pay your mortgage, with part

of the check paying the actual mortgage and part of the check going into
an escrow account for property taxes, you can use the Split Transaction
window to describe the transaction’s individual components. To split

a check amount so that the amount is assigned to multiple spending
categories, click the Split button. Or press Ctrl+S. Either way, Quicken
displays the Split Transaction window for you to indicate the categories
and categorized amounts that make up the check total. If you have ques-
tions about how split transactions work, refer to Chapter 4.

. Click Record Check.

Quicken records the check. It displays the current account balance and
the ending account balance, and it even adds a Checks To Print total

at the bottom of the window. If you’re working with a monitor that sup-
ports a high screen resolution, you’ll also see a Checks To Print window
that lists all the nitty-gritty about the checks you have to print, as shown
earlier in Figure 5-2. Shoot, when you're finished with one check, Quicken
even scrolls the completed check off the screen and replaces it with a new
blank check that you can use to pay your next bill. It doesn’t get much
better than this, does it?

What if you make a mistake
entering a check?

Don’t worry. If you haven’t yet printed the check, fixing mistakes is easy. If
you press the PgUp and PgDn keys with the Write Checks window displayed,
Quicken pages you through the check transactions. That way, you can display
any check that you wrote — but have not yet printed — in the Write Check
window. Or, an even easier way if you've got a lot of checks is to double-click
the check in the list that appears beneath the check form. (Quicken adds a
check to this list when you click the Record Check button.)

With the check redisplayed, you can fix the mistake in two ways:

v If you incorrectly entered some bit of check information, move the

cursor to the field with the incorrect data and just type over the data.
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v If you're really mad or frustrated, you can delete the entire check by
clicking the Delete button. (I should ’fess up here and suggest that you
delete the check if you accidentally entered a check to me, for example.)
Then you can re-enter the check — only this time correctly.

Don’t use this method to delete a check that you've already printed. To void
a check that you've already printed, follow these steps:

1. You must first go into the Register tab. To display the register, you can
click the QuickTab for the account.

The QuickTab shows beneath the Cash Flow Center button.

2. Find the check on the Register tab, select the check, and void it by
clicking the Edit button and choosing the drop-down menu’s Void
Transaction command.

3. You should also write something, such as VOID, in large letters across
the face of the printed check.

Printing a check you've entered
Printing checks is easy. Here’s what you need to do:

1. Load the checks into your printer.

You do so the same way you load any other paper into your printer. If you
have questions about it, refer to your printer documentation. (Sorry I
can’t help more on this process, but with a million different printers on
the market, I can’t guess which one you have.)

2. Click the Print button at the top of the Write Checks window or
choose File=>Print Checks or press Ctrl+P.

Quicken displays the Select Checks To Print: Checking dialog box, as
shown in Figure 5-3. At the top of the dialog box, Quicken shows how
many checks you have to print and the total dollar amount for those
checks.

3. Enter the first check number.

Move the cursor to the First Check Number box and type the number
printed on the first check form you’ll print. Figure 5-3 shows 1001, for
example, so the first check form is numbered 1001. To quickly increase
or decrease the check numbers, use + or — on the numeric keypad.

4. Indicate which checks Quicken should print by selecting one of these
options:

¢ All Checks: Select this option button if you want Quicken to print
all the checks you've entered by using the Write Checks window,
which is the usual case. (If you select this option, skip to Step 6.)
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¢ Checks Dated Through: Select this option button if you want to
print all the checks through a certain date; then type that date in
the text box. (If you select this option, skip to Step 6.)

¢ Selected Checks: Select this option button if you want to pick and
choose which checks to print.

5. If you say that you want to select which checks to print, click the
Choose button.

Quicken, with some annoyance, displays the Select Checks To Print
window, shown in Figure 5-4. Initially, Quicken marks all the checks
dated on or earlier than the current date by placing a check mark in the
Print column. If you don’t want to print a check, either leave the Print
field for that check clear (unchecked) or click the field to remove the
check mark. When only the checks you want to print are marked to be
printed, click Done to continue with this crazy little thing called check
printing. Quicken, happy with your progress, redisplays the Select Checks
To Print: Checking dialog box (refer to Figure 5-3).

Select Checks to Print: Checking
fou have 1 check to print for $25.50,
First Check Mumber, [1001
Frint
m— |
Frint First...
- . " Checks Dated Through D
e >3
" Selected Checks I:I -
ket
Elp
Checks To | checkstle:  [Standard Checks B
Pri nt: Checks on First Page Options
. & 's s
Checklng Three Two One r~
dialog box. Addtionsl Copies: [
|
[ Select Checks to Print
Mark all - Clear All Done
Print Date Payee Category Amount
|
Figure 5-4:
The Select
Checks To
Print
window.
|
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|
Figure 5-5:
The Did
Check(s)
Print OK?
dialog box.
|

6. Indicate which Quicken check form you’re using.

Move the cursor to the Check Style drop-down list box, click the arrow so
that the list drops down, and then select the check form you purchased:
standard, voucher, or wallet checks.

. Tell Quicken if you’re printing a partial page.

If you're printing a partial page, use the Checks On First Page option but-
tons to indicate the number of check forms on the partial page. Select
the Three option button if you have three checks, the Two option button
if you have two checks, or the One option button if you have one check.

. Indicate whether you want extra copies of the check form.

To do so, type the number of copies you want in the Additional Copies
text box. (This text box appears only if you're set up for the voucher
check style.)

If you use Quicken for business to keep accounts payable files, make
copies of checks to attach to the invoices that the checks pay. Then if

a vendor calls later, starts hassling you, and asks which check paid an
invoice, you can easily check your accounts payable files, quickly answer
that question, and basically cover your derriére.

. Click OK and let the games begin.

If you're using a partial starting page of forms, your printer may prompt
you to feed the first page of forms manually. When it finishes, Quicken
asks whether it printed your checks correctly (as shown in Figure 5-5).

Did Checkis) Print OK?

It checks 1007 through 1001 printed corectly, click OK
to continue. Otherwise, type the number of the first check.
which printed incorectly and then click OK.

First Inconectly Printed Check:

10. If the checks printed correctly, click OK. You're done. If the checks

didn’t print correctly, enter the number of the first check that printed
incorrectly and click OK; then repeat Steps 3 through 9.

11. Sign the printed checks.

Then — and I guess you probably don’t need my help here — put the
checks in the mail.
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Oh, where, oh, where, do the unprinted checks go?

The register stores unprinted checks — those
you've entered by using the Write Checks:
Checking window but haven't yet printed. To
identify them as unprinted checks, Quicken sets
their check numbers as Print. After you tell
Quicken to print the unprinted checks, Quicken
prints the checks in your register that have Print
in the check-number field and replaces the
word Print with the actual check number.

This information is of little practical value in
most instances, but it results in several inter-
esting possibilities. For example, you can enter
the checks you want to print directly into the

register — all you need to do is enter the check
number as Print. (Notice that you can't enter an
address anywhere in the register, so this
process isn't practical if you enter addresses
that will be printed on your checks.) You also
can cause a check you've printed once to print
again by changing its check number from, say,
007 to Print. | can't think of many good reasons
why you would want to change a check number.
The only one | can think of is that you acciden-
tally printed a check on plain paper and want to
reprint it on a real check form.

What if you discover a mistake
after you print the check?

This problem isn’t as big as you may think.

If you've already mailed the check, you can’t do a whole lot. You can try to
get the check back (if the person you paid hasn’t cashed it) and replace it
with the correct check. (Good luck on this one.)

If the person has cashed the check, you can’t get the check back. If you
overpaid the person by writing the check for too much, you need to get the
person to pay you the overpayment amount. If you underpaid the person,
you need to write another check for the amount of the underpayment.

If you printed the check but haven’t mailed it, void the printed check. First,
write the word VOID in large letters — in ink — across the face of the check
form. (Use a ballpoint pen if you're using multipart forms so that the second

and third parts also show as VOID.) Second, display the Register tab, highlight

the check, and then click the Edit button and choose the Void Transaction
command. (This option marks the check as one that has been voided in the
system so Quicken doesn’t use the voided check in calculating your account

balance.)

A few words about check printing

Check printing is kind of complicated at first, isn’t it?
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For the record, I'm with you on this one. But you’ll find that printing checks
does get easier after the first few times.

Pretty soon, you’ll be running instead of walking through the steps. Pretty
soon, you'll just skate around things like check-form alignment problems.
Pretty soon, you’ll know all this stuff and never have to read “pretty soon”
again.

Printing a Check Register

|
Figure 5-6:
The Print
Register
dialog box.
|

You can print a check register or a register for any other account. To print a
register, follow these magic steps:

1. First, display the register by clicking the QuickTab for the account.
Then choose Filew>Print Register.

Quicken displays the Print Register dialog box, shown in Figure 5-6.

Print Register

Title: | Print....

S
Print Transactions From: 14,2005 _
To  [6/5/72005

Optiohs

[~ Print Spiit Transactions

2. [Optional] Enter a register title.

If you're the sort who likes to add your own special titles to things, move
the cursor to the Title text box. Then type the report title or description
that you want Quicken to print at the top of every page of the register.

3. [Optional] Limit the range of dates.

To print a register of something other than the current year-to-date
transactions, use the Print Transactions From and To text boxes. This is
pretty dang obvious, isn’t it? You just move the cursor to the From and
To text boxes and type the range of dates the register should include.

4. [Optional] Tell Quicken to print split transaction information.

To print the split transaction information — categories, memos, and
amounts — move the cursor to the Print Split Transactions check box.
Then press the spacebar or select the check box.

93



94

Part II: The Absolute Basics

|
Figure 5-7:
The Print
dialog box.
|

5.

Click Print.

Quicken displays the Print dialog box (shown in Figure 5-7). You don’t
have to fool around with this dialog box. If you want to print a register
pronto, just click OK. Then again, if you're the sort of person who likes to
fool around with this kind of stuff, carry on with the rest of these steps.

Print
{+ Printer |HP Desklet B40C/3410/842C/8430 [Cj Properties Orientation
" Export to ASCI Disk File (+ Partrait
" Ewport to tab-defimited (E xoel-compatible) Disk File N
(" Exportto PAN (123-compatible) Disk File " Landscape
Print Range

[+ Print in Colar Al

I~ " Pages:

[~ Fitto One Page \Wide From: To:

Mumber of Copies: ’1_j‘

N

If you want to see the effect that the different register-printing text boxes
and check boxes have, just experiment. You can’t hurt anything or
anybody.

The rest of these steps are optional. Do them if you feel like it.

. [Optional] Print the report to disk if you want.

To print the report to disk as a text file, select one of the following Print To
option buttons:

¢ ASCII Disk File if you want to create a text file, such as when you
want to import the register into a word-processing program.

e Tab-delimited Disk File, such as when you want to import the
register into a database program. (Oooh ... fancy....)

¢ 123 ((PRN) Disk File, such as when you want to import the register
into Lotus 1-2-3 or any spreadsheet program that will open 1-2-3
files (which, basically, means any spreadsheet program including
Microsoft Excel).

If you do indicate that you want a disk file, after you click the Print button
to start the ol’ printing process, Quicken displays the Create Disk File
dialog box, shown in Figure 5-8. This dialog box asks for the filename that
Quicken should create as part of printing the file to disk and asks where
you want to store the file. Just enter the filename you want into — you
guessed it — the File Name text box. (Use a valid filename, of course.) Use
the Save In box to indicate where you want to store the file. Or don’t do
anything, and Quicken creates the file in the active Quicken directory —
probably QUICKENW. And what do you do with the disk file? You're on
your own here. . ..
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|
Figure 5-8:
The Create
Disk File
dialog box.
|

Create Disk File ] =]
Save in |_} Quicken ﬂ e Ea-
[CHBACKUP
Filename: ||
Save as lype: |Text [ tut) j Cancel

Help

Lines Per Page: ’T éidth: ’H

7.

10.

11.

[Optional] Tell Quicken which pages to print.

Use the Print Range option buttons and text boxes to limit the pages
Quicken prints (refer to Figure 5-7). How? Select the Pages option button
and then type the range of page numbers you want to print. That’s simple
enough, right?

. [Optional] Color your world.

If you have a color printer and want to print your register in color, select
the Print In Color check box on the Print dialog box (refer to Figure 5-7).

. [Optional] Trade speed for quality.

Or you can select the Print In Draft Mode check box to tell Quicken it
should print faster and spend less time worrying about the quality of the
printing job (refer to Figure 5-7). In other words, you can use this check
box to trade print quality for print speed. Life is full of trade-offs, isn’t it?

[Optional] Tell Quicken to scrunch the information so that it fits
across the page.

Use the Fit To One Page Wide check box to tell Quicken that you want its
register information to fit across the width of the page (refer to Figure 5-7).

Click OK.

Quicken finally prints the register. 'm not going to show a printed copy
of the register here. All it is, really, is just a printed copy of the same
account detail information you see on the Register tab.
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Should you save a printed copy of your register?

Here's a question for you: Should you save a
printed copy of your register? | don't know. The
case for printing a copy of your register and
then having it handy in case, well, just in case,
is this: If your computer goes haywire and you
need to reenter your transactions or you need a
hard-copy record of your transactions and for
some reason don't have access to Quicken,
having a printed register will make things much
easier for you. You know what, though? | think
that most people, if they religiously back up their
Quicken data files (something | describe in
Chapter 9), don't really need to print copies of
their registers.

Now, | should say that if you're someone who
likes to keep meticulous records of your income

and spending and you always double-check to
make sure that you haven't left the iron on or
even plugged in whenever you leave your
house, you could print a copy of the register.
And what | would suggest is that you print a
copy of the register at the end of the year and
then file this report away with your tax return.

By the way, I've been using Quicken since 1988
and have never needed a printed copy of my
register. I've made frequent use of other reports.
But never have | needed a hard, paper copy of
my register. Anytime | have had a question, I've
simply looked through the online version of my
current register or archived files from previous
years.




Chapter 6
Online and In Charge

In This Chapter

Defining Online Account Access and Bill Payment

Paying bills with Online Bill Payment

Transferring money and downloading statements with Online Account Access

M any banks now offer electronic banking services in a big, big way. This

is a step toward providing a pretty impressive variety of online services
to the general consumer. (You and me.) This chapter covers the Quicken elec-
tronic banking services: Online Account Access and Online Bill Payment.

What Are Online Account Access
and Online Bill Payment?

I'm going to start with the basics — a definition of these two services.

Online services means that you can connect your computer to your bank’s
computer electronically through your Internet connection. You may think that
doing so sounds scary, but Online Account Access and Online Bill Payment
provide some very neat benefits:

v With Online Bill Payment, you can tell your bank or, in a pinch, Intuit’s
online financial services unit to make payments to specific individuals or
businesses. In other words, rather than providing all this information in
the usual way (on checks), you send the same information — the payees’
names, their addresses, the amounts, and so on — and then the bank
writes the checks. You can tell the bank to make automatic recurring pay-
ments for bills that you pay regularly basis, such as a rent or mortgage
payment. You can use Online Bill Payment at any bank.
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v With Online Account Access, you can get transaction information — such
as information about which checks and deposits cleared your account
and what bank service fees you've been charged — from the bank’s com-
puter. You can also transfer money between accounts — such as from
your savings account to your checking account and from your checking
account to your credit card account (to pay a credit card bill). To use
Quicken for Online Account Access, your bank must support the Quicken
Online Account Access service.

Wise Whys and Wherefores

Neither Online Account Access nor Online Bill Payment is difficult to use. And
despite the nightmares that people with delusional paranoia may develop about
electronic banking, the service is safe, secure, and very solid. Nevertheless,
before you, too, jump onto the Online Account Access and Online Bill Payment
bandwagon, you should probably consider a few points:

v As I noted in the preceding section, if you want to use the Online Account
Access feature, your bank must be a part of the Quicken Online Account
Access program. (See the next section for details on how to find out
whether your bank qualifies.)

v To sign up for and use Online Account Access or Online Bill Payment
services, you need an Internet connection.

v You should be fairly comfortable with Quicken, especially with account
transactions and transferring money between accounts. (Therefore, if
you’re new to Quicken, you should at least record a handful of checks,
make some deposits, and reconcile your account before venturing into
Online Account Access. This ramping up of your Quicken skills should
take, oh, [ don’t know, about two weeks.)

v Make sure that your records are completely up-to-date and reconciled
with the last statements you've received from the bank.

This stuff usually ain’t free. I can’t tell you how much these two services will
cost because your bank sets the charges. A good guess is $5 to $10 a month —
and that adds up over the course of a year. But in choosing to use Online
Account Access or Online Bill Payment, do consider all the hidden costs of
the normal way of banking and paying bills. Gasoline, time, and postage can
all add up, and these almost-hidden costs may make the costs of the online
services appear more reasonable. (Besides, you won’t have to deal with all
that nasty glue on your tongue from licking envelopes.)
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Banking with Online Account Access
and Online Bill Payment

To begin using either the Online Account Access or the Online Bill Payment
service, you have to sign up. If you want to use Online Account Access, you
sign up with your bank. Just visit your bank’s Web site or call your local
branch and ask someone whether the bank supports Online Account Access
with Quicken. (If your bank doesn’t support Online Account Access, you can
still sign up with Intuit for Online Bill Payment — check the Quicken.com Web
site for details.) Then do whatever the folks at the bank tell you to do to sign
up. You'll probably have to fill out an application, agree to pay some extra
fees, and then wait a few days for a customer identification number and a
PIN, or personal identification number.

After the bank does its preparation and sends you its welcome letter, you can
set up Quicken for Online Account Access. To set up Quicken to use Online
Account Access or Online Bill Payment services, display the account for which
you want to activate online services. You can do this, for example, by follow-
ing these steps:

1. Click the Cash Flow Center button and then click the account.
2. Tell Quicken you want to set up online banking or bill payment.

Click the Set Up Now button, which appears at the bottom of the register
area (as shown in Figure 6-1).

3. Identify yourself.

When Quicken displays the Quicken Account Setup dialog box (not
shown here), supply a customer identification number and also a per-
sonal identification number, or PIN.

Let me say a couple more quick things about setting up Online Account
Access or Online Bill Payment. Your bank or the Quicken folks may, as part
of the application process, send you a letter asking for more information, a
canceled check, or a signature. (If they do, of course, be sure to respond.)

Using Online Account Access and Online Bill Payment is extremely easy. You
pay bills in pretty much the usual manner. You make account transfers in the
same manner. And then you reconcile transactions with a mouse click.
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|
Figure 6-1:
Click the Set
Up Now
button for
online
banking.
|
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Finding an online bank — online

You can also find out which banks support Online Account Access by

using your Internet connection. To do so, choose the Onlinem>Participating
Financial Institutions command. When you choose this command, Quicken
starts your Web browser and then opens a page that lists the banks that
allow you to bank online or provide other online services to Quicken, as
shown in Figure 6-2. See the lower-left corner of the window? That list of
financial institutions tells you which banks work well with Quicken. (The
Quicken.com Web site may require you to register before it will supply a cur-
rent list of banks that will take your money for providing online services.)

Paying bills

You have three ways to record online payments. If you’re comfortable using
the Write Checks window, you write a check in the usual way. You enter the
payee name, an amount, probably a category, and so on. Just make sure that
you mark the Online Payment check box (as shown in Figure 6-3).

If you have questions about how the Write Checks window works, Chapter 5
shows you — among other things — how to use the Write Checks window to
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|
Figure 6-2:
The Par-
ticipating
Financial
Institutions
command
tells you
which
banks
support
Quicken.

|
Figure 6-3:
You record
online
payments
with the
Write
Checks
window by
marking the
Online
Payment
check box.

describe checks you want to print. You use the same basic procedure to
describe online payments that you want to make.
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|
Figure 6-4:
You record
online
payments
with the
register by
specifying
the Num as
Send.

If you're more comfortable using the register to record payments, you can
make online payments with that, too. In the Num column, just specify the
payment number as Send, as shown in Figure 6-4. (The last selected transac-
tion is the online payment.)

If you have questions about how the register works, you may want to refer
to Chapter 4. Chapter 4 describes — in some detail, [ might add — how the
Quicken register works.

You can also use the Payments tab in the Online Center to record an online
payment. If you take a close look at Figure 6-5, you can see this tab. Just fill
out the blanks on this tab like you fill out a check in the Write Checks window.
No sweat. By the way, you get to the Online Center by choosing Onlinex>
Online Center.

By the way, the first time you make an online payment to someone, Quicken
asks for some information in the Set Up Online Payee dialog box (shown in
Figure 6-6): where the person lives or where the business is located, and what
account number Quicken can use to identify the person or business. You can
also describe online payees by choosing Onlinez>Online Payee List, which
displays a list of online payees, and then clicking the New button, which dis-
plays the Set Up Online Payee dialog box, shown in Figure 6-6.
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After you record a payment, you send it to the bank. To do so, display the
Online Center by choosing Online=>Online Banking. When Quicken displays
the Online Center window, click the Update/Send button (refer to Figure 6-5).

When you click the Update/Send button, Quicken connects to your Internet
service provider and then, through the Internet, to your bank’s computer. As
part of making this connection, you need to provide a personal identification
number, or PIN. When Quicken finishes sending your payment instructions to
your bank, it displays the Online Transmission Summary dialog box, which
basically says you've connected to the bank’s computer and sent it some pay-
ment instructions. At this point, you're done.
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Honest Steve’s evaluation of online services

I'm pretty much a cynic when it comes to new
bells and whistles — or at least the kinds of
bells and whistles that software companies like
to add to the mature versions of their products.
And | hate making financial record keeping
more complicated. | like things simple. But all
that said, | think Online Bill Payment and, in par-
ticular, Online Account Access are slick.

If you're using Quicken to keep your financial
records, you get to pay your bills and reconcile
your bank accounts for basically no extra work.
Well, okay, you have to click your mouse an
extra time. And initially, you need to provide
addresses and account numbers for your
payees (which takes about five minutes). So you
do have to do a little extra work at the begin-
ning. But Online Account Access saves you
time and hassle when it comes to bill paying and
banking.

The only catch — and this is a big one for some
Quicken users — is that to use Online Account
Access, your bank needs to have its act
together. (Note that if your bank doesn’t support
Online Account Access with Quicken, you can
still use Online Bill Payment by signing up for
online payment with Intuit, as detailed at the
Quicken.com Web site.)

Now, all that said, | want to close with two
caveats. Here's the first one: Online Account
Access isn't worth it if it means you end up
banking at some poorly run bank. I, er, well,
yeah, you see, I've been there. And itisn't pretty.
To make a long, sorry story short, a long time
ago | had the experience of moving my banking
from a well-run bank that didn't have Online
Account Access to a poorly managed bank that
did. Online Account Access is not— | repeat, is
not — such a cool tool that you'll be happy
banking at First National Idiots.

And now a second caveat: | have to tell you that
online payments aren't, in my experience, as reli-
able as writing a regular check and then send-
ing that check through the mail. | dont know why
this is. But it's been my experience that online
payments sometimes get lost, and they some-
times get delayed. I've been using online bank-
ing and bill payment for several years now, and
several times a year, people or businesses call
and say, “Dude, we never got your payment” or
“Dude, we got your check late — you owe us a
late fee.” Over the same time period, I've only
had the U.S. Postal Service lose one check.

<MBER

Note: The first time that you use Online Account Access, Quicken asks you to

change your personal identification number, or PIN.

I need to make an important point here. You must send your payment instruc-

tions to the bank several days in advance of the time the bill needs to be

paid. For obvious reasons, the bank needs a day or two to process the bill.
And then the check probably has to go through the U.S. Postal Service. . . .
(I say “probably” in the previous sentence because a few payments get made

electronically.)
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Transferring money between accounts

As you may expect, you record Online Account Access transfers in the same
way you record regular transfers — or at least in almost the same way. For
online transfers, you can use the register in the normal way, but you need to
specify that the transaction is an online transfer. You can record an account
transfer on the Transfers tab in the Online Center window (as shown in Fig-
ure 6-7). Just enter the transfer information in the boxes Quicken provides.

You can also do this task from the register by activating the Num drop-down
list box and selecting the Online Transfer entry.

As with online payments, after you describe the online transfer that you
want to make, you need to make an online connection. To do so, click the
Update/Send button and then, when prompted, provide your PIN and click
Send. When Quicken finishes sending your bank your account transfer
instructions, you're done.

If you have a credit card with a bank that supports Online Account Access
and if you also set up the credit card for Online Account Access, you can pay
your credit card bill by transferring money from a bank account to your credit
card account. You probably already thought of this if you have a credit card
account. But [ thought I'd mention it anyway. (For more information about
credit card accounts, refer to Chapter 11.)

Online Center S[=)]=]
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U.S. Bank j 1 instruction

Transactions ] Payments ]Translers] E-mail(1} ]

Date: |:|
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Are you still with me?

Okay, I'm going to take a little breather here —
just to make sure that you understand what's
going on. When you boil everything down to its
essence, online payments are really just pay-
ment instructions you send your bank. And
when you make an online transfer, you are
effectively just calling the bank and saying,
“Please transfer money from one account to
that other account.”

This makes sense, right? You're really just giving
instructions to the bank. And then the bank (or

actually the bank’s computer) goes off and does
whatever you've told it to do. It's pretty simple.

Is Online Account Access anything to get all
excited about? Is it really as slick as some
people think? | think so. Sure, it's not always
cheap. But after you get going, you get away
from that business of finding your checkbook,
signing checks, finding stamps, and then, on
occasion, running down to the post office to
drop off some overdue bill.

\\J

Updating your Quicken accounts

One major advantage of Online Account Access is that you can get the most
up-to-date information regarding your accounts. Let me explain: When you

click the Online Center window’s Update/Send button, the bank automatically

sends current transactions to your computer. They’re not loaded immedi-
ately into your Quicken registers. Quicken gives you a chance to examine
them before they go into your records. To update a Quicken account, click
the Transactions tab of the Online Center window (as shown in Figure 6-8)
and select an account from the list box at the upper-left corner of the tab
window. When you do, the new transactions (if any have occurred) for that
account appear in the lower half of the tab window. (In Figure 6-8, no new
transactions have occurred, so none appeatr.)

To add the transaction that you've downloaded from the bank to your account
register, click the Compare To Register button. (This button is disabled in
Figure 6-8, so it’s hard to read.) Quicken then displays the appropriate register
in the top half of the window and the list of new transactions in the bottom
half. You can accept each new transaction one at a time by clicking it and then
clicking Accept. If you're the daring sort, you can click Accept All, and Quicken

places all the new transactions in your register. Click Done to close the window.

By regularly downloading transactions into your online accounts and matching
transactions between your Quicken records and the bank’s records, you don’t
need to reconcile your account. In effect, you reconcile your account just by
downloading and matching. You can also get information about checks and

debit card transactions that you've forgotten to record much earlier (because

you don’t have to wait until the end of the month).
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Figure 6-8:
The Trans-
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Online Center ==
Payees Repeating Contact Info PIN Yault  Renaming Rules Print  Options +

Financial Institutior: UpdatefSend. .

U3, Bank j 1 instruction
Transactions | _payments | Transfers | Emaity |

Cleared transactions and online balances downloaded on 5/18/2002. :

Account Transactions Onling Balance

US Checking 0 7,796.21

U3 Bank Visa ] 0.00

U5 Bank Money Market: 1] 0.00

Date Hum Payee Payment

Deposit

Communicating online with the bank

Quicken also provides a means of sending and receiving e-mail to and from
your bank. Click the E-Mail tab of the Online Center window, and you see
something similar to Figure 6-9.

Quicken sends and receives e-mail with any transactions when you click the
Update/Send button and then lists any messages that are received in the text
box on the E-Mail tab. To read a message, you just highlight it (by clicking it)
and then click the Read button. Quicken displays the e-mail message window.
Click Close. After you finish, Quicken returns you to the Online Center window.
If you don’t want to save the message, click it to highlight it and then click
Delete (available at the top of the Online Center window) to remove it from
the list.

If you want to send your bank a message, click the Create button. Quicken
displays a Create dialog box, shown in Figure 6-10. If you have a general ques-
tion about the bank’s online services or an online account, select the E-Mail
About An Online Account radio button and select the online account from the
Account drop-down list box. If you want to send a message regarding a specific
online payment, select the E-Mail About An Online Payment radio button and
click the online account and payment. Click OK. Quicken then opens a message
dialog box.
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|
Figure 6-9:
The E-Mail
tab of the
Online
Center
window.
|
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Create

" E-mail abaut an online accaunt

¢ E-mail about an online payment
|

Account:
Figure 6-10: |US Checking =]
Creating Payments:
an e-mail
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|

Quicken automatically fills in the date and the To text box. Fill in the other
text boxes by clicking them and then typing the necessary information. Open
the Regarding Account drop-down list box by clicking the down arrow and
then choose the appropriate account.

After you complete your message, click OK. Quicken records your message

and forwards it to the bank the next time that you click Update/Send.




Chapter 7

Reports, Charts, and
Other Cool Tools

In This Chapter

Printing Quicken reports

Using the Reports menu commands
QuickZooming report totals

Sharing information with a spreadsheet
Editing and rearranging report information
Creating a chart

Using QuickReports

uicken enables you to summarize, slice, and dice register and account
w” information in a variety of ways. This chapter describes how to use
reports and produce graphs easily. This stuff is much easier to understand
if you know how to print a register first (a trick I describe at the end of
Chapter 5).

Creating and Printing Reports

After you know how to print checks and registers, all other printing in Quicken
is easy, easy, easy.

Printing the facts, and
nothing but the facts

The transactions you enter in the register window and the checks you enter
in the Write Checks window determine the information in a report. To print a
report, just choose the Reports menu and tell Quicken which report you want
to print.
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Quicken produces a bunch of different reports. To make sense of what may
otherwise become mass confusion, Quicken arranges all its reports into
groups: Cash Flow reports, Investing reports, Tax reports, Net Worth &
Balances reports, and Business reports. (These sort of sound like PBS docu-
mentaries, don’t they? “Tonight, Joob Taylor explores the truth about tax
evasion in the lemonade stand industry in the Tax Report.”)

To see the reports in one of these groups, select the report group from the
Reports menu. If you read the fast-paced and exciting Appendix A, you know
that those little triangles to the right of menu command names tell you that
another menu follows.

Figure 7-1 shows the Cash Flow group of reports. Pretty exciting stuff so far,
don’t you think?

To create a Cash Flow report (or any other report, for that matter) on the fly,
choose the report from the appropriate menu. For example, to create the
Cash Flow Income/Expense report, choose Reports=>Cash Flowr>Income/
Expense. Quicken then creates the report, placing it inside a newly opened
window. Figure 7-2, for example, shows an Income/Expense Cash Flow report.
After you create a report, you can change the report date or date range by
using the boxes at the top of the report.

Quicken 2005 Premier - gdata? - [Checking] BE=
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help
@ - - T @ sz @ me ) Reports and Graphs
Back Update Reports  Setup  Services Cicken| Banking Summary Cash Flow N
Quicken Home 13 Chiecking ®  Budget Investing v
Celete  Find  Transfer Cash Flow Tax r
< Cash Flow Center Datef s Fm | Cash Flow Comparison Net Worth & Balances 4
Income/Expense
5/1/2005 il = L4 ) EasyAnswer Reports and Graphs
Savings 0.00 Income/Expense Comparison
sazma | [o/12/2005 Hemized Cateqories [ 416 54 16
- Missing Checks
| Investing Center 5/13/2005 1001 2550 228 66
s0.00 Monthly Budget
’ 5/51/2005  DEP Payee 100 00 328 66
¥ | Property & Debt Reconciliation
$0.00 /32005 Spending 25 50 303 16
Transaction
/42005 DEP T 100 00 403 16
Gift Received
/52005 THFR. Birthday 5000 353 16
[Savings]
&/5/2005 Carner Store 2000 335 16
--5plit--
5itj2005 [EE] Aum Fayee Payment Depost
— Category Memo Enter | Edit | Split |+
. Current Balance: 228,66 Ending Balance: 33316
Figure 7-1:
The CHSh ’m J Download Transactions | ‘ Scheduled Transactions {0 Due) ‘ i‘ |
Flow group )
Financial Overview @ Set Up Download | Set Up Online Payment ‘ Save time - autamatically keep this account up to date!
of reports.
Custamize Hide Amounts -?d Want to track vour business expenses the sasy way?
I
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|
Figure 7-2:
The Income/
Expense
Reportin
areport
window.
|

& Income/Expense B[]
Export Data « Preferences  How Do [#
> Date Range: | Year to date | Interval | ‘vear - Save Repoit | Customize

Print

Report History: IncomejExpense - YTD

1/1/2005 Thraugh 5{13/2005

Income/Expense - YTD

Report | Graph
QOVERALL
TOTAL

1j1/2005-

Category Description Si15/2005
INCOME
Salary

TOTAL INCOME

500,00
500.00

500,00
500.00

EXPENSES
Rent 250,00 250,00
Utilities 25,50 25.50
TOTAL EXPENSES 275.50 275.50

OYERALL TOTAL 224.50 224.50

To find out what type of information a report includes before you create the
report, or to preview a report, choose Reports>Reports And Graphs. This
displays the Reports And Graphs window, shown in Figure 7-3. Select a report
group by clicking a topic on the left side and then select the report you want
to create. You can change the report date or date range by using the box(es)
provided. Click Show Report to create the report.

If you don’t enter a new range of dates, Quicken assumes that you want to
include transactions from the start of the current calendar year through the
present date.

Reports that show account balances — such as the Account Balances report,
the Net Worth report, the Balance Sheet report, or the Portfolio Value report —
don’t need a range of dates because these reports show account balances as of
a specific date. In these cases, if you don’t enter a date, Quicken assumes that
you want account balances for the current system date from your computer’s
internal clock.

You can’t see the entire on-screen version of a report unless your report is very
small (or your screen is monstrously large). Press the PgUp and PgDn keys

to scroll up and down and use Tab and Shift+Tab to move right and left. Or if
you're a mouse lover, you can click-and-drag various pieces of the scroll bars.
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Reports and Graphs B[]
Preferences  How Do [?
Select a topic Select a report
Saved reports Where did | spend my money during the perio... [
How am 1 spending my money? Income/Expense

How are my investments doing? How much did | pend on ...7

Itemized Categories
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Payee
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EasyAnswer reports and graphs Caszh Flaw Camparisan
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|
Figure 7-3: For the period: ’W‘
The Reports
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W|nd0W. Show Report ‘ | Show Graph
|

To print your report, follow these steps:

1. Click the Print button.
Quicken displays the Print dialog box.

2. To accept the given specifications — which are almost always fine —
just click OK.

You’ll never guess what happens next: Quicken prints the report!

Print dialog box settings

I almost forgot. The Print To option buttons let you tell Quicken where it
should send the report it produces: to the printer or to a disk file. The check
boxes let you control aspects of printing, and the Print Range option buttons
and text boxes let you print a specific portion of the report.

I describe how these things work in Chapter 5, so I won’t repeat the discussion.
If you want the scoop, refer to the section about printing a check register.
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Reviewing standard reports

Tables 7-1 through 7-5 describe Quicken’s reports by group. (Some of these
babies won’t make sense unless you understand how to collect the informa-
tion that goes into the report, as I describe in Chapters 13 and 14.)

Table 7-1 Quicken Net Worth & Balances Reports
Report Description
Net Worth Lists all accounts, their balances, and the difference

between the sum of the asset accounts and the sum of the
liabilities accounts, which the report identifies as your net
worth.

Account Balances

Lists all accounts and their balances.

Table 7-2

Quicken Cash Flow Reports

Report

Description

Banking Summary

Summarizes spending totals by category.

Budget

Summarizes income and expense categories and compares
actual category totals for the year to budgeted category
amounts. This report includes only transactions that you
record in your bank, cash, and credit card accounts. (For
this report to work, of course, you need to have a budget
setup.)

Cash Flow

Summarizes the money that flows into and out of an
account by income and expense categories and by trans-
fers. Cash is king, dude, so this report only includes trans-
actions that you record in your bank, cash, and credit card
accounts.

Cash Flow
Comparison

Lets you compare category totals from two periods. You
can use this report to compare January’s activity with
February’s activity, for example. Remember: Because you
are comparing two periods, you need to enter two trans-
action date ranges.

Income/Expense

Summarizes income and spending.

Income/Expense
Comparison

Summarizes spending totals by category for two time
periods.

Itemized Categories

Lists transactions by category.

(continued)
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Table 7-2 (continued)

Report

Description

Missing Checks

Lists all the checks you've written and flags any gaps in
the check number sequence. This report helps you iden-
tify missing checks.

Monthly Budget

Summarizes income and expense categories and compares
actual category totals for a month to monthly budgeted cat-
egory amounts. This report includes only transactions that
you record in your bank, cash, and credit card accounts.
(For this report to work, of course, you need to have a
budget set up.)

Payee

Summarizes payments you've made to a particular payee
in the current year.

Reconciliation

Summarizes an account reconciliation that you've per-
formed. You don't need this report, really, unless you've
got a clinical anxiety disorder and need to prove to your-
self or your accountant that you really did reconcile your
account.

Spending

Summarizes spending.

Transaction

Lets you list transactions in multiple accounts
chronologically.

Table 7-3 Quicken Investing Reports

Report Description

Capital Gains Lists all the realized gains on individual investments you
hold. (A capital gain occurs when an investment is worth
more than you paid for it. When you sell the investment,
you realize the gain.)

Investment Asset Shows investments by asset class.

Allocation

Investment Activity Shows investment transactions grouped by activity.

Investment Income

Summarizes income and expense categories for the trans-
actions you record in your investment accounts.

Investment
Performance

A power-user report. This report calculates the internal
rates of return delivered by each of the individual invest-
ments in your portfolio.
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Report Description

Investment Lists recorded transactions for all your investment
Transactions accounts.

Portfolio Value Lists the current value of all securities in your investment

accounts.

Portfolio Value &

Lists the current value and cost of all securities in your

Cost Basis investment accounts.

Table 7-4 Quicken Tax Reports

Report Description

Capital Gains Lists all the realized gains on individual investments you

hold. (A capital gain occurs when an investment is worth
more than you paid for it. When you sell the investment,
you realize the gain.)

Schedule A-ltemized
Deductions

Lists and summarizes transactions that probably belong
on your Schedule A tax form as itemized deductions: mort-
gage interest, property taxes, charitable contributions,
and so on.

Schedule B-Interest
and Dividends

Lists and summarizes interest and dividend income trans
actions that need to be reported on your Schedule B tax
form.

Schedule D-Capital
Gains and Losses

Lists and summarizes capital gain and loss transactions
that need to be reported on your Schedule D tax form.

Tax Schedule

Lists all transactions you've entered as tax-related and
subtotals them by line item.

Tax Summary

Lists all transactions you've described as falling into tax-
related categories.

Table 7-5

Quicken Business Reports

Report

Description

Accounts Payable

Summarizes unprinted checks by payee for all your bank
accounts.

Accounts Receivable

Summarizes uncleared transactions for all other asset
accounts.

(continued)
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Table 7-5 (continued)

Report

Description

Balance Sheet

Lists all accounts, their balances, and the difference
between the sum of your asset accounts and the sum of
your liabilities accounts, which the report identifies as
your equity. This report is almost identical to the Net
Worth report in the Cash Flow group.

Cash Flow

Summarizes the money received by and paid out of an
account by income and expense categories and by trans-
fers. This report includes only transactions you record in
your bank, cash, and credit card accounts.

Cash Flow Comparison

Lets you compare category totals from two periods. You
can use this report to compare January’s activity with
February’s activity, for example. (Because you are com-
paring two periods, you must enter two transaction date
ranges.) This report is identical to the Cash Flow
Comparison report in the Cash Flow group.

Missing Checks

Lists all the checks you've written and flags any gaps in
the check number sequence. This report helps you iden-
tify missing checks and is identical to the Missing Checks
report in the Cash Flow group.

Payroll

Summarizes income and expense categories that begin
with the word payroll. If you do things correctly, you can
use this report to prepare quarterly and annual payroll tax
reports. (See Chapter 15 for the rest of the story.)

Profit & Loss
Comparison

Lets you compare profit and loss by category for two peri
ods. You can use this report to compare January’s profit
with February's profit, for example.

Profit & Loss
Statement

Summarizes income and expense category totals. This
report includes transactions from all your accounts. It also
helps you answer the business question, “Am | compen-
sated fairly for the hassle and the risk?”

Project/Job

Summarizes income and expense category totals with
each class'’s information displayed in a separate column.
You must be using classes, an advanced Quicken feature,
for this report to make any sense.
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Finding the report you want

Okay, if you've read or even skimmed the reports I describe in Tables 7-1
through 7-5, you're probably a little overwhelmed. Quicken produces a bunch
of different reports. How do you know which one provides the answers you
want? What are you supposed to do? Sift your way through a couple dozen

of these babies?

Thankfully, the answer is no. Quicken also provides something called
EasyAnswer reports. In effect, EasyAnswer reports let you identify the
question that you want a report to answer. After you identify the question,
Quicken produces the appropriate report. Here’s how this all works:

1. Choose Reports->EasyAnswer Reports And Graphs.
Quicken displays the EasyAnswer topic of the Reports & Graphs window.
2. Indicate your question.

To tell Quicken what your question is, click one of the questions and
then use the drop-down list boxes that accompany each question to
further refine your question. For example, the “Where did [ spend my
money?” question lets you pick the period of time you’re asking about:
Last Year, Last Month, Current Year, Month to Date, and so on.

3. Click Show Report.

Quicken produces a report that answers your questions. If you ask the
question, “Where did | spend my money last year?” for example, Quicken
produces a cash flow report that summarizes the previous year’s income
and expenses by category.

Going to the printing dog-and-pony show

You can do some neat things with the reports you create. | won’t spend a
bunch of time talking about these things, but [ do want to give you a quick
rundown of some of the most valuable tricks.

Got a question about a number? Just zoom it

If you don’t understand where a number in a report came from, point to

it with the mouse. As you point to numbers, Quicken changes the mouse
pointer to a magnifying glass marked with a +. Double-click the mouse, and
Quicken displays a list of all the transactions that make up that number.

This feature, called QuickZoom, is extremely handy for understanding the fig-
ures that appear on your reports. If you double-click the Utilities number in
the report in Figure 7-2, for example, Quicken displays the QuickZoom report
shown in Figure 7-4.
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Customizing

If you want to extract some financial tidbit, you
can usually get what you want from one of the
reports listed on the Reports menu, especially if
you use the EasyAnswer feature to find the right
report!

| should tell you something: Quicken is remark-
ably sophisticated in its reporting. You can cus-
tomize any report you see in the Reports menu.

To customize these reports, click the Customize
button to get to the nuts and bolts of your
selected report.

I’'m not going to describe the Customization
process. | feel kind of bad about this omission
because a few people are probably out there
who, late one night, will decide that they want
to know how to filter, sort, and customize. Of

your reports

course, there are also people who will decide
late some night that they want to know how to
replace the transmission on a 1971 Triumph
Spitfire. And I'm not describing that here, either.

If you really want to customize your reports, just
noodle around. You can't hurt anything.

If you do play around with these items, you can
save any custom report specifications that you
create. To do so, click the Save Report button at
the top of the report window. Quicken displays a
dialog box that asks you to supply a name for
your customized report. (You can also provide a
default report date range.) After you name the
customized report, Quicken lists it whenever you
choose Reportse>Saved Reports And Graphs.

Ah, yes. The cable TV bill. Doesn’t cable TV seem to just get more and more

expensive every year?

Income/Expense Comparison - ...

Date " Account ||

5132005  Checking

Income/Expense Comparison B[]

Delete  Export Data Sork - Preferences  How Do [#
<:| > Date Range: | Year to date ~ | Subtotal By: | Don't subtotal - Save Repoit | Customize
Back Print AlAmA

Report History: Utilities:Cable TV - YTD

1/1/2005 Through 5/13/2005

Mum || Description ” Memo ” Category ”CIr” Amount ||

1001 Movigs Galare Utilities:Ca... -25.50

|
Figure 7-4:
The
QuickZoom
report.
|

TOTAL 1/1/2005 - 5/13/2005

-25.50

TOTAL INFLOWS 0.00

TOTAL OUTFLOWS -25.50

MNET TOTAL -25.50
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Sharing report data with spreadsheets

If you use a Windows spreadsheet such as Microsoft Excel, 1-2-3 for Windows,
or Quattro Pro for Windows, you can copy the stuff that shows in a report
window to the Clipboard. Just click the Copy button. Start your spreadsheet
program and choose Editr>Paste to paste the stuff from the Clipboard into
your spreadsheet. This process really isn’t very hard, so go ahead and try it.
You may need to use this feature if you want to use a spreadsheet to analyze
the report data.

Editing and rearranging reports

You may notice that when Quicken displays the report window, it also dis-
plays a row of buttons, including (roughly left to right) Delete, Copy, Sort, Save
Report (refer to Figure 7-2), Preferences, and Customize. Also appearing are the
Date Range box and the Subtotal By box. Earlier in the chapter, in “Printing the
facts, and nothing but the facts,” I talk about what the Date Range box does. So
in the interest of fair play, I'll briefly discuss what the other buttons do. (Not all
these buttons are available in every report document window. And sometimes
Quicken uses different names to refer to them. I don’t know why, really. Maybe
it’s just to keep you guessing.)

You really don’t need to worry about these other buttons. Read through the
discussion that follows only if you're feeling comfortable, relaxed, and truly
mellow. Okay?

Delete

The Delete button deletes the current report from the report list. You can use
this button to, in effect, undo any changes you’ve made to a report and return
to the default report specifications.

Copy

[ already talked about this option in “Sharing report data with spreadsheets,”
earlier in this chapter: It copies the report data so that you can paste the
data into a spreadsheet.

Sorting

The Sort button displays a list or sorting options that you can use for arrang-
ing information on the report. Enough said.

Save Report

Say you get into this customization thing. If you do, you should know that
you can save your customized reports by clicking the Save Report button.
When you click Save Report, Quicken displays the Save Report dialog box,
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|
Figure 7-5:
The Save
Report
dialog box.
|

shown in Figure 7-5. Mostly, Quicken displays this dialog box so that you can
give your creation a name. You also use this dialog box to indicate in which
financial activity center Quicken should save your report.

Save Report

Report Mame: |IncomeJEkpanse Comparigon Ok,

Select a center for this report

¢ Cash Flow Center " Property & Debt Center
" Investing Center " Met\Worth Center

Help

" Tax Center

Look tor this saved repart in the selected Center or in
Reports and Graphs.

Description; [optionall

By the way, after you create a saved report, you can reproduce it by choosing
Reports=>Saved Reports And Graphs and then selecting the saved report name.

What's the Preferences button for?

When you click the Preferences button, Quicken displays a Preferences dialog
box with a bunch of boxes and buttons that let you change the way the window
looks or works.

If | were a really great writer — the Stephen King of computer books, for
example — [ might be able to whip up a riveting discussion of how the
Preferences dialog box works. I'm going to do both you and my publisher a
favor, however, by making a suggestion. Just play with these option settings
if you're interested. You'll find it more fun and a better learning experience.

Date Range

[ briefly mention the Date Range box earlier in the chapter, but here I provide a
slightly more detailed description. The Date Range box displays a drop-down
list that you can use to specify what time period you want listed on your report:
the current month, last year, the current quarter to date, and so on.

Column subtotaling

The Interval box displays a list that enables you to tell Quicken you want
subtotal amounts by some criterion, as shown in Figure 7-6. Just select the
criterion. Note that sometimes the Interval box is replaced with a Subtotal
By box.
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& Income/Expense B[]
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|
Figure 7-6:
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Customizing

The Customize button works pretty much the same no matter which report
shows in the document window.

When you click this button, Quicken displays a dialog box that lets you enter
the report title and specify the range of dates the report should cover by using
text boxes. It also lets you choose from a variety of other options, too, such
as which accounts to use, which transactions to use, and how the report’s
information should be arranged.

Charts Only Look Tricky

I love charts. | know that sounds goofy. But data graphics — as the snobs and
academics call it — open up wonderful opportunities for communicating.
And Quicken charts are really easy to use.

To produce a Quicken chart, just produce the report you want using the
Reports And Graphs window, which you get to by choosing the Easy Reports
And Graphs command from the Reports window. Then, select the report you
want and click the Show Graph button. That’s it. Easy as rolling off a log.
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Note: Not all reports provide data that can be plotted in a graph. Accordingly,
you won'’t see a Show Graph button in every report window.

Figure 7-7 shows a picture of a bar graph of income and expense figures. But
you’ll have much more fun looking at your own data in a picture. By the way,
you can use QuickZoom (described earlier in this chapter in “Got a question
about a number? Just zoom it”) on a chart to see a report that describes the
data being plotted.

You can memorize customized graphs the same way you memorize customized
reports. Just click the Save Report button at the top of the graph window.
Then, when Quicken prompts you, give the graph a name. To later reuse the
graph, choose Reports=>Saved Reports And Graphs, select the saved graph
from the menu that Quicken displays, and click OK.

Income/Expense [™[=(]
Preferences  How Do [#
> Date Range: | Yeartodate | v | Intervat | ear = Save Repott || Customize
Print
IncomefExpense - YTD

Report History:
(]

q 1/1/2005 Through 5/13/2005
Income/Expense - YT

Report Graph

¥ Income
600 Expense

&00
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Figure 7-7:
The Income/ o
Expense —
YTD graph.
|
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OuickReports: Last but Not Least

Before I forget, I need to tell you about one other variant of the Quicken report-
ing feature: QuickReports. Ah, yes, QuickReports. Here’s the deal. Quicken sup-
plies a quick-and-dirty report called, cleverly enough, a QuickReport. If you're
working with the register, you can produce a quick report that summarizes
things, such as the checks written to a particular payee or the transactions
assigned to a specific income or expense category.
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Figure 7-8:
Here'sa
QuickReport.
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To produce a QuickReport, first move the cursor to the field that you want
to summarize in the report. Then click the Report button at the top of the
register window. Choose the report you want from the Report menu that
drops down. The report shown in Figure 7-8, for example, is a QuickReport
summarizing the generous $100 checks you received from your Aunt Enid.

Payee Report =aE

Export Data v Sort v Preferences How Do 17

> Date Range: | Current Year | Subtatal By: | Don't subtotal - Save Report | Customize
Print
; Payee Report - Current Yr
Report History: ¥ P
3 " 1/1/2005 Through 124312005

- Curr

Date " Account || MNum || Description ” Mema ” Categary ” r ” Amount ||
5/31/2005  Checking DEP Aunt Enid Gift Received 100,00
&/4/2005 Checking DEP Aunt Enid Gift Received 100,00
TOTAL 1/1/2005 - 12/31,/2005 200.00

TOTAL INFLOWS 200.00
TOTAL DUTFLOWS 0.00
NET TOTAL 200.00
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Chapter 8
A Matter of Balance

In This Chapter

Choosing the account you want to balance

Telling Quicken to balance an account

Giving Quicken the bank statement balance

Entering monthly service charges and interest income

Marking account transactions as cleared or uncleared

Verifying that uncleared transactions explain the account difference
Checking for errors: What you should do if your account doesn’t balance

want to start this chapter with an important point: Balancing a bank
account in Quicken is easy and quick.

I'm not just trying to get you pumped up about an otherwise painfully boring
topic. I don’t think balancing a bank account is any more exciting than you
do. (At the Nelson house, we never answer the “What should we do tonight?”
question by saying, “Hey, let’s balance an account.”)

My point is this: Because bank account balancing can be tedious and boring,
use Quicken to speed up the drudgery.

Note: If you're using online banking for accounting and you regularly download
account transactions, you don’t need to reconcile your account. When you

compare the downloaded transactions to your register, you, in effect, recon-
cile your account. See Chapter 6 for more information about online banking.

Selecting the Account You Want to Balance

This step is easy. And you probably already know how to do it, too.

1. Click the Cash Flow Center button.

Quicken displays the Cash Flow Center window (shown in Figure 8-1).



] 26 Partii: The Absolute Basics

|
Figure 8-1:
The Cash
Flow Center
window.
|

Quicken 2005 Premier - qdataZ - [Cash Flow Center] [BE=
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help
¥ T ‘. W
@ G 4 P 40 w ===
Back  Update Reports  Setup  Services Quicken.com Custamize
Quicken Home 13 Lash Howr lenter My Data | Analysis & Reports
Hiow Do T2
~
Cash Flow Alerts Options Online Updates -
Checking 228,66 You currently have no cash Flow alerts e Step Update
Savings 0.00
$228.66 Show all alerts | | St Up Alerts Never connected.
S Schedule Updates
| Investing Center Spending & Savings Accounts Options +
$0.00 Account MinBal IntRate  Current Balance Ending Balance| | Save time --
b spending download your credit card,
=) Property & Debt Cherking 000 Mot Set 22666 39396 | [aat 1 ow
$0.00 Subtotal 228.66 333.16
- May 2005
Savings S M T W T F 5
Savings 0.00 Mok Set 0.00 550.00 Tk b B B 7
Subtotal 0.00 550.00
@10 (11 12 13 (14
Total 228.66 883.16| 5 |15 17 & 19 =0 &1
Add Account | | Edit Accounts e Quicken Bill Pay b b3 b4 b5 be &7 b8
Credit Card Accounts Options * 29 30 31
Track your credit card spending, Add credit card accounts, Full Calendar ﬂ ﬂ
Add Account | | Edit Accounts &5 Quicken MasterCard
EERITIn $228.66 Cash Flow Services
Bills and Scheduled Transactions Options ¥ | Pay Bils Online
Financial Overview Q B T ——— = _ Download Banking Data hd
Customize Hide Amaunts " Save time with checks I can print from Quicken!

2. Next, click the account that you want to balance.

Quicken displays the register window, which lists information about the

account.

Balancing a Bank Account

As I said, balancing a bank account is remarkably easy. In fact, I'll go so far as
to say that if you have any problems, they’ll stem from . . . well, sloppy record
keeping that preceded your use of Quicken.

Telling Quicken, “Hey, man, | want
to balance this account”’

To tell Quicken that you want to balance, or reconcile, your account records
with the bank’s records, click the Reconcile button. The Reconcile button
appears at the top of the register window. Quicken displays the Statement
Summary: Checking dialog box, shown in Figure 8-2.
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|
Figure 8-2:
The
Statement
Summary:
Checking
dialog box.
|

S Si y: Checking
The last statement ending date: M4
1 . Enter the following from your bank statement.
Opening Balance: ’4157
Ending Balance: ’318587
Mew Statement Ending Date: ’W

2. Enter and categorize your interest and bank charges, if any.

Service Charge: 10 Date: [5/13/2005

Categary: |Bank Charge lz‘

Interest Eamed: | Date; [5/13/2005
Categary: |Inte|est Inc: lz‘
| Ok | ‘ Cancel | | Help |

Giving Quicken the bank’s information

As you probably know, in a reconciliation, you compare your records of a
bank account with the bank’s records of the same account. You should be able
to explain any difference between the two accounts — usually by pointing to
checks that you've written but that haven’t cleared. (Sometimes deposits fall
into the same category; you’'ve recorded and mailed a deposit, but the bank
hasn’t yet credited your account.)

The first step, then, is to supply Quicken with the bank’s account informa-
tion. This information comes from your monthly statement. Supply Quicken
with the figures it needs as follows:

1. Verify the opening balance.

Quicken displays a figure in the Opening Balance text box. If this figure
isn’t correct, replace it with the correct figure. To do so, move the cursor
to the text box and type over the given figure. (If you're reconciling your
account for the first time, Quicken gets this opening balance figure from
your starting account balance. If you’ve reconciled before, Quicken uses
the Ending Balance that you specified the last time you reconciled as the
Opening Balance.)

2. Enter the ending balance.

Move the cursor to the Ending Balance text box and type the ending, or
closing, balance shown on your bank statement.

3. Provide the statement’s ending balance date.

Move the cursor to the New Statement Ending Date text box and type
the ending date for the statement you’re using to reconcile.

127
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4. Enter the bank’s service charge.

If your bank statement shows a service charge and you haven'’t already
entered it, move the cursor to the Service Charge text box and type the
amount.

5. Type a transaction date for the service charge transaction.

Quicken supplies its best guess for the date. If you're reconciling for the

first time, Quicken uses the current system date from your computer’s

clock. If you’ve reconciled the account before, Quicken picks a date one

month later from the last time you reconciled the account. If the date
‘x&“\BE” Quicken picks isn’t correct, type the correct date.

You can adjust a date one day at a time by using either the + or — key.
6. Assign the bank’s service charge to a category.

Quicken helps you out by displaying the Bank Charge category in the first
Category text box — the one beneath the Service Charge text box. If you
want to use a different category, click the down arrow in the Category
text box to open the Category drop-down list box; then select a category
by scrolling down the list and pressing Enter.

7. Enter the account’s interest income.

If the account earned interest for the month and you haven’t already
entered this figure, type the amount in the Interest Earned text box.

8. Enter a transaction date for the interest income transaction.

You already know how to enter dates. | won’t bore you by explaining it
again (but see Step 5 if you're having trouble).

9. Assign the interest to a category.

Type an appropriate income category for any interest — perhaps some-
thing like, er, Interest Income.

10. Tell Quicken that the bank statement is complete.

To do so, just click OK. Quicken displays the reconcile window, which I
describe in the next section.

Explaining the difference between your
records and the bank’s records

Next, Quicken compares your register’s account balance with the bank state-
ment’s ending account balance. Then it builds a list of checks and deposits
that your register shows but that haven’t yet cleared (haven’t been recorded
by the bank). Figure 8-3 shows the Statement Summary: Checking window
that Quicken displays to provide you with this information.
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Figure 8-3:
The
Statement
Summary:
Checking
window.
|

A\

s Summary: Checking FEx]
Mew Edit  Delete Back to Statement Summary View = How Do I?
Payments and Checks Deposits
Clr Date Chk # Payee Amaunt
5/1/2005 DEP  Salt Mine, LLC S00.00
5/31/2005 DEP  Aunt Enid 100.00
632005 Movies Galore -25.50 642005 DEP  Aunt Enid 100.00
6/5/2005 TsFR Birthday -50.00
6/5f2005 Corner Store -20.00
& 5/13/2005 Service Charge -10.00
0 deposits, credits 0.00
Cleared Balance: -5.84
Statement Ending Balance: 318.66
1 check, debit 10,00 Difference: -324.50
Mark Al Cancel Finish Later | Finished |

As Figure 8-3 shows, the Statement Summary: Checking window is basically
just two lists — one of account withdrawals and one of account deposits. The
window also displays some extra information at the bottom of the screen:

the Cleared Balance (which is your account balance including only those
transactions that you or Quicken have marked as cleared), the Statement
Ending Balance, and the Difference between these two figures.

If you don’t like the order in which withdrawals and deposits are arranged, you
can change it. Click the View button and choose Sort By Date, and Quicken
reorders the transactions by date.

Marking cleared checks and deposits

You need to tell Quicken which deposits and checks have cleared at the bank.
(Refer to your bank statement for this information.)

1. Identify the first deposit that has cleared.

You know how to do so, I'm sure. Just leaf through the bank statement
and find the first deposit listed.

2. Mark the first cleared deposit as cleared.

Scroll through the transactions listed in the right column of the Statement
Summary: Checking window, find the deposit, and then mark it as cleared
by clicking it. Quicken places a check mark in front of the deposit and
updates the cleared statement balance.
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3. Record any cleared but missing deposits.

If you can’t find a deposit, you haven’t entered it into the Quicken register
yet. I can only guess why you haven’t entered it. Maybe you just forgot.
In any event, return to the Quicken register by clicking the Edit button
and then enter the deposit in the register in the usual way — but type a
c (for “cleared”) in the Clr column. This mark identifies the deposit as one
that’s already cleared at the bank. To return to the Statement Summary:
Checking window, click the Reconcile button.

4. Repeat Steps 1, 2, and 3 for all deposits listed on the bank statement.
5. Identify the first check or other withdrawal that has cleared.

No sweat, right? Just find the first check or withdrawal listed on the
bank statement.

6. Mark the first cleared check or other withdrawal as cleared.

Scroll through the transactions listed in the left column of the Statement
Summary: Checking window, find the first check, and select it to mark it
as having cleared the bank. Quicken inserts a check mark to label this
transaction as cleared and updates the Cleared Balance.

7. Record any missing but cleared checks or withdrawals.

If you can’t find a check or withdrawal — guess what? — you haven’t
entered it in the Quicken register yet. Display the Quicken register by
clicking the Edit button. Then enter the check or withdrawal in the regis-
ter. Be sure to type a ¢ (for “cleared”) in the Clr column to identify this
check or withdrawal as one that’s already cleared the bank. To return to
the Statement Summary: Checking window, click the Reconcile button.

8. Repeat Steps 5, 6, and 7 for withdrawals listed on the bank statement.

By the way, these steps don’t take very long. It takes me about two minutes
to reconcile my account each month. And I'm not joking or exaggerating. By
two minutes, I really mean two minutes.

Matking sure that the difference equals zero

After you mark all the cleared checks and deposits, the difference between
the cleared balance for the account and the bank statement’s ending balance
should equal zero. Notice that I said should, not will. Figure 8-4 shows a
Statement Summary: Checking window in which everything is hunky-dory,
and life is grand.

If the difference does equal zero, you're done. Just click the Finished button
to tell Quicken that you’re done. Quicken displays a congratulatory message
telling you how proud it is of you, and then it asks whether you want to print
a Reconciliation report.
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s Summary: Checking FEx]
Mew Edit  Delete Back to Statement Summary View = How Do I?
Payments and Checks Deposits
Clr Date Chi # Payes Amount Clr Date Chk # Payee Amaunt
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Figure 8-4:
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Statement
Summary:
CheCklng 2 deposits, credits 600.00
window
ShOng a Cleared Balance: 318.66
Statement Ending Balance: 318.66
Cleared Difference: 0.00
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balance.
Mark Al Cancel Finish Later | Finished |
|

As part of the finishing-up process, Quicken changes all the cs to Rs. There’s
no great magic in this transformation. Quicken makes the changes to identify
the transactions that have already been reconciled.

P Can’t decide whether to print the Reconciliation report? Unless you’re a busi-
ness bookkeeper or an accountant reconciling a bank account for someone
else — your employer or a client, for example — you don’t need to print the
Reconciliation report. All printing does is prove that you reconciled the
account. (Basically, this proof is the reason you should print the report if you
are a bookkeeper or an accountant — the person for whom you’re reconciling
the account will know that you did your job and will have a piece of paper to
come back to later if she has questions.)

If the difference doesn’t equal zero, you have a problem. If you click Finished,
Quicken provides some cursory explanations as to why your account doesn’t
balance (via the Adjust Balance dialog box shown in Figure 8-5). This box
tells you, in effect, that you can force the two amounts to agree by clicking
the Adjust button.

Vg‘“\NG! Forcing the two amounts to agree isn’t a very good idea. To do so, Quicken
adds a cleared and reconciled transaction equal to the difference. (I talk about
this transaction in the upcoming section “Ten Things You Should Do If Your
Account Doesn’t Balance.”)



132 Partii: The Absolute Basics

|
Figure 8-5:
The Adjust
Balance
dialog box.
|

Adjust Balance

The total of the items you have marked is $25.50 more than the tatal
of the items shown on pour bank statement.

*r'ou may have Quicken enter a balance adjustment in pour register
far this amaunt, or click Cancel to go back to reconciling.

Adjustment Date: |5/13/2005

| Adjust | ‘ Cancel | | Help |

If you want to reconcile later without saving your unfinished work, click
Cancel in the Statement Summary: Checking window and then click Yes
when Quicken asks you whether you really want to quit without saving your
work. The next time you click the Reconcile button, you'll have to start over
from scratch.

If you can’t get your account to reconcile but want to save your work, click
the Finish Later button. Quicken leaves your reconciliation work basically
half done. The transactions that you marked as cleared still show a c in the
Clr field. And you still have an explainable difference between the bank state-
ment and your register.

Either way, postponing a reconciliation and not choosing to adjust the bank
account balance is usually the best approach. It enables you to locate and cor-
rect problems. (I give you some ideas about how to do so in the next section.)
Then you can restart the reconciliation and finish your work. (You restart a
reconciliation in the same way that you originate one.)

Ten Things You Should Do If Your
Account Doesn’t Balance

I have some suggestions for reconciling an account that’s causing you prob-
lems. If you're sitting in front of your computer wringing your hands, try the
following tips.

Make sure that you're working
with the right account

Sounds dumb, doesn'’t it? If you have a bunch of different bank accounts, how-
ever, ending up in the wrong account is pretty darned easy. So go ahead and
confirm, for example, that you're trying to reconcile your checking account at
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Mammoth International Bank by using the Mammoth International checking
account statement.

Look for transactions that the bank
has recorded but you haven'’t

Go through your bank statement and make sure that you have recorded

every transaction that your bank has recorded. Cash machine withdrawals,

special fees or service charges (such as for checks or your safety deposit

box), automatic withdrawals, direct deposits, and so on are easily overlooked.
¥ If the difference is positive — that is, the bank thinks you have less money
than you think you should — you may be missing a withdrawal transaction.
If the difference is negative, you may be missing a deposit transaction.

Look for reversed transactions

Here’s a tricky one. If you accidentally enter a transaction backwards — a
deposit as a withdrawal or a withdrawal as a deposit — your account won’t
balance. And the error can be difficult to find. The Statement Summary:
Checking window shows all the correct transactions, but a transaction amount
appears positive when it should be negative or negative when it should be
positive. The check you wrote to Mrs. Travis for your son’s piano lessons
appears as a positive number (a deposit) instead of a negative number (a
check), for example.

Look for a transaction that’s

equal to half the difference

One handy way to find a transaction that you entered backwards — if you
only have one — is to look for a transaction that’s equal to half the irreconcil-
able difference. For example, if the difference is $200, you may have entered a
$100 deposit as a withdrawal or a $100 withdrawal as a deposit.

§,‘&N\BEI? [ don’t want to beat a dead horse, but the sign (that is, positive or negative) of
& the difference should help you find the problem. If the difference is positive —
the bank thinks you have less money than your register indicates — you
may have mistakenly entered a withdrawal as a deposit. If the difference is
negative — the bank thinks you have more money than your register says —
you may be missing a deposit transaction.
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Look for a transaction that's
equal to the difference

While I'm on the subject of explaining the difference by looking at individual
transactions, let me make an obvious point. If the difference between the
bank’s records and yours equals one of the transactions listed in your regis-
ter, you may have incorrectly marked the transaction as cleared or incorrectly
left the transaction marked as uncleared.

I don’t know. Maybe that was too obvious.

Check for transposed numbers

Transposed numbers occur when you flip-flop two digits in a number. For
example, you enter $45.89 as $48.59.

Transposed numbers are tough to find, but here’s a trick you can try. Divide
the difference shown on the Statement Summary: Checking window by nine. If
the result is an even number of dollars or cents, you may have a transposed
number somewhere.

Have someone else look over your work

This idea may seem pretty obvious, but I'm amazed at how often a second
pair of eyes can find something that you’ve been overlooking.

If you're using Quicken at home, ask your spouse. If you're using Quicken at
work, ask the owner or one of your coworkers (preferably that one person
who always seems to have way too much free time).

Look out for multiple errors

By the way, if you find an error by using this laundry list and still can’t bal-
ance your account, you should start checking at the top of the list again. You
may, for example, discover — after you find a transposed number — that you
entered another transaction backwards or incorrectly cleared or uncleared a
transaction.
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Try again next month (and maybe
the month after that)

If the difference isn’t huge in relation to the size of your bank account, you
may want to wait until next month and attempt to reconcile your account
again.

Before my carefree attitude puts you in a panic, consider the following exam-
ple. You reconcile your account in January, and the difference is $24.02. Then
you reconcile the account in February, and the difference is $24.02. Then you
reconcile the account in March, and, surprise, surprise, the difference is still
$24.02.

What’s going on here? Well, your starting account balance was probably off
by $24.02. (The more months you try to reconcile your account and find that
you're always mysteriously $24.02 off, the more likely it is that this type of
error is to blame.)

After the second or third month, I think it’s pretty reasonable to tell Quicken
that it should enter an adjusting transaction for $24.02 so that your account
balances. (In my opinion, this is the only circumstance that merits your
adjusting an account to match the bank’s figure.)

By the way, if you've successfully reconciled your account with Quicken
before, your work may not be at fault. The mistake could be (drum roll,
please) the bank’s! And in this case, you should do something else. . . .

Get in your car, drive to the
bank, and beqg for help

As an alternative to the preceding idea — which supposes that the bank’s
statement is correct and that your records are incorrect — I propose this
idea: Ask the folks at the bank to help you reconcile the account. (Check to
see whether they charge for this service first, of course.) Hint that you think
that the mistake is probably theirs. Smile a great deal. And one other thing —
be sure to ask about whatever product they’re currently advertising in the
lobby. (This behavior encourages them to think that you're interested in that
180-month certificate of deposit, and they’ll be extra nice to you.)
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In general, the bank’s record keeping is usually pretty darned good. I've never
had a problem as a business banking client or as an individual. (I've also been
lucky enough to deal with big, well-run banks.)

Nevertheless, your bank may have made a mistake, so ask the people there
to help you. (Note: Be sure to have them explain any transactions that you
discover only by seeing them on your bank statement.)
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Housekeeping for Quicken

In This Chapter

Backing up your Quicken data

Knowing when and how often to back up your data

Knowing what to do if you lose your Quicken data

Creating and working with more than one set of Quicken data
Setting up a new file password

Changing a file password

Okay, you don’t have to worry about chasing dust bunnies in Quicken,
but you do have to take care of little housekeeping tasks. This chapter
describes these chores and how to do them right, with minimal hassle.

Backing Up Is Hard to Do

You should back up the files that Quicken uses to store your financial
records. But you need to know how to back up before you can back up.

Backing up the quick-and-dirty way

You’re busy. You don’t have time to fool around. You just want to do a pass-
able job backing up files. Sound like your situation? Then follow these steps:

1. Insert a blank, formatted floppy disk, a writeable CD, or a blank Zip
disk into the appropriate drive.

You can back up to any disk you can write to — this can be a floppy disk,
writeable CD, or Zip disk. You should know which letters your computer
uses to label its drives. If you don’t, consult the documentation that
came with your computer. (Usually, a floppy drive is named drive A.)
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Figure 9-1:
The Quicken
Backup
dialog box.
|

2. Verify that the file you want to back up is active.

Display the Register tab and make sure that it displays one of the
accounts in the file you want to back up. You can do so by clicking the
register’s QuickTab, which appears under the Cash Flow Center button.
(If you don’t remember setting up multiple files, don’t worry. You proba-
bly have only one file — the usual case.)

. Start the backup operation.

Choose Filem>Backup from the menu bar. Quicken displays the Quicken
Backup dialog box, shown in Figure 9-1.

. Identify the backup floppy drive.

Select the Disk option button. Then verify that the disk letter shown in
the text box is the one you want to use for backing up. If it isn’t, click the
Browse button. When Quicken displays the Browse For Folder dialog box,
shown in Figure 9-2, select the correct disk.

Again, note that you don’t have to use a floppy disk to back up. You can
use any removable disk, including a Zip disk and a recordable CD. In real
life, [ use a Zip disk, just in case you're interested.

. Click OK.

You see a message on-screen that says, “Aye, Cap’n, 'm working just as
fast as I can” (or something to that effect). Then you see a message that
says the backup is complete. Don’t worry. You'll never see a message
that says, “She’s starting to break up, Cap’n. She can’t take warp 9 much
longer.” You will see a warning message if the file you want to back up is
too large. In this case, you need to shrink the file, use a different disk, or
use multiple disks.

Quicken Backup

1. Select the Ouicken file to backup

2. "Where do you want to save your backup file?

* On my computer

" Online

Back up your current file or specify another file below:

|ocuments and SettingshSteve MEWWIMNMIE My D ocuments\Quickentgdata2. GDF Browse

¥ Add date to file name [qdata2_20050607)
Thiz will help you identify which file is the latest backup.

Select the disk drive and path to the backup folder:
nd SettingsSteve NEWYINNIE Sy Documents\QuickenBACKLIP Browse ...

Insert your formatted backup disk in a dive now, Altenate between
two instead of always backing up to the same digk.

v Usetwindows CO \Wiiting Wizard

Protect your Quicken data from computer failure, theft and fire with I:I

Quicken Online Backup. Enjoy offsite storage, automatic backups
and eazy retrieval. Learh more,

Help | ‘ Cancel | | QK
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Browse for Folder 2%

Select Backup Directory

MMy Data Sources "
ﬁ My Music
2 My Pictures
) My Videos
+ My Webs
5) Personal
5) Press Releases
) Project2002
|
Figure 9-2: 2 QdFiles -
= Cwickan Danavke
The Browse < >
For Folder
dialog box. [ ox ][ cancel
|
P As Figure 9-1 indicates, you can also back up Quicken online. When you select

the Online option button and click OK, Quicken explains the service and

gets you started. Just so you know, an online backup gets stored on Intuit’s
computers — Intuit makes Quicken — rather than on your computer’s disks.
Online backup works the same basic way as disk backup, except you need an
Internet connection, and the online backup service costs money. The service
costs from $6.95 to $19.95 a month at the time I'm writing this book, depend-
ing on the level of service you choose. But that seems too expensive to me
for saving a couple of mouse clicks a week. Sorry, Intuit. . . .

Deciding when to back up

Sure, I can give you some tricky, technical examples of fancy backup strate-
gies, but they have no point here. You want to know the basics, right? So
here’s what I do to back up my files. I back up every month after I reconcile.
Then I stick the floppy disk in my briefcase, so if something terrible happens
at home, I don’t lose both my computer and the backup disk with the data.

[ admit that my strategy has a few problems, however. For example, because
I'm backing up only once a month, I may have to reenter as much as a month’s
worth of data if the computer crashes toward the end of the month. In my case,
[ wouldn’t lose all that much work. However, if you have really heavy transac-
tion volumes — if you write hundreds of checks a month, for example — you
may want to back up more frequently than monthly, such as once a week. If you
use the same disk or set of disks to back up your Quicken file, Quicken will
warn you before it replaces the old file with the new one. You can go ahead
and let Quicken do this, as long as you're sure that you won’t want to access
the old file anymore.
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A second problem with my strategy is only remotely possible but is still
worth mentioning. If something bad does happen to the Quicken files stored
on my computer’s hard disk and the files stored on the backup floppy disk,
I'm up the proverbial creek without a paddle. I should also note that a floppy
disk is far more likely to fail than a hard drive. If this worst-case scenario
actually occurs, I'll need to start over from scratch from the beginning of the
year. To prevent this scenario from happening, some people — those who are
religiously careful — make more than one backup copy of their Quicken files.

By the way, Quicken periodically prompts you to back up when you try to
exit. (You'll see a message that basically says, “Friend, backing up is a darn
good idea.”) You can, of course, choose to ignore this message. Or you can
take Quicken’s advice and do the backup thing as [ describe earlier in this
chapter, in “Backing up the quick-and-dirty way.”

You know what else? Here’s a secret feature of Quicken: Quicken adds a sub-
directory called Backup to the Quicken directory. And Quicken will stick a
backup copy of your files in this directory every few days. (Sorry to be vague
on this point, but it’s hard to be specific and concrete when it comes to
undocumented features.) You can find out more on this later in this chapter
in the section titled “Losing your Quicken data when you haven’t backed up.”

Losing your Quicken data
after you've backed up

What happens if you lose all your Quicken data? First of all, I encourage you
to feel smug. Get a cup of coffee. Lean back in your chair. Gloat for a couple of
minutes. You, my friend, will have no problem.

After you've sufficiently gloated, carefully do the following to reinstate your
Quicken data on the computer:

1. Get your backup disk.

Find the backup disk you created and carefully insert it into one of your
disk drives. (If you can’t find the backup disk, forget what I said about
feeling smug — stop gloating and skip to the next section.)

2. Start Quicken.

You already know how to do this, right? By the way, if the disaster that
caused you to lose your data also trashed other parts of your computer,
you may need to reinstall Quicken. Shoot. | suppose it’s possible that you
may even need to reinstall Windows.

3. Choose File~>Restore Backup File from the menu.



Chapter 9: Housekeeping for Quicken

|
Figure 9-3:
The Restore
Quicken File
dialog box.
|

\NG/
Vg,\\

Quicken probably displays a menu listing the backup copies of the
Quicken data file that you’ve previously made. If that’s the case, you
simply the select the backup copy you want to use. Alternatively, you
can also choose the Browse command from this little menu.

Quicken looks at the disk in drive A or wherever and displays a list of
the files stored on the disk, as shown in Figure 9-3. (If you have only one
Quicken file on the disk — the usual case — only one file is listed.) If your
computer has another disk in it and this other disk has the backup copy
of the file, use the Look In drop-down list box to select the other drive.

Restore Quicken File 2]
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LY DILMMIEST
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My Recent DUMMIES3
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My Network Files of type: ‘Quicken Files (“QDF." QB1;".QDE."Q0T) j Cancel
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4. Select the file you want to restore and click OK.

Use the arrow keys or the mouse to select the file that you want to
restore.

If the file you select is the one Quicken used last, the program displays
a message asking whether it’s okay to overwrite, or replace, the file with
the one stored on the disk.

When you restore a file, you replace the current, in-memory version of
the file with the backup version stored on the disk. Don’t restore a file
for fun. Don’t restore a file for entertainment. Restore a file only if the
current version is trashed, and you want to start over by using the ver-
sion stored on the backup disk.

5. Click OK.

Quicken replaces the file it’s currently using with the one from the backup
disk. After it finishes, Quicken displays a message telling you that it has
restored the file. You're almost done.
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6. Update the account registers as necessary.

Using the register windows for each of the accounts in a file, reenter each
of the transactions you recorded since you created the backup. Be sure
that you update your accounts, because you've almost certainly entered
transactions since the last time you backed up.

Just to be on the safe side, you should back up the file after you com-
plete this process. Using a new disk is probably a good idea, too. I have
heard that lightning never strikes the same place twice, but I'm not sure
that the old saying is true. If you have hard drive problems or another
recurring problem, whatever fouled up your file this time may rear its
ugly head again — and soon.

Losing your Quicken data when
you haven't backed up

What do you do if you haven’t backed up your files in a while and you lose all
the data in your Quicken files? Okay. Stay calm. All may not be lost.

First, you can try restoring the files from the Quicken backup directory. To do
so, you follow the same file restoration steps I cover in the preceding section,
with one minor exception. When you get to the Restore Quicken File dialog
box (shown in Figure 9-3), you select your C drive. Then use the Look In box
to indicate that you want to see the backup files in the BACKUP folder of the
QUICKEN folder. (This is what I actually did in Figure 9-3, by the way.)

At this point, you’ll probably see a list of files with names similar to the file
you lost. If the file you lost had the name QDATA, for example, you may see
files named QDATA1 and QDATAZ2. If you named your Quicken data file STEVE
in honor of me, you might see STEVE1, STEVEZ2, and so on. Select the newest
file, which is the one with the “1” suffix, as in QDATA1 or STEVEI; then click
OK. Quicken uses the file to restore the current file. As I alluded to earlier in
this chapter, this may just work. And if it does, you should feel very lucky.
Very lucky indeed.

Okay. So suppose that you've tried the approach described in the preceding
paragraph, and it didn’t work. What next?

You have to reenter all the transactions for the entire year. Yeah. [ know. It’s a
bummer. This method isn’t quick, and it isn’t pretty, but it works.

If you have copies of the registers, of course, you can use these as your infor-
mation source to reenter the information in your files. If you don’t have copies
of the registers, you need to use your bank statements and any other paper
financial records you have.
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P If, for some unfortunate reason, the only copy you have of your Quicken data
seems to have become corrupted, you can have Quicken rebuild the file. To
do so, choose File>File Operationsw>Validate and enter the name of the file
you want rebuilt in the File Name text box. You typically do this, however,
only when instructed by Quicken or Intuit technical support people.

Working with Files, Files, and More Files

As part of setting up Quicken, you create what Quicken calls a file: a place
where Quicken stores all your accounts (bank accounts, credit card accounts,
investment accounts, and so on).

You can have more than one Quicken file at any time. Most people won’t want
to do this. But, for example, you can use different files to keep your personal
financial records separate from business financial records.

Using multiple files does have a little drawback, however. You can’t easily
record, in one fell swoop, account transfer transactions between accounts in
different files. You need to record the transaction twice — once in the source
account, the file where the transaction originates, and again in the destination
account, the file where you are transferring the transaction.

If the two accounts involved in a transfer are in the same file, just enter the

account name in the Category text box. Quicken then records the transfer in
the other account for you.

Setting up a new file
To set up a new file so that you can create accounts in it, follow these steps:

1. Choose File>New from the menu bar.

Quicken displays the Creating New File: Dude, Are You Sure? dialog box,
shown in Figure 9-4.

Creating new file: Are you sure?

Figure 9-4: S

The Creatlng & New Ouicken File

NeW Flle £ Quicken file is a collection of accounts, categories,
Are Y mematized items, and 5o an. _
ancel
re you " Mew Ouicken Account
S u re? A Quicken account is & list of transactions for a single
. bank account, credit card or ather financial item.
dialog box.
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2. Select the New Quicken File option button and then click OK or press
Enter.

Quicken displays the Create Quicken File dialog box, shown in Figure 9-5.
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3. Enter a name for the Quicken file.

Position the cursor in the File Name text box and type some meaningful
combination of letters and numbers. You don’t need to enter a file exten-
sion because Quicken supplies the correct file extension, QDF, for you.

Note: You can use the symbol characters on your keyboard, but doing
so gets a little tricky. If you must use symbol characters in the filename,
refer to the Quicken user documentation.

4. Use the default file location.

Accept Quicken’s suggestion to store the file in the QUICKENW
directory — I can think of no good reason to put it in another file
location.

5. Click OK.

Quicken displays the Quicken Guided Setup dialog box, shown in
Figure 9-6.

6. Run the Guided Setup.

To set up the new Quicken file, run the Guided Setup and answer its
questions. If you have questions about the steps, refer to Chapter 1.
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[ Quicken Guided Setup
1. Welcome Welcome to Quicken Guided Setup
2. About You . .
Before you start using Quicken...
3. Set Your Goals Guicken Guided Setup helps you get the most from Guicken. After you select your financial goals, Guicken Guided
Setup leads you through a personalized setup process so that you set up only the parts of Quicken vou need to
4, Add Accounts mest vour goals.
Cash Flow
Quicken Guided Setup will help you:
Investments Enter some basic information about yourself,
Select your financial goals,
Property & Debt Set up the parts of Quicken you need to meet your goals.
Paycheck
Bills

5. SetpSummary [T

|
Figure 9-6:
The Quicken
Guided
Setup

dialog box.

Flip-flopping between files

You can work with only one file at a time. So, after you create a second file,
you need to know how to flip-flop between your files. If you're recording busi-
ness stuff, for example, you want to be using the business file. However, what
if a transaction comes in that clearly is meant for your personal file and you
want to enter it there immediately? Flip-flopping allows you to get from one
file to another in no time.

Flip-flopping is easy:

1. Just choose Filez>Open.
Quicken displays the Open Quicken File dialog box (see Figure 9-7).
2. Pick the file you want from the File Name text box and then click OK.
Zap! You are in the new file.
\3
P If you really want to switch to another file with lightning speed, you can

select the name of the other file directly from the bottom of the File menu,
where Quicken lists the last four files you used.
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When files get too big for their own good

You can enter a large number of transactions in a Quicken file; in fact, you can
record tens of thousands of transactions in a single account or file. Wowsers!

In spite of these huge numbers, I can think of some good reasons to work with
smaller files if you can. For example, you can fit only about 5,000 transactions
on a double-density 3%-inch disk. So working with files of a manageable size
means that you can more easily back them up on a floppy disk. Also, fewer
transactions mean that Quicken runs faster because more memory is avail-
able for Windows. (Windows likes lots of memory — the same way that some
people like lots of ice cream.)

Note: My technical editor, though, wants me to remind you that there are
good reasons to work with large files when you can. Having several years of
data at your fingertips, for example, is handy. With several years of data, you
can easily get answers to all sorts of questions: how much money wealthy rel-
atives have given you over the years, how much cable television has gone up
in price, and so on.

If your files have gotten too big for their own good, you can knock them down
to size by creating a new file that contains only the current year’s transac-
tions. You end up with a copy of the big file that you won’t use anymore and
a smaller, shrunken file with just the current year’s transactions. Working
with a smaller file probably means that Quicken will run faster. (The memory
thing comes into play again.) And smaller files should make backing up easier
because you can probably keep your files small enough to fit on a single,
double-density floppy disk.



For people who just have to be in the know. . ..

What Quicken refers to as a file is really a set of
data and index files with the same filename, such
as HOME, but different file extensions, such as
QDF, QPH, QEL, and QSD. So when Quicken refers
to the HOME file, it really is referring to the set
of files that includes HOME.QDF, HOME.QPH,

knowledge may come in handy someday. For
example, if you happen to stumble onto the
Quicken directory, knowing about the set of
HOME files keeps you from panicking when you
see all the multiple copies of the HOME file. Or,
on a more serious note, if you use a third-party
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HOME.QEL, and HOME.QSD.

In most cases, you never need to know the dis-
tinction between the files in the set, but the

backup utility, you need to know that all of these
files contain data that should be backed up.

Call me a Nervous Nellie — or a Nervous Nelson — but because shrinking a
file involves wholesale change, I'd really feel more comfortable helping you
through this process if you first back up the file you're about to shrink. I don’t
think that you need to be anxious about anything, but just in case something
does go wrong during the shrinking process, [ know that you would like to
have a backup copy of the file to fall back on.

To shrink a Quicken file, follow these steps:

1. Choose Filec>File Operations=>Year-End Copy from the menu bar.

Quicken displays a portrait of Barry Nelson, the first actor to portray
James Bond. No, not really — I just wanted to see whether you were
awake. Actually, Quicken displays the Year-End Copy dialog box, shown
in Figure 9-8.

2. Describe what you want in the current data file.

Your next step in creating a year-end copy is to describe what informa-
tion you want in the current data file, which is the Quicken file that you’ll
continue to work with. As the Year-End Copy dialog box suggests, you
have two choices: The Do-nothing choice leaves the Quicken data file
alone. The Do-something (please!) choice creates a copy of the Quicken
data file using only balances and transactions after a specified date. To
shrink the current Quicken file, you predictably use the Do-something
(please!) option by selecting the appropriate option button and then
specifying the cutoff date.
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Year-End Copy

Create a Y'ear End Copy

Quicken will create bwo data files with pour data: A current Ok
data file which you will continue to use in Quicken, and an
Archive file for pour records.

Cumrent Data File

Archive File

Cancel

‘wihat do pou want to do with your curent data file?
[Thiz will be the file you continue to use in Quicken)]
& Do nothing. My curent data file will remain unchanged.

| only want transactions in my curent data fils
starting with thiz date;

17172005

[Transactions prior to this date will not be in your
current data file.]

Quicken will copy all your data to a backup file
for your archive records.

Give thiz archive file a name and location:

‘ocuments\ﬂuicken\DudeEKP.QDH Erowse...

Thiz archive data file will contain transactions up to
and including:

12/31/2004

When you archive, you make a copy of the Quicken data file, but (typi-
cally) just through the end of the previous year. You continue to work with
the big, everything-is-still-there data file. Why archive? So that you can
have a copy of the Quicken data file as it existed at a point in time. You
might archive the Quicken data file, store the archive copy on a floppy
or CD, and store the archive file with your tax return, for example. By
doing this, you'd be sure of always being able to later look at the Quicken
data file that explained your tax deductions.

. Confirm the name in the Give This Archive File A Name text box.

You can actually ignore the filename and folder location information that
Quicken enters into the Give This Archive File A Name box. However, if
you really must have it your way, you do have the option of replacing
what Quicken suggests with another name. You can also click the Browse
button and choose another folder location by using the dialog box
Quicken displays.

. Specify a starting date.

Using the Specify Starting Date text box, type a cutoff date. Quicken
deletes all cleared transactions with dates that fall before this cutoff
date from the current Quicken file. (Remember: This file is the one you
work with and want to shrink.) I chose 12/31/2004, as the cutoff date

in Figure 9-8 so that I could create a new file for all 2005 transactions.
(Note: Quicken doesn’t delete uncleared transactions, and it doesn’t
delete investment transactions.)

. Click OK.

Quicken creates an old-transactions “archive file” with the filename
discussed in Step 3. If you told it to, Quicken also deletes all the old
transactions from the current file so that your current file contains only
the transactions that are dated after the cutoff date.
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Figure 9-9:
The File
Archived
Successfully
dialog box.
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Quicken then displays the dialog box shown in Figure 9-9, which tells you
the file was successfully copied. Select the Current File option button if
you want to use the current file you've just shrunk. Select the Archive
File option button if you want to use the old-transactions file. Click OK
after you make your choice.

If you want to see the old-transactions, or archive, file again, you can
select it from the dialog box of the File>Open command. You should not
enter any new transactions in the old-transactions file, however, because
these new transactions will change the old file’s ending account balance
without changing the current file’s beginning account balance.

File Archived Successfully
File to Use
* Current file
£ hrchive fil

Using and Abusing Passwords

WNG/
S

[ have mixed feelings about Quicken passwords. Theoretically, they let you
lock up your Quicken data so that your rebellious teenagers (if you're using
Quicken at home) or the night janitors (if you're using Quicken in a business)
can’t come in and print checks, process automatic payments, and just gener-
ally mess things up.

Using passwords sounds pretty good, of course. But before you set up a pass-
word and then start relying on it to protect your information, let me remind
you that a Quicken password only prevents someone from accessing your
data with Quicken. Using a password doesn’t prevent someone from fooling
around with your computer itself. If the night janitors — or, heaven forbid,
your teenagers — are the nefarious types, they can erase your files with
Windows or scramble them with another program, such as a spreadsheet or
word-processing program. And they may even be able get in and manipulate
the data with another checkbook or accounting program.

Passwords come with one other little annoying problem, too. Darn it, you
have to remember them.

For these reasons, I think that passwords are best left to computer systems
that use them on a global basis to control access to all programs and to com-
puter systems that can track all users (you, your teenagers, the night janitors,
and anyone else) by name. Your PC doesn’t fall into this category.
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Figure 9-10:
The Quicken
File
Password
dialog box.
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Setting up a file password
You still want a password? Okay. With much trepidation, I give you the follow-
ing steps for setting up a password for a Quicken file:

1. Select the file you want to protect with a password.

If the file you want to password-protect is not the active file, choose
File>Open from the menu and then either double-click the file you want
or select it and click OK.

2. Choose File=>Passwords from the menu bar.

Quicken displays the — you guessed it — Passwords submenu, which
lists two commands: File and Transaction.

3. Choose the File command.

Quicken displays the Quicken File Password dialog box, shown in
Figure 9-10.

Quicken File Password

Enter the password pou would ke to uge:

Mew Password:
EEEEET] -
m Canfirm Password:
i

Secure passwords are typically longer than zix characters,
should include & combination of letters and numbers, and
should not contain obvious words such as pour name.

Mote: Passwords are case sensitive.

Help Cancel ‘ ak.

4. Enter the password into the New Password text box.

You can use up to 16 characters. Quicken differentiates between lower-
case and uppercase characters, by the way, so Washington, wASHINGTON,
and WASHINGTON are all different from its point of view. Quicken doesn’t
display the actual characters you type; it displays asterisks instead. If you
type Dog, for example, it displays ***. (Passwords require strict secrecy,
you see.)

5. Enter the password you want to use again — only this time into the
Confirm Password text box — and click OK.

Congratulations! You're done.
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So what are transaction passwords?

After you choose FilecoPasswords from the menu
bar, you can create a file password or a trans-
action password by choosing File or Transaction
from the Passwords submenu. In general, you
use a file passwordto protect the access into a
Quicken file.

A transaction password works like a file pass-
word except that the user has to enter the
transaction password if he or she tries to enter
a transaction that is dated before a specified
date. You specify the date, called the cutoff date,
when you set up the transaction password.

You would use transaction passwords, my guess
is, when you want to “lock” the previous year's

records. In other words, if you don’t want people
to intentionally or accidentally change last year's
transactions — because that would mean they're
screwing around with things like your records
of tax deductions you've claimed on a return —
you use a transaction password.

Transaction passwords are okay, | guess. But I'm
going to go out on a limb here and suggest some-
thing different: You can create and safely store
backup copies of the Quicken file for last year or
last month. Or you can keep the idiots from fool-
ing around with your Quicken files. Jeepers, if
somebody can’t understand an instruction such
as, “Use the current date,” do you really want
them mucking about in your books?

Assigning a password to a file doesn’t prevent you from doing anything with

the file that you would normally do. However, the next time you try to use

this file — after you start Quicken or when you try to select the file by using
the File=>Open command — Quicken will ask you for the file’s password. You

need to supply the password to gain access to the file.

Changing a file password

After you set up a file password, you're not stuck with it forever. You can
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either change the password or remove it by choosing Filee>Passwords=File.

If you've already set up a password, however, Quicken doesn’t display the
Quicken File Password dialog box shown in Figure 9-10. Instead, Quicken dis-
plays a mutated Quicken File Password dialog box that asks for the password
you’re now using and the new password you want to use in the future (as
shown in Figure 9-11). Type the current password in the Old Password text
box and the new password in the New Password and Confirm Password text
boxes. Then press Enter or click OK. From now on, you need to use the new
password to gain access to the file. If you don’t want to use a password any-
more, just leave the New Password and Confirm Password text boxes blank.
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Figure 9-11:
The Quicken
File
Password
dialog box.
|

Quicken File Password

0ld Passward: ||
New Password: I
Corfirrn Pagsword: I

Secure passwords are bpically longer than six characters,
should include & combination of letters and number, and
should not contain obvious words such as your name.,

Mate: Ta remove old password, leave new and Confirm
fields blank. Also note that passwords are case senstive

Help Cancel | ak. I




Chapter 10

Compound Interest Magic
and Other Mysteries

In This Chapter

Using the Investment Savings Calculator
Using the Loan Calculator

Using the Refinance Calculator

Using the Retirement Calculator

Using the College Calculator

Estimating your income taxes

Doing other financial planning stuff

Fe folks at Intuit provide several nifty little calculators (most are dialog
boxes) with Quicken. I strongly encourage you to use these tools. At the
very least, the calculators should make your work easier. And if you invest a
little time, you should gain some enormously valuable perspectives on your
financial affairs.

What’s more, the most recent versions of Quicken Deluxe and Quicken Premier
include a handful of more powerful financial planning wizards that [ want you
to know about. I won’t walk you through the steps to using these wizards. But
[ do want to preview them in the same way that a restaurant critic tells you
what you should and shouldn’t order at some nice restaurant. You know what
[ mean. “Darling, you absolutely must try the foie gras, but do stay away from
the chocolate mousse. It’s abominable. . . .”

Noodling Around with Your Investments

My favorite Quicken calculator is the Investment Savings Calculator. I guess |
just like to forecast portfolio future values and other similar stuff.
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A timing assumption you should know
The Investment Savings Calculator assumes period — what financial planners call an ordi-
that you’ll add to your portfolio at the end of the  nary annuity.
ing the I ‘ lcul.
Using the Investment Savings Calculator
Suppose that you want to know how much you’ll accumulate if you save
$2,000 a year for 35 years in a stock mutual fund that you anticipate will earn
10 percent annually. Use the Investment Savings Calculator to estimate how
much you should ultimately accumulate. To use it, follow these steps:
1. Choose Planning=Financial Calculators=>Savings Calculator.
Quicken displays the Investment Savings Calculator dialog box (see
Figure 10-1).
Investment Savings Calculator
Savings |nformation
Opening savings balance: 0.00
Annual yield: 10.000%
Numberof — |Years j |35 4, Sy
Contibution each ~ “ear 2.000.00
Ending savings balance: 137.363.54
I Inflation Calculate For
Figllre 10-1: Predicted inflation: 4.000% ~ Opening savings balance
The I Inflate contibutions " Regular contribution
|nVeStment ¥ Ending balance in today's § % Ending savings balance
SaVingS Lalculate | | Schedule...
Calculator
dialog box.
|

2. Enter what you’ve already accumulated as your Opening Savings
Balance.

Move the cursor to the Opening Savings Balance text box and then type
the amount of your current investments. If this amount is zero, for exam-
ple, type 0.
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3. Enter the Annual Yield that you expect your investments to earn.

Move the cursor to the Annual Yield text box and type the percent. If
you plan to invest in the stock market and expect your savings to match
the market’s usual return of about 10 percent, for example, type 10
(don’t type .10).

4. Indicate how long you plan to let your investments earn income.

Move the cursor to the Number Of drop-down list box and select the time
period appropriate to your investment planning. (Usually, you’ll select
Years, as Figure 10-1 shows.) Then move the cursor to the Number Of
text box and indicate how long (enter the number of time periods) you
want to maintain these investments. For example, if you select Years in
the drop-down list box and you plan to let your investments grow for

35 years, you type 35.

5. Enter the amount you plan to add to your investments every period.

Move the cursor to the Contribution Each text box and type the amount
you plan to add. (Figure 10-1 shows how to calculate an IRA’s future value
assuming a $2,000 annual contribution.)

6. Enter the anticipated inflation rate.

Move the cursor to the Predicted Inflation text box and type the inflation
rate. By the way, over the twentieth century, the inflation rate averaged
just over 3 percent.

7. Indicate whether you plan to increase your annual contribution as a
result of inflation.

Select the Inflate Contributions check box if you plan to annually
increase — by the annual inflation rate — the amount you add to your
investment portfolio. Don’t select the check box if you don’t want to
inflate the payments.

8 After you enter all the information, click Calculate.

The Ending Savings Balance field shows how much you’ll accumulate in
present-day, uninflated dollars: $137,363.54. Hmmm. Nice.

If you want to know the amount you’ll accumulate in future-day, inflated dol-
lars, deselect the Ending Balance in Today’s $ check box.

To get more information on the annual deposits, balances, and so on, click
the Schedule button, which appears at the bottom of the Investment Savings
Calculator dialog box. Quicken whips up a quick little report showing the
annual deposits and ending balance for each year you plan to add into the
savings. Try it. You may like it.
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Trying to become a millionaire

So you want to be a millionaire some day.

To find out how to realize this childhood dream, use the Calculate For option
buttons, which appear on the Investment Savings Calculator dialog box (refer
to Figure 10-1). With these option buttons, you click the financial variable
(Opening Savings Balance, Regular Contribution, or Ending Savings Balance)
you want to calculate. For example, to determine the annual amount you need
to contribute to your investment so that your portfolio reaches $1,000,000,
here’s what you do:

1. Select the Regular Contribution option button.

2. Select the Inflate Contributions check box.

3. Deselect the Ending Balance In Today’s $ check box.
4. Enter all the other input variables.

Remember to set the Ending Savings Balance text box to 1000000 (the
Ending Savings Balance field becomes a text box after you select the
Regular Contribution option).

The Investment Savings Calculator computes how much you need to
save annually to hit your $1,000,000 target.

Starting from scratch, it’ll take 35 years of roughly $2,500-a-year payments to
reach $1,000,000.00, as shown in Figure 10-2. (All those zeros look rather nice,
don’t they?) Note that this calculation assumes a 10 percent annual yield.

1 Savings Calcul
Savings Information _m
Opening savings balance: ’0007
Annual yield: W
Numberof — [Years | ~| [=5 R @™
Contribution each ~ “rear 248382
Ending savings balance: W
Figul’e 10-2: Inflation Calculate For
Th e secret Fredicted inflation: ’W " Opening savings balance
to your W Inflate contributions * Regular contibution
success: " Ending balance in today's § " Ending savings balance
$2'500 a Lalculste | | Schedule
year for 35
years.
|
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“Jeepers, creepers,” you say. “This seems too darn good to be true, Steve.”

Well, unfortunately, the calculation is a little misleading. With 4 percent infla-
tion, your million bucks will be worth only $253,415.55 in current-day dollars.
(To confirm this present value calculation, select the Ending Savings Balance
option button and then the Ending Balance In Today’s $ check box.)

One of my pet ideas is that it really is possible for most people to become
millionaires. There are just three tricks to doing so. First, make sure that you
use tax-advantaged investments like 401(k) plans and IRAs. Second, invest this
money into an index stock mutual fund like the Vanguard Total Stock Market
Portfolio to make sure that, over time, your returns average out to the average.
Third, use Quicken and your computer to make smarter financial decisions —
by doing this, you can rather easily free up an extra $50, $100, or even $200 a
month. [ talk about this subject in Chapter 18.

The Often Unbearable Burden of Debt

To help you better manage your debts, Quicken provides a neat Loan
Calculator that computes loan payments and balances.

Using the Loan Calculator
to figure payments

Suppose that one afternoon, you’re wondering what the mortgage payment is
on one of those monstrous houses: tens of thousands of square feet, acres of
grounds, cottages for the domestic help, and so on. You get the picture —
something that’s a really vulgar display of wealth.

To calculate what you would pay on a 30-year, $5,000,000 mortgage if the
money costs 6 percent, use the Loan Calculator:
1. Choose Planning=>Financial Calculators=>Loan Calculator.

Quicken displays the Loan Calculator dialog box. (See Figure 10-3 for a
picture of this handy tool.)

2. Enter the loan amount.

Move the cursor to the Loan Amount text box and type the amount of
the loan. (If you're checking the lifestyle of the ostentatious and vulgar,
type 5,000,000.)
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|
Figure 10-3:
The Loan
Calculator.
|

Loan Calculator
Loan Infarmation
—
Laan amount: 5.000.000.00
Annual interest rate: 5 0005
Mumber of years: 30

Periads per year: 12
Compounding period Honthly =2

Payment per period: 29,977,653

Calculate For

" Loan amount + Payment per period

| Lalculate | ‘ Schedule...

3. Enter the annual interest rate.

Move the cursor to the Annual Interest Rate text box and type the
interest rate percent. If a loan charges 6 percent interest, for example,
type 6.

4. Enter the number of years you want to take to repay the loan.

Move the cursor to the Number Of Years text box and type the number
of years you plan to make payments.

5. Indicate how many loan payments you plan to make a year.

Move the cursor to the Periods Per Year text box and type the number of
loan payments you plan to make in a year. If you want to make monthly
payments, for example, type 12.

6. Indicate how frequently the lender will calculate, or compound,
interest.

Move the cursor to the Compounding Period box and select the interest

compounding period. If a loan uses monthly compounding, for example,

select monthly. (By the way, just so you know, most loans use compound-
ing periods equal to the payment period. Some don’t. But most do.)

If you click Calculate or move the selection cursor, Quicken calculates the
loan payment and displays the amount in the Payment Per Period field. Hey,
wait. $29,977.53. That doesn’t seem so bad, does it? I mean, you could almost
make an annual — oh, never mind. That’s a monthly payment, isn’t it? Yikes!

I guess if you have to ask how much the mortgage payment is, you really
can’t afford it.
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Calculator
dialog box.
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To get more information on the loan payments, interest and principal por-
tions of payments, and outstanding loan balances, click the Schedule button,
which appears on the face of the Loan Calculator dialog box. Quicken whips
up a quick loan amortization schedule showing all this stuff.

Calculating loan balances

To calculate the loan principal amount, select the Loan Amount option button
under Calculate For in the Loan Calculator dialog box. Then enter all the other
variables.

For example, those $29,977.53-a-month payments for the monster mansion
seem a little ridiculous. So calculate how much you can borrow if you
make $1,500-a-month payments over 30 years and the annual interest rate
is 6 percent:

1. Select the Loan Amount option button.

2. Type 6 in the Annual Interest Rate text box.

3. Type 30 in the Number of Years text box.

4. Type 12 in the Periods Per Year text box.

5. Type 1500 in the Payment Per Period text box.

After you click the Calculator button or move the selection cursor, the Loan
Calculator computes a loan amount of $250,187.42, as shown in Figure 10-4.

Loan Calculator

Laan Infarmation

Loan amaunt: 250,187.42

Annual interest rate: E.000%

Mumber of years: 30
Petiods per year: 12

Compounding period: Monthly -
Payment per period: 1.500.00

" Payment per period

| LCalculate | ‘ Schedule. ..
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You won’t read about the Refinance Calculator here — but not because I'm
lazy. Believe it or not, I enjoy writing about things that help you make better
financial decisions. The Refinance Calculator merely calculates the difference
in mortgage payments if you make lower payments; then it tells you how long
it would take with these lower payments to pay back the refinancing costs
you incur.

For example, if you save $50 a month because you refinance and it costs $500
to refinance, the Refinance Calculator tells you that it would take ten months
of $50-a-month savings to recoup your $500.

You know what? Although you may want to know how long it would take to
recoup the refinance costs, that information doesn’t tell you whether refinanc-
ing is a good idea. Deciding whether to refinance is very, very complicated.
You can’t just look at your next few payments, like the Refinance Calculator
does. You also need to look at the total interest you would pay with the old
mortgage and the new mortgage.

I can’t think of any good reason to use the Refinance Calculator; it just doesn’t
do what it purports to do.

So that I don’t leave you hanging, however, let me give you two general rules
to help you make smarter refinancing decisions:

v First, if you want to save interest costs, don’t use refinancing as a way to
stretch out your borrowing. That is, if you refinance, make sure that you
make payments large enough to pay off the new mortgage by the same
time you would have paid off the old mortgage. In other words, if you have
23 years left on your old mortgage, don’t go out and get a 30-year mort-
gage. Find a lender who will let you pay off the new mortgage in 23 years.

v Here’s a second trick, if you can find a willing lender. Ask the lender to cal-
culate the annual percentage rate (APR) on the new mortgage, assuming
that you’ll pay off the mortgage by the same time you would have paid off
the old mortgage. (An APR includes all the loan’s costs — interest, points,
miscellaneous fees, and so on — and calculates an implicit interest rate.)
If the APR on the new loan is lower than the current loan’s interest rate,
refinancing would probably save you money.

Let me issue one caveat. When you base your refinancing decision on the
comparison between the new loan’s APR and the current loan’s interest rate,
you assume that you'll live in your current house until the mortgage is paid.

[ hope this information helps. As I said, mortgage-refinancing decisions are
tough if you truly want to save money.
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The Retirement Calculator

[ think that this section is the most important one in this book. No joke. Your
financial future is much too consequential to go for easy laughs or cheap shots.

The dilemma in a nutshell

By the time the 30-something and 40-something crowd reaches retirement,
Social Security coverage almost certainly will be scaled back.

But the problem isn’t just Social Security. More and more often, employer-
provided pension plans are defined contribution plans, which add specific
amounts to your pension (such as 2 percent of your salary), rather than
defined benefit plans, which promise specific pension amounts (such as
$1,000 a month). As a result, although you know that someone will throw
a few grand into your account every so often, you don’t know how much

you’ll have when you retire.

So what does all this mean? In a nutshell, you need to think about your retire-

ment now. Fortunately, the Quicken Retirement Calculator can help you.

The truth about Social Security

Every so often, the Social Security Administration
sends you a Personal Earnings and Benefits
Summary, sometimes known by the acronym
PEBS. You want to pay close attention to hoth
the statement and the accompanying letter. The
statement shows you how much you can expect
to receive in the way of retirement savings based
on your past earnings, assuming you continue
to earn similar amounts in the future. The state-
ment also typically tells you that if Congress
does nothing, there will only be money to cover
“X" percent of your benefits at some point a few
decades in the future. For example, the state-
ment may say something along the lines of “Blah,
blah, blah, and if Congress does nothing to fix the
funding challenges faced by the nation’s aging
workers, in 2039 the trust fund will be depleted,
and Social Security tax receipts will be only

enough to pay 70 percent of the retirees and
other recipients’ benefits. . . .” Okay, that's a
bummer. | know.

But think about the worst case scenario. If
Congress really does do nothing, the Social
Security Administration now tells you, implicitly
through the PEBS statement, by what amount
your benefits will be cut. The last PEBS that | saw,
for example, suggested that the trust fund runs
out of money in roughly 35 years, and, at that
point, benefits will have to be cut back to 70 per-
cent of their current level. For example, someone
who would have gotten $800 a month will get
only $560. Okay, that's not good. But as long as
you're not depending solely on Social Security,
itisn’t quite a financial meltdown either. You can
easily save just a bit more money yourself and
more than make up the difference.
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Figure 10-5:
The
Retirement
Calculator
dialog box.
|

Retirement planning calculations

Imagine that you decide to jump into your employer’s 401(k) thing (a type
of profit-sharing plan) and that it allows you to plop $6,000 into a retirement
account that you think will earn about 9 percent annually.

Fortunately, you don’t need to be a rocket scientist to figure this stuff out.
You can just use the Retirement Calculator:

1. Choose Planning=>Financial Calculators=>Retirement Calculator.

Quicken displays the Retirement Calculator dialog box, shown in
Figure 10-5.

Retirement Calculator
Retirement Information
Current savings: 0.00 .
A yeld 500 e o
: %
NN e Predicted inflation; 4,000
Annual contribution: E,000.00 ol s e
Current age: 40 i k
Yy
Retirement age: =] e\ 8
- . Calculate For e
“withdraw until age: 95 . ]
 Curent savings 5
Other incame (551, ete ] 15.000.00 B Al s
Annual income after taes: 28.838.76 @ Annual retirement incame: Caloulate
Tax Information Schedule...
% Tay sheltered investment Cuirent tax rate:
" Mon-sheltered investment Retirement tax rate: 15.000%
To develop a complete retirement plan, use the Retirement Planner in the Planning Center.

2. Enter what you’ve already saved as your current savings.

Move the cursor to the Current Savings text box and type your current
retirement savings (for example, if you have some Individual Retirement
Account money or you’'ve accumulated a balance in an employer-
sponsored 401(k) account). Don’t worry if you don’t have anything
saved — most people don't.

3. Enter the annual yield that you expect your retirement savings to earn.

Move the cursor to the Annual Yield text box and type the percent. In the

little example shown in Figure 10-5, I say the annual yield is 9 percent.
This is, I'll remind you, about the average return that the stock market
produces over long periods of time. And yes, [ do know that over the
1990s the market almost tripled this percentage. But I urge you not to
expect that party to restart during either of our lives.
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. Enter the annual amount added to your retirement savings.

Move the cursor to the Annual Contribution text box and type the
amount that you or your employer will add to your retirement savings
at the end of each year. In the example, [ say that [ plan to add $6,000
(refer to Figure 10-5).

. Enter your current age.

Move the cursor to the Current Age text box and type a number. You're
on your own here, but let me suggest that this is a time to be honest.

. Enter your retirement age.

Move the cursor to the Retirement Age text box and type a number. Again,
this is purely a personal matter. (Figure 10-5 shows this age as 65, but
you should retire when you want.)

. Enter the age to which you want to continue withdrawals.

Move the cursor to the Withdraw Until Age field and type a number. I
don’t want to beat around the bush here. This number is how old you
think you’ll be when you die. [ don’t like the idea any better than you do.
Let me say, though, that ideally you want to run out of steam — there,
that’s a safe metaphor — before you run out of money. So go ahead and
make this age something pretty old — like 95.

. Enter any other income you’ll receive — such as Social Security.

Move the cursor to the Other Income (SSI, Etc.) text box and type a value.
(Figure 10-5 shows $15,000.) Note that this income is in current-day, or
uninflated, dollars. By the way, you can request an estimate of your
future Social Security benefits (this is the PEBS statement I talk about

in the “The truth about Social Security” sidebar earlier in this chapter)
by visiting the Social Security Administration’s Web site at www.ssa.gov
or by contacting your local Social Security Administration office. Also,
note that if you haven’t received a benefits estimate already, the Social
Security Administration is actually supposed to be sending every worker
an estimate of his or her future benefits.

. Indicate whether you plan to save retirement money in a tax-sheltered

investment.

Select the Tax Sheltered Investment option button if your retirement sav-
ings earns untaxed money. Select the Non-Sheltered Investment option
button if the money is taxed. Tax-sheltered investments are such things

as Individual Retirement Accounts, annuities, and employer-sponsored
401(k)s and 403(b)s. (A 403(b) is kind of a profit-sharing plan for a non-
profit agency.)

As a practical matter, tax-sheltered investments are the only way to ride.
By deferring income taxes on your earnings, you earn interest on the
money you otherwise would have paid as income tax.
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Enter your current marginal tax rate, if needed.

If you're investing in taxable stuff, move the cursor to the Current Tax
Rate text box. Then type the combined federal and state income tax rate
that you pay on your last dollars of income.

Enter your anticipated retirement tax rate.

Move the cursor to the Retirement Tax Rate text box, then . . . hey, wait a
minute. Who knows what the rates will be next year, let alone when you
retire? I think that you should type 0, but remember that the Annual
Income After Taxes is really your pretax income (just as your current
salary is really your pretax income).

Enter the anticipated inflation rate.

Move the cursor to the Predicted Inflation text box and type the inflation
rate. By the way, in recent history, the inflation rate has averaged just
above 3 percent (refer to Figure 10-5).

Indicate whether the annual additions will increase.

Select the Inflate Contributions check box if the additions will increase
annually by the inflation rate. (Because your salary and 401(k) contribu-
tions will presumably inflate if there’s inflation, Figure 10-5 shows the
Inflate Contributions check box selected.)

After you enter all the information, click Calculate and take a peek at
the Annual Income After Taxes field.

Figure 10-5, for example, shows $28,838.76. Not bad really. If you want to
see the after-tax income in future-day, inflated dollars, deselect the Annual
Income In Today’s $ check box but leave the Inflate Contributions check
box checked.

To get more information on the annual deposits, balances, income, and so
on, click the Schedule button, which appears on the face of the Retirement
Calculator dialog box. Quicken whips up a quick little report showing the
annual deposits, income, and ending retirement account balances for each
year you plan to add to and withdraw from your retirement savings.

If you're now bummed out about retirement

First, don’t feel depressed. At least you know now if your golden years seem
a little tarnished. After all, you acquired Quicken to help you sort out your
finances. Now you can use Quicken and your newly gained knowledge to help
improve your financial lot.
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Basically, retirement planning depends on just three things:

v The number of years that the retirement savings will accrue interest

v The real yield (that is, adjusted for inflation) you earn — in other words,
the annual yield minus the predicted inflation

v The yearly payments

Anything you do to increase one of these variables increases your retirement
income.

If you invest, for example, in something that delivers higher real yields, such
as the stock market, you should see a big difference. (Of course, you usually
bear more risk.) Or if you wait an extra year or two to retire, you wind up
making more annual payments and earning more interest. Finally, if you boost
the yearly payments (for example, by participating in an employer-sponsored
401(k) or 403(b) plan, where your employer matches a portion of your contri-
bution), you'll see a huge change.

Noodle around with the variables. See what happens. You may be surprised.

Retirement roulette

Use the Calculate For option buttons in the Retirement Calculator (refer to
Figure 10-5) to determine a retirement income variable. You can calculate
current savings, annual contribution, or, as I describe earlier in “Retirement
planning calculations,” the annual after-tax income.

To calculate the yearly payment required to produce a specific level of retire-
ment income, for example, select the Annual Contribution option button. Then
enter all the other variables — including the desired after-tax income and click
Calculate. The Retirement Calculator figures how much you need to save to
hit your target retirement income.

The Retirement Calculator assumes that you or  adds to your retirement savings at the beginning
your employer will add to your retirement savings  of the year, you earn an extra year of interest.
atthe end of the year— what financial planners ~ As a result, your after-tax income will be more
call an ordinary annuity. If you or your employer  than Quicken shows.

More about timing
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Cost of College

Ouch. I have a couple of daughters, so [ know how you feel. Man, oh, man, do
[ know how you feel.

The College Calculator

Suppose that you have a child who may attend college in 16 years, and you
haven’t started to save yet. If the local university costs $10,000 a year and
you can earn 9 percent annually, how much should you save?

The College Calculator works like the Retirement Calculator:

1. Choose Planning=>Financial Calculators=>College Calculator.

Quicken displays the College Calculator dialog box, shown in Figure 10-6.

|
Figure 10-6: College Calculator
Use the College Infarmation
C ” Annual college costs: 10.000.00
Y eg e “Years until enrallment: 13

Ca|CU|at0r Mumber of years eniolled: 5
dia Iog box Cunent callege savings 0.00

to determine Annual yield 3.000%
bt | it : 21027
whether nnual contribution: L2
you ” have Inflation Calculate For
to take out a Predicted jnflation 4.000% € Annual college costs
SeCOnd "] " Current college savings
{* Annual contribution
mo rtg age
to pay for Calculate | ‘ Schedule... |
J un | 0 r,s #all calculstions assume saving until the student graduates.
college
education.
I

2. Enter the annual college costs.

Move the cursor to the Annual College Costs text box. Then type the
current annual costs at a school Junior may attend. Figure 10-6 shows
this amount as $10,000.

3. Enter the number of years until enrollment.

Move the cursor to the Years Until Enrollment text box and type a
number. For example, if Junior will start college in 13 years, type 13.
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4. Enter the number of years enrolled.

Move the cursor to the Number Of Years Enrolled text box and type a
number. Assuming that Junior doesn’t fool around, type 4 or 5.

5. Enter the amount of the current college savings.

Move the cursor to the Current College Savings field and type an amount.
Figure 10-6 shows this amount as $0.00.

6. Enter the annual yield that you expect the college savings to earn.

Move the cursor to the Annual Yield text box and type the percent.
Figure 10-6 shows the yield as 9 percent.

7. Enter the inflation rate anticipated in college tuition.

Move the cursor to the Predicted Inflation text box and type the inflation
rate percent. Figure 10-6 shows this rate as 4 percent.

8. Indicate whether you plan to increase your annual contribution as a
result of inflation.

Select the Inflate Contributions check box if you plan to annually
increase — by the annual inflation rate — the amount you save.
Figure 10-6 shows this check box selected.

After you enter all the information, click Calculate or move the selection
cursor. The Annual Contribution field shows how much you need to save
each year until the child graduates from college.

Just to beat this thing to death, Figure 10-6 shows that the lucky student will
attend five years at a college that currently costs $10,000 a year and that you
expect to earn 9 percent annually and anticipate 4 percent annual inflation.
Given these cold hard facts, you need to start saving $2,171.27 every year.

To get more information on the annual deposits, tuition, and balance, click the
Schedule button, which appears on the face of the College Calculator dialog
box. Quicken whips up a quick little report showing the annual deposits,
tuition, and ending college savings account balances for each year you add
to, and Junior withdraws from, the college savings money.

If you’re now bummed out
about college costs

Look at the positive side: You now understand the size of the problem and
the solution.
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College planning depends on four things:

v College costs
v The number of years that the savings earn interest

v The real yield (that is, adjusted for inflation) you earn — in other words,
the annual yield minus the predicted inflation

v The yearly payments
[ don’t mean to sound like a simpleton, but you can successfully save for a
college education in three basic ways:

1 Reduce the costs (find a less expensive school)

v Invest in things that deliver higher yields

v Boost the yearly payments
Use the Calculate For option buttons (refer to Figure 10-6) to compute a spe-

cific financial variable. Select the variable you want to calculate and then
input the other values. The College Calculator computes the flagged variable.

Finding a less expensive school isn’t necessarily the same thing as looking for
the cheapest tuition fees. Another huge factor these days is whether a pro-
gram takes four years or five years to complete. A cheap-tuition school that
requires five years may be more expensive than, say, a good private school
that gets a student out — and working — in four years.

Planning for Taxes

Quicken also comes with a very powerful, very useful Tax Planner. The Tax
Planner helps you make a precise estimate of the taxes that you’ll owe. To
use the Tax Planner, take the following steps:

1. Choose Tax~>Tax Planner.

Quicken displays the Tax Planner window. To move past the introductory
information, click Let’s Get Started and then click Next. Quicken shows
the second page (see Figure 10-7).

Note: Quicken may display a dialog box that asks whether you want to
learn how TurboTax can help with year-round tax planning. Click No if
you see this message. You've got my help.
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Tax Planner
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2. Verify the tax year and filing status.

In the upper-left corner of the Tax Planner window, notice that the tax
year (labeled Year) and the filing status (labeled Status) appear. These
are probably correct. Quicken can guess the year by looking at your
computer’s clock. It determines your filing status based on information
that you supply when you set up Quicken. But if one of these bits of infor-
mation is wrong, click the Year or Status hyperlink. The hyperlinks are
those bits of text along the left edge of the Tax Planner window. Quicken
displays the Tax Planner Options text boxes, which let you specify the
Tax Year and the Filing Status and choose a Scenario.

Note: A Scenario is just a set of income tax inputs. You may have only
one Scenario. Or you may have several Scenarios based on different
guesses about your income and deductions.

. Enter the wages and salaries that you and your lovely or handsome

spouse expect.

Click the Wages hyperlink. Then, when Quicken displays the Wages text
boxes, type your wages and, if you’re married, those of your spouse.
Quicken totals your wages and then makes a first rough calculation of
the amount you’ll owe in taxes. Of course, Quicken needs to collect
some more data before this number is accurate, so don’t freak out yet.
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You can move to the next set of input text boxes by clicking the Next
hyperlink and to the previous window of input text boxes by clicking
the Previous hyperlink. The Next and Previous hyperlinks appear at the
bottom of the page, so you can’t see them in Figure 10-7. But you’ll be
able to scroll down and see them on your computer. I guarantee it.

. Enter the other income you’ll have from interest, dividends, capital

gains, and so on.

To record the other income that you'll need to pay taxes on, click the
Interest/Dividend Inc, Business Income, Capital Gains, and Other Income
hyperlinks and provide the information that Quicken requests. Some of
these numbers are pretty easy to guess. Some of them aren’t. You can
also look at last year’s tax return or at the year-to-date information you've
already collected by using Quicken.

. Identify any adjustments to your gross income.

Click the Adjustments hyperlink and then, using the Adjustments to
Income text boxes, identify or estimate any adjustments to gross income
that you’ll have. Most people make only one adjustment — contributions
to a deductible IRA. Self-employed individuals, however, also typically
have several other adjustments, including half of their self-employment
tax (which Quicken automatically calculates and enters), a portion of
any health insurance paid, and Keogh and SEP pension contributions.

. Estimate your itemized deductions.

Click the Deductions hyperlink and then use the Standard and Itemized
Deductions text boxes to estimate your deductions for expenses, such
as state and local taxes, mortgage interest, and charitable contributions.
Alternatively, if you’ll probably or possibly use the standard deduction,
carefully check any of the boxes that Quicken uses to determine which
standard deduction you should use.

. Tell Quicken how many personal exemptions you’ll claim.

Click the Exemptions hyperlink and then specify the number of depen-
dents you’ll claim on your return. The basic rule is that you get one
exemption for every person in your family (you, your spouse if you're
filing jointly, and your kids) as long as they live in your house. [ should
mention, however, that things become tricky if you have shirt-tail rela-
tives (your Aunt Enid, for example) living at your house, if your kids live
away from home or are married, or if some of the kids in the house have
divorced parents. If you have questions because one of these situations
sounds vaguely familiar, get the IRS preparation instructions and read
the part about who is and is not a dependent.

. Indicate whether you owe any other taxes or have tax credits you can

use to reduce your taxes.
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Click the Other Taxes, Credits hyperlink and then use the Other Taxes &
Credits text boxes to describe any of the federal taxes you’ll pay in addi-
tion to the usual federal income tax. The other taxes, by the way, typically
include just two taxes: self-employment tax (which is the tax that self-
employed people pay in place of Social Security and Medicare tax) and,
in special cases, the alternative minimum tax. A bunch of different tax
credits exist. You can very possibly look at your prior years’ returns to
see if they apply (typically) in your situation.

. Enter any estimated taxes you’ve paid or any federal income taxes

your employer has withheld from your paycheck.

Click the Withholding hyperlink and use the Withholdings text boxes to
record how much money you've paid through withholding. Then click
the Tax Payments hyperlink and use the Estimated Tax Payments text
boxes to record how much you’ve paid in estimated tax payments and
to guess how much you’ll pay in the coming months.

Return to the Tax Planner Summary and review the Quicken pro-
gram’s calculations.

After you complete the preceding steps, click the Tax Planner Summary
hyperlink and review the calculations that Quicken makes. Quicken esti-
mates the total tax you’ll pay (which is useful and interesting in itself),
the estimated refund or payment you’ll have to make, and one other
particularly useful bit of information — your marginal income tax rate
(which Quicken labels Marginal Rate). If you want to print a copy of the
Tax Planner’s information and calculations, click Print (in the upper-
right corner of the window).

Knowing your marginal income tax rate enables you to make more precise
investment calculations. For example, the Retirement Calculator — described
earlier in the chapter in the section cleverly titled, “The Retirement
Calculator” — uses your marginal income tax rate to make more precise
calculations. You can also use the marginal income tax rate to calculate

the after-tax return that taxable investments deliver. Simply multiply the
taxable return by the factor (1 + marginal tax rate).

The Other Planning Tools

In the preceding pages of this chapter, [ talk about the personal financial plan-
ning tools that are most useful. Before [ wrap up my discussion, let me quickly
mention that Quicken provides some other interesting and, for some people,
useful financial planning tools.
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If you open the Planning menu, you’ll notice commands named Retirement
Planner, College Planner, Home Purchase Planner, Debt Reduction Planner,
and Special Purchase Planner. These wizards walk you through the steps to
planning for big important events. Like retirement. Or college. In my opinion,
these are all special-interest tools. Most people won’t be interested in taking
the time to use the wizards. (The Retirement Planner, for example, takes about
30 minutes.) But if you're really serious or worried or compulsive about one
of these topics, well, it just may be worth your time to explore a bit.

And now let me sneak in one other snidbit. If you choose Planning=
Professional Planning Resources, Quicken displays a window that provides
general information about personal financial planners. Go ahead and look at
this stuff. But, well, can I be blunt? I think you need to be very careful about
getting personal financial advice from a so-called personal financial advisor.
Some advisors are very skilled. For example, I think anyone who’s got the
personal finance specialist (PFS) designation is a good bet. These persons
are certified public accountants, which means that they’re either college or
graduate business school graduates who have passed a grueling three-day
test and have spent time working with a publicly licensed CPA in a sort of
apprenticeship. And these persons have also met a bunch of other knowledge
and experience requirements.

[ also think a tax attorney who specializes in estate tax planning usually pro-
vides pretty good advice. I don’t think, however, that someone who’s gone
through a company-sponsored training program or a night school correspon-
dence program — even one that leads to a professional designation — is auto-
matically good. Okay, some are. I grant you that. But [ would urge you to be
very cautious about taking advice from someone who earns a commission by
selling you financial products and services. Be careful. It’s a jungle out there.
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“Sometimes 1 feel behind the times.
I asked my 11-year old toset up
Quicken for my business, and he
said he would, only atterhe sets
up Quicken for hislemonade stand.”



In this part . . .

A re you going to be using Quicken for your personal
financial stuff? If so, you should know that this pro-

gram offers more than just the checkbook-on-a-computer
business that [ describe in Part II. Quicken can help you
manage and monitor such things as credit cards, home
mortgages, and investments. If this stuff sounds interest-
ing, keep reading.




Chapter 11

Credit Cards, Debit Cards,
and Petty Cash

In This Chapter

Tracking credit cards with Quicken

Setting up a credit card account

Selecting a credit card account so that you can use it
Recording a credit card charge

Changing charges you've already entered

Paying a credit card bill

Reconciling a credit card balance

Handling debit cards

Deciding whether to use Online Account Access

Tracking cash with Quicken

ou can use Quicken to track your credit cards, debit cards, and even the

cash in your pocket in much the same way that you use Quicken to keep
a checkbook. Tracking these items uses a nearly identical process — with a
few wrinkles.

First, however, | need to discuss whether you should even bother.

Tracking a Credit Card

Of course, if you do carry a credit card balance — and about 50 percent of
people do — you can set up a Quicken credit card account and use it for
tracking credit card purchases. If you just need to keep track of how much
you charge during the month (even if you're going to pay the balance in full),
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you must also set up a credit card account and use it. I should make one other
point: In order to track not just what you charge (by using spending categories)
but also where you charge it (by using the Payee field), you must set up a credit
card account and use it.

I don’t use Quicken to track my credit card purchases because I pay my
credit card balance in full every month. (Don’t feel bad if you don’t — it’s like
a natural law that CPAs like me must do this.) Therefore, I don’t have an open
credit card balance to track. What’s more, when I pay the monthly credit card
bill, I can easily use the Split Transaction Window to describe my spending
categories: $3.53 on food for lunch, $52.64 for car repair, and $217.54 for books
(a dangerous, and ultimately destructive, personal weakness). If you're in the
same boat — meaning you use a credit card but you don’t carry a balance —
you don’t need anything special to track your credit card purchases, and,

of course, you don’t need to use Quicken to tell you your account balance
because it’s always zeroed out at the end of the month.

How to Set Up a Credit Card Account

If you want to track credit card spending and balances with Quicken, you must
set up a special credit card account. (In comparison, you use bank accounts
to track other things, such as the money that flows into and out of a checking
account.)

Adding a credit card account

To set up a credit card account, you follow roughly the same steps as you do
to set up a bank account. Here’s what you do:

1. Choose Tools>Account List.
Quicken displays the Account List window, shown in Figure 11-1.
2. Click the Add Account button.

Quicken displays the Quicken Account Setup dialog box, which you’ve
seen about a thousand times before. As you may remember, what you
need to do is enter the name of the credit card company into the text
box that asks you for the name of your financial institution, at which
point Quicken asks you to select the financial institution from its list —
or to just use the name you entered, as shown in Figure 11-2. You click
Next again to display the next Quicken Account Setup dialog box.
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& Account List ==
Goto Edt  Delete  Set Up Online Services Add Account Print  Options =  How Do I?
¥iew Accounts I Manage Accounts
Online
Account Services Status Trans Description Current Balance Ending Balance
Cash Flow Accounts
iChecking ] T7E B 333,16
Savings 2 0,00 550.00
Tokal 228,66 883.16
|
Figure 11-1:
The Account
LI st WIndOW‘ Balance Total: 228,66 883.16
|
Quicken Account Setup
Select your financial institution
‘W found more than one financial instiution with a similar name.
 Use the following financial institution:
~
‘what can | do if my Financial
Institution is nat on this list?
hd
— See afulllist of financial institutions.
Flgure 1 1-2: & None of these, Use the followang name:
The O.Uicken ‘Elg Mational Credit Card
Account
Setup
dialog box. [
|

3. Tell Quicken you’re setting up a credit card account.

Select the Credit Card option button when Quicken asks what type of
account you want to set up (see Figure 11-3). Then, click Next to display
the fourth Quicken Account Setup dialog box (not shown as a figure
because it’s really boring).



] 78 Partii: Home Finances

Quicken Account Setup
Choose the type of account to add.
I
Cash Flow Investments Property & Debt
Figure 11-3: " Checking " Brokerage " House [with ar w/a Martgage)
- " Savings " IRA. SEF. Keogh ™ Wehicle [with or w/o Loan)
The thlrd 7 401(k), 403(b) " Asgel
OUICken ™ Single Mutual Fund " Lizhility
Account
Setup dialog
bOX aSkS » IF you ars bying o set up & security such as a stock or bond, you should
probably choose Brokerage. Click help for more information,
what type
of account
you wa nt
to setup. T
I
4. Name the account; then click Next.
Why not? Move the cursor to the Name This Account text box and type
a name. After you click Next, Quicken displays the fifth Quicken Account
Setup dialog box, shown in Figure 11-4.
Quicken Account Setup
Enter the ending date and balance from your statement, if you have it.
B Enter the ending date on the statement,
Statement D ate: 5/13/2005
B Enter the ending balance on the statement.
Ending B alance: 12,345.00
I This becomes the opening balance of your Guicken account.
Figure 1 ‘I _4: Dion't worry if you don't have your last statement - you can make changes to your account later.
The fifth
Quicken
Account
Setup
dialog box. = [ T
I

5. Enter the date on which you will start keeping records for the credit
card account.

You should probably choose the date of your last statement, as Quicken
suggests. Move the cursor to the Statement Date text box and type the
date in MM/DD/YYYY format. May 13, 2005, for example, should be
entered as 5/13/2005.

6. Enter the balance you owed at the end of the last credit card billing
period after making your payment. Then click Next.
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|
Figure 11-5:
The sixth
Quicken
Account
Setup

dialog box.
|

Move the cursor to the Ending Balance text box and type the balance
value by using the number keys. After you click Next, Quicken displays
the sixth Quicken Account setup dialog box, shown in Figure 11-5.

Quicken Account Setup

If you want, enter the credit limit for this account.

B Credit Limit, if Applicable:

20000 [Dptional)

= |f pou enter your credit limit, Quicken displays your remaining credit in the account register,

= ][ o

7. [Optional] Type in the amount of your credit limit.

If you want, indicate the amount of your credit card limit by moving the

cursor to the Credit Limit, If Applicable text box and then typing whatever
number the credit card company has arbitrarily decided is a reasonable
balance for you to shoulder.

8. Click Done.

Quicken may display a message that urges you to sign up for your credit
card company’s online banking services. For now, ignore this. (If you
later want to sign up, just tell your bank, and it’ll help you get all set up.)
Just click Done again. Quicken finally gets the message and displays the
new account’s register.

Selecting a credit card account
so that you can use it

To tell Quicken that you want to work with an account, you use the Account
List window — the same window you saw in Figure 11-1. To get to the Account
List window again, choose Tools=>Account List and then select the new credit
card account.

You can also get to the credit card account from the Cash Flow Center. Just
click the Cash Flow Center button, and then click the credit card account’s
button.
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After you select the account you want, Quicken displays the register for that
account so that you can begin recording transactions (which I describe in the
next section).

How to Enter Credit Card Transactions

|
Figure 11-6:
The credit
card version
of the
Quicken
register.
|

After you select a credit card account, Quicken displays a special version of
the register, as shown in Figure 11-6.

Touring the credit card register

The credit card register works like the regular register that you use for a bank
account. You enter transactions into the rows of the register. After you record
a charge, Quicken updates the credit card balance and the remaining credit
limit (if you entered the optional credit limit information when you set up the
account).

You can use the same techniques and commands as you do for your regular
ol’ bank account register. I talk about these in earlier chapters, so [ won’t
regurgitate those discussions here.

Quicken 2005 Premier - qdataZ - [Credit: Credit Card] ===
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help
g | P E ; T
@ G da @ =
Back Update Reports  Setup  Services Cuicken. com Customize
Quicken Home ﬁ Credits Credit Cand Register Overview
Delete  Find  Transfer Reconcile Wiew v Reportw  Options »  How Do [7
¥ | Cash Flow Center Datef A Ref PayesefCategaryiMema Charge Clr Payment Balance
Checking 22866 5/13/2005 Opening Balance 12,345 00 R 12,345 00 «
i .00 [Credit Card]
avings . /13200 [EE 7= Fayee Charge Fapment
0 Category Aemo Enter | Edit | Spi
-$12,116.34
= | Investing Center
$0.00
~) | Property & Debt
$0.00
-
Credit Remaining: 7,655,00 Ending Balance: 12,345.00
Met Worth -$12,116.34
S
Financial Overview @ l—l Download Transactions | ‘ Scheduled Transactions {0 Due) ‘ ;‘ |
Customize Hide Amaunts =] Account Lisk i Monitor receivables and payables with Quicken Premier Home: & Business
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Recording a credit card charge

Recording a credit card charge is similar to recording a check or bank account
withdrawal. For the sake of illustration, suppose that you charge $30.47 for
dinner at your favorite Mexican restaurant. Here’s how you record this charge:

1. Enter the charge date.

Move the cursor to the Date field (if it isn’t already there) and type the date
using the MM/DD format. For example, enter May 13, 2005, as 5/13. You
usually don’t have to type the year because Quicken retrieves the current
year number from the little clock inside your computer. Or, if you want,
get crazy — click the box that remotely resembles a calendar at the end of
the field, and Quicken displays a pop-up calendar (see Chapter 4 for more
information) from which you can select the appropriate month and day.

Don’t bother with the Ref field. Quicken supplies it so that you can
record the credit card reference number — a bit of data that’s usually
about 20 characters long. You, my friend, have better things to do with
your time, however. So just skip the field.

2. Record the name of the business you paid with a credit card.

Move the cursor to the Payee field and type the name of the person or
business you paid. If the restaurant is Florencia’s Cantina, for example,
type Florencia’s Cantina into the Payee field.

3. Enter the charge amount.

Move the cursor to the Charge field and type the total charge amount —
30.57 in this example. Don’t type a dollar sign, but do type the period to
indicate the decimal place and cents.

4. Enter the category.

Move the cursor to the Category field, open the drop-down list box, and
select the appropriate category. You may categorize a restaurant charge
as Dining, for example.

5. [Optional] Enter a memo description.

Move the cursor to the Memo field and type the specific reason you're
charging the item, such as a special date with your spouse or an impor-
tant business meeting.

6. Record the charge and click the Enter button.

Quicken beeps and then calculates both the new credit card balance and
the remaining credit limit. Quicken then moves the cursor to the next slot
in the register.

Figure 11-7 shows the charge at Florencia’s. Good food and reasonable
prices — you can’t ask for much more than that.

181



182 Partini: Home Finances

Quicken 2005 Premier - qdataZ - [Credit: Credit Card] ===
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help
3 BT ‘ W
@ © dh £ L @ =
Back  Update Reports  Setup  Services Quicken.com Custamize
Quicken Home ﬁ credits Credit Bard Register | Overview
Delete Find Transfer Reconcile View Reportw Options »  How Do I?
~ | Cash Flow Center Datef A Ref PayesfCategaryMema Charge Clr Payment EBalance
Checking 22866 S/13/2005 Opening Balance 12,345 00 R 12,345 00 ~
o oo [Credit Card]
avings ' §/13/200¢ [ Aef Florencia's Cantina 30 57 Payment 12,375 57
Dining emn Enter | Edit | Spit
5/13/2005
¥ | Investing Center
$0.00
| Property & Debt
$0.00
|
Figure 11-7:
The -|
Credit Remaining: 762443 Ending Balance: 12,375.57
charge at ! b
) Net Worth -$12,146.91
Florencia’s ™
. Financial Overview Q Download Transactions | ‘ Scheduled Transactions (0 Due) ‘ ;I
Cantina.
Customize Hide Amaunts 5] Account Lisk 1 Monitor receivables and payables with Quicken Premier Home & Business
|

Changing charges you've already entered

Use the arrow keys or click the mouse to highlight the charge that you want
to change. Use Tab and Shift+Tab or the mouse to move the cursor to the field
that contains the misinformation you want to fix. You can then fix the entry
and record the transaction by clicking Enter. That’s easy enough, isn’t it?

Paying credit card bills

If you're tracking the credit card account balance with a credit card account
like the one I'm describing here, Quicken provides two ways for you to pay a
credit card bill.

Note: If you're not using a credit card account in Quicken, you record the check
you send to pay a credit card bill in the same way you record any other check.
And that means you don’t have to read anything I'm about to say. Shoot, you
shouldn’t even be reading this chapter.
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Figure 11-8:
A check
transaction
that pays a
credit card
balance.
|

A most bodacious way to pay a credit card bill

This method is pretty simple, so don’t blink your eyes because you may miss
the action.

Look at your credit card statement. Decide how much you want to pay. Select
the bank account on which you’ll write the check. Then write the check and
record it in the bank account register — but as a transfer to the credit card
account.

You're done. If you have questions, take a peek at the selected check transac-
tion shown in Figure 11-8. It pays $30.57 of the credit card balance. The only
trick — if you want to call it that — is that the credit card account is specified
as the account to which the money is transferred. (You can see the other
account by right-clicking the transaction and selecting Go To Transfer, or you
can click the other account’s QuickTab, of course.)

If you could look at the credit card account register now — of course, you
can’t because you're not sitting in front of my computer — you would see
that this check reduces the credit card balance by $30.47.

Quicken 2005 Premier - gdata? - [Checking] BE=
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help

@ G da P L a

Back Update Reports  Setup  Services Cuicken. com Customize
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Delete  Find  Trapsfer Reconclle  Write Checks  Set Up Online Wiew v Reportw  Options »  How Do [7
¥ | Cash Flow Center Datef A Ium Descriptionfsfer AcctiMema Payment Cl Deposit Balance |
6 5/12/2005 Opening Balance R 4|16 -271 34 d
o .00 [Checking]
avings ; SiLHEO0s 1001 Movies Galore 550 171 34
Credit Card -12,375.57 Utiities:Cable TY
“$12,146.91 || EFETEO0S  DEP Aurk Erid [3 mood -zl 9l
= | Investing Center Gift Received
40,00 8131/z002 TXFR. Big Mational Credit Card 3057 Depost -23Z 48
. [Credit Card] Memo Enter | Edit | Spi
~) | Property & Debt 5/3(2005 Movies Galore 25 5E| Return ko Reconcile
$0.00 Utilities: Cable TY
/42005 DEP Aunt: Enid 100 00 -157 95
Gift Received
/52005 THFR. Birthday 5000 -207 98
[Savings]
&/5/2005 Carner Store 2000 -EIT 95
--5plit--
5/13/2005
-
Current Balance: -171.54 Ending Balance: -EIT.9E
a
Net Worth $12,146.91 J Download Transactions | ‘ Scheduled Transactions {0 Due) ‘ ;‘ |
Financial Overview @ Set Up Download | Set Up Online Payment ‘ Save time - autamatically keep this account up to date! ‘
Customize Hide Amaunts =] Account Lisk i Monitor receivables and payables with Quicken Premier Home: & Business
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A less bodacious way to pay a credit card bill

You can also tell Quicken that you want to pay some portion of the credit
card bill as part of reconciling the credit card’s account balance. What will
happen is that after you reconcile the credit card account, Quicken will (or
may) ask whether you want to make a payment. If you say you do, Quicken
prompts you to describe the payment.

I think that this method is slightly more difficult. But if you want to reconcile
your credit card account, think about using this second method. If you're rec-
onciling a credit card statement and paying some portion of the credit card
balance at the same time, you may find this method more convenient. Who
knows?

I describe how to reconcile a credit card account in the very next section.

Reconciling That Crazy Account

You know that trick in which you compare your checking account records with
your bank’s records of your checking account? The one in which you calcu-
late the difference between what you think is your account balance and what
the bank thinks is your balance? And this difference is supposed to equal the
total of the transactions floating around out there in the system? You can use
this same trick on your credit card account.

Reconciling your credit card account,
neat and straight up

To reconcile a credit card account, first get your credit card statement. Next,
display the credit card account in a register window.

What the nasty credit card company says
To tell Quicken what that nasty credit card company says, follow these steps

and put on some music if you can’t seem to get the rhythm thing right:
1. Click the Reconcile button on the register window.

Quicken displays the Statement Summary: Credit Card dialog box,
shown in Figure 11-9.

2. Enter the charges and cash advances that your statement shows.

Move the cursor to the Charges, Cash Advances text box and then type
the number.
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|
Figure 11-9:
The
Statement
Summary:
Credit Card
dialog box.
|

Statement Summary: Credit Card

The last statement ending date: 5/31/2005

1 . Enter the following from your statement

Charges, Cash Advances:

[ather than finance charges]

Paprnents, Credits: 30.57
Ending Balance: 12.345.00
New Statement Ending Date:  [5/30/2005

2. Enter and categorize pour interest charges, if any.

Finance Chaiges.  [25.00 Date: [F/31/2005 &)
Categary: |\nterest Exp E

| ak, | ‘ Cancel | | Help |

3. Enter the payment and credits that your statement shows.

You know the drill: Move the cursor to the Payments, Credits text box
and type the number.

4. Enter the new balance shown on the credit card statement.

Now I bet this is a surprise. Go ahead and type the figure in the Ending
Balance text box — even if you just can’t believe you charged that much.

5. Enter the ending statement date.

I don’t know why Quicken is now collecting this piece of information. For
more than ten years, Quicken has been able to reconcile your credit card
account (and any other account) without this snidbit of data.

6. Enter the monthly interest charge by using the Finance Charges
text box.

Pause for a moment of silence here if this topic makes you sad, sad, sad.

7. Assign the monthly interest to the appropriate spending category,
such as Interest Exp.

Move the cursor to the Category text box and type the category name.
(Are you getting bored yet? | know: move and type . .. move and type. ..
all [ ever seem to say is “move and type.”) Remember that you can click
the little down arrow at the end of the text box to see a list of categories
to select from.

8. Click OK.

Quicken displays the Statement Summary: Credit Card window (see Fig-

ure 11-10). Use this window to tell Quicken which credit card charges and
payments appear on your statement. (This step is akin to looking at a bank
statement and noting which checks and deposits have cleared the bank.)
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Statement Summary: Credit Card ==
Mew Edit  Delete Back to Statement Summary View = How Do I?
Charges Payments
Clr Date Payee Amount Clr Payee
5/13/2005 Opening Balance 12,345.00 edit Card
5/13/2005 Florencia's Canting 30.57
|
Figure 11-10:
Th e 0 payments, credits 0.00
Statement
Summal’y: Cleared Balance: 0.00
B Statement Ending Balance: 12,345.00
CrEdIt Card Difference: -12, ;45 11]
. 0 charges, debits 0.00 B i "
window.
Mark Al Cancel Finish Later | Finished |
|

Ouch! Did 1 really spend that much?

After you give Quicken an overview of your credit card situation, you can
note which charges have cleared and which charges have not.

If you're comfortable whipping through a bank reconciliation, you can proba-
bly do this reconciliation with your eyes closed. If you need some help, leave
your eyes open so that you can read these steps:

1. Find the first charge listed on the credit card statement.

2. Mark the charge as cleared.

Charges are listed in the left list box. If you charged a bunch of stuff, scroll
through the transactions listed in the Charges window until you find the
charge. After you see a charge that appears on your credit card statement,
click it. Or select the charge by using the arrow keys and then press the
spacebar. Quicken adds the check mark symbol in front of the list entry
in the Clr column to mark this charge as cleared and then updates the
cleared statement balance.

3. Enter any missing charges.
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If you can’t find a charge, you probably didn’t enter it in the Quicken reg-
ister yet. Open the credit card account register by clicking its tab and then
enter the charge into the register in the usual way — except enter a c
(the letter ¢) into the Clr column by clicking the Clr field. By doing so,
you identify the charge as one that’s already cleared. After you finish,
click the Back to Statement Summary button to return to the Statement
Summary: Credit Card window.

4. Repeat Steps 1, 2, and 3 for charges listed on the credit card statement.
Or until you're blue in the face.

5. Find the first payment or credit listed on the credit card statement.
Any payments and credits appear in the right list box.

6. Mark the payment or credit as cleared.

Scroll through the transactions listed on the Payment window until you
find the first payment or credit and then click it. Or select the credit and
then press the spacebar. Quicken adds the check mark symbol in front of
the list entry to mark the payment or credit as cleared and then updates
the cleared statement balance.

7. Enter any missing payments or credits.

If you can’t find the payment or credit — you probably know what I'm
going to say — it means you haven’t entered it into the Quicken register
yet. Open the credit card account register by clicking its tab and then
enter the payment or credit into the register in the usual way, but put

a c in the Clr column. When you finish, click the Return to Reconcile
button to return to the Statement Summary: Credit Card window.

8. Repeat Steps 5, 6, and 7 for payments or credits listed on the credit
card statement.

If you record a transaction wrong, do this

As you're looking through the credit card statement, you may discover that
you incorrectly recorded a transaction. If this happens, display the credit card
register so that you can make the necessary fixes.

Oh, that explains the difference

After you mark all the cleared charges and payments, the difference between
the cleared balance for the credit card and the statement’s ending balance
should be zero.

Figure 11-11 shows how this looks. By the way, reconciling with fictitious data
is darned easy.
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Figure 11-11:
When the
difference

between

the cleared
balance and
the state-
ment is zero,
the recon-
ciliation is
complete.
|

Statement Summary: Credit Card B[]
Mew Edit  Delete Back to Statement Summary View = How Do I?
Charges Payments

Clr Date Payee Amount Clr Date Payee Amaunt

& 5/13/2005 Opening Balance 12,345.00 « 5/31/2005 Big MNational Credit Card -30.57
5/13/2005 Florencia's Cantina

1 payment, credit -30.57

Cleared Balance: 12,345.00
Statement Ending Balance: 12,345.00
Difference: 0.00

Mark Al Cancel Finish Later | Finished |

2 charges, debits 12,375.57

If you're ready to finish
If the difference does equal zero, you're cool. You're golden. You're done.
(Sort of makes you sound like fried chicken, doesn’t it?)

All you need to do is click Finished to tell Quicken that you're done. Quicken
asks you whether you want to make a credit card payment. Jump ahead a
couple of paragraphs for help doing just that.

If the difference doesn’t equal zero, you have a problem. If you clicked Finished
in spite of the problem, Quicken displays a message that has some cursory
explanation as to why your account doesn’t balance. This message also tells
you that you can force the two amounts to agree by pressing Enter.

Forcing the two amounts to agree isn’t a very good idea, though. To make the
balances agree, Quicken adds a cleared transaction equal to the difference.
(Quicken asks for a category if you choose the adjustment route.)

Despite the ease of making adjustments, you should still correct the error
responsible for the difference.

Chapter 8 provides some ideas for trying to figure out why a bank account
that should balance doesn’t. You can apply the same list of tips to credit card
reconciliations if you’re in a bad way.



Figure 11-12:
The
Adjusting
Register To
Agree With
Statement
dialog box.
|
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If you want to postpone the inevitable

You can postpone reconciling the account by clicking the Finish Later button.
When you click this button, you abandon your reconciliation work. Transac-
tions that you mark as cleared still show the c in the Clr text box. You still
have an inexplicable difference between the credit card statement and your
register. Even so, postponing a reconciliation is usually better than forcing the
cleared balance to equal the credit card statement balance. By postponing a
reconciliation, you can hopefully find the problem or problems and fix them.
Then you can restart the reconciliation and finish your work. (You restart a
credit card reconciliation in the same way that you originally start one.)

When you finish, Quicken redisplays the Register tab. You may notice that, as
you mark credit card transactions as cleared, Quicken puts a c in the Clr column
of the credit card register. When you finish reconciling the credit card account,
Quicken changes all these cs to Rs. None of what Quicken does here is magical.
Quicken just makes this change to identify the transactions that have already
been through the reconciliation process. (The c shows that a transaction has
been marked as cleared. The R shows that a transaction has been reconciled.)

Paying the bill as part of the reconciliation

After you finish reconciling the credit card account, Quicken does two things.
First, if some of the stuff in the credit card register doesn’t agree with the
credit card statement, Quicken displays a message box to alert you to these,
er, discrepancies and then suggests you let Quicken bring your records into
agreement with the state (see Figure 11-12). To synchronize your records with
the credit card statement, verify that Quicken is using a reasonable expense
category to “categorize” the discrepancy and then click Adjust.

Quicken also does a second thing after you finish reconciling a credit card
account. Quicken asks whether you want to pay the bill. Figure 11-13 shows
the Make Credit Card Payment dialog box, which is the tool that Quicken uses
to collect the necessary data. You simply identify the bank account on which
you want to write the check and indicate whether you’ll use a printed check
or a handwritten check. Quicken then records a check that pays the credit
card balance into the register. You can edit, print, and do whatever else you
want to do with this check in the usual way.

Adjusting Register to Agree with Statement
In order ta bring your records into balance with the statement, Quicken is sbout to
make the following entries in your register.
Opening balance difference
12,345.00 Category (optional); [Misd lz‘
Register missing one or more payments
-30.57 Category [optional): |Misc IE‘
Register missing one or mare charges
12.345.00 Category [optional]: [Misc [2]
| Adjust ‘ | Cancel | | Help |
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Figure 11-13:
The Make
Credit Card
Payment
dialog box.
|

Make Credit Card Payment
Do you want to make a payment now?
“fou have an outstanding balance of $12,345 00
[and uncleared payments and credits of $30.57).
IF pou would like to pay some or all of this amount, select &
bank account below and click ves.
Bank Account: | Checking i

Payment Method
f* Printed Check.
" Hand wiitten Check

| Yes

Mg | | nee

™ Don't show me this screen again

The Online Banking Hoopla

As I mention in Chapter 6, Quicken supports online banking. If you have your
credit card with a credit card company — probably a bank — that is set up

to handle Quicken online banking, you can grab your credit card statement
directly from the credit card company. If you have a checking account at the
bank that issued the credit card, you can also pay your credit card bill simply
by transferring money from your checking account to your credit card. (This
feature is actually pretty slick, I have to say.)

The big hoopla concerning this feature — at least as it relates to credit cards —
is that you don’t have to enter the credit card transactions into a register.
Rather, you retrieve them by using a modem.

Should you even bother?

Is the online-banking-with-a-credit-card-thing a feature that you should look
into? Does it really save you time? Is it a good deal? Inquiring minds want to
know, so I'll tell you what I think. (I should point out that what I'm about to
say next is just my humble opinion.)

I think that online banking in general is well worth the fee you probably have
to pay for the service when you consider the time savings. You’'ll probably
pay only a few dollars a month. (What you pay depends on the bank issuing
the credit card.)

Something bothers me about the whole deal, however: You really just receive
an electronic version of your statement, which means — at least from my
perspective — that you're more likely not to see erroneous transactions.
And reconciling your bank statement against, well, your bank statement isn’t
going to make a whole heck of a lot of sense. (Golly, gee, Batman, the charge
to Edna’s Pet School appears on both statements, too!)
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How to use Online Account Access
with your credit card

Okay, so you've listened to my side of the story, but you still want to use the
Quicken Online Account Access feature with your credit card — and your
bank is one that provides this service. “What next?” you’re wondering.

Here’s the answer: You set up online credit card accounts the same way you
set up online bank accounts. Note: For more information about the Quicken
Online Account Access feature, see Chapter 6.

Petty Cash and Mad Money

You can track petty cash in your business as well as the petty cash in your
wallet by using a special Quicken cash account. To track the cash, you must
set up a cash account and then enter the increases and decreases into the
cash account’s register. Sure, this stuff isn’t exactly rocket science, but shoot,
I thought I'd just quickly go over it to show you how easy it really is. Okay?

Adding a cash account

To set up a cash account, you follow roughly the same steps as you do for
setting up a bank account. Because you’ve probably already set up a bank
account, you can move quickly through the following steps to set up a cash
account:

1. Display the Account List window.

Choose the Tools=>Account List command. Quicken displays the Account
List window (refer to Figure 11-1). You remember this puppy.

2. Click the Add Account button to set up a new account.

Quicken, of course, is no fool, and so it displays the Quicken Account
Setup dialog box.

3. Set up a cash account.

You can guess how to do this, can’t you? You simply step through
Quicken’s questions about the account you want to set up. You'll need
to specify, for example, that this account isn’t kept at some financial
institution and that it’s a cash account. You'll need to give the account
a name, such as “pocket money.” And you’ll need to provide a starting
balance value using the faithful, the familiar Quicken Account Setup
dialog box, shown in Figure 11-14.
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Figure 11-14:
The final
Quicken
Account

Setup dialog
box used
for cash

accounts.
|

\\J

4. Click Done.

When you finish describing the cash account, click Done. Quicken dis-
plays the new cash account in a register window.

Quicken Account Setup
Enter the ending date and balance from your statement. if you have it.
B Enter the date you want to start with,
L5 of Diste Er2/200E
B Enter how much cash you have.
Amount [39.41
This becomes the opening balanoe of your Guicken account.
Dlon't wormy if you don't have your last statement - you can make changes to your sccount later
B ][ E

Tracking cash inflows and outflows

After you set up a cash account, you can use it to track the cash you receive
and spend in the same way that you track the deposits and checks for a bank
account.

To record your cash inflows and outflows, use the QuickTab for the account,
which should appear under the Cash Flow Center button. Figure 11-15 shows
the cash account version of the register. Until you start entering transactions,
only the first opening balance transaction shows.

To record the amount of money you spend, fill in the Date, Payee, and Spend
fields. To record the amount of money you receive, fill in the Date, Payee, and
Receive fields. To track the reasons that you're receiving and spending the
cash, use the Memo and Category fields.

Recording checks you cash
instead of deposit

By the way, you don’t necessarily need to set up a cash account if you like to
spend cash (rather than, say, write checks or charge on a credit card). If you
just cash a check and you do have a bank account set up, you can record the
transaction in another way that may be simpler: Just use the Split Transaction
window to show both the income category (Salary, for example, for an indi-
vidual) and how you’re going to use the money.
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Figure 11-15:
The cash
account
version of
the register.
|

Figure 11-16:
A zero-
amount

transaction
is one
handy trick.
|

Quicken 2005 Premier - qdata2 - [Cash: Cash Account] [BE=
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help
¥ P " L]
@ © dh £ L @ =
Back  Update Reports  Setup  Services Quicken.com Custamize
Quicken Home ﬁ Lash: Bash Account Reaqister I Overview
Delete Find Transfer  Update Balance Vieww Reportw Options »  How Da I?
~ | Cash Flow Center Datef A Ref PayesfCategaryMema Spend Cl Receive EBalance |
Checking 5/13/2005 Opening Balance 3941 394] ~
[Cash Account]
; 571372005 Fayee Spend, Receive
Savings 0.00
7 Category Memo Erter | Edit | apit
Credit Card -24,720,57
-$24,452.50
¥ | Investing Center
$0.00
| Property & Debt
$0.00
-|
Ending Balance: 39,41
Net Worth -$24,452.50
S
Financial 0verview$ l_l Download Transactions H Scheduled Transactions (0 Due) ‘ ;||
Customize Hide Amaunts 5] Account Lisk El Gek the big picture of your credi card transactions

For example, if you cash a $1,000 check and you plan to use the $1,000 for
spending money, you may show a positive $1,000 in the Salary category and
a minus $1,000 in the Entertainment spending category. Figure 11-16 shows
this trick.

Split Transaction
Enter multiple categories to itemize this transaction; use the Memao field to record more details.
Category Memo Amount
1. |Salaw Spouse 1,000 00|~
2. | Entertainment 1,000/ 00|
El [= |
4. Hext Edit -
[
E.
7.
8
&
10
1
1z
13
14
18
1E. sl
Split Total: 0.00
| 0K | | Cancel || Help Remainder: 0.00
I—}Ijlnt Llsle the Adjust buttan at right to recalculate Transaction Total 0.00
the total.
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Note that the transaction shown in Figure 11-16 produces a transaction that
equals zero. This is correct. Cashing a check that you never deposited doesn’t
affect your checking account balance. But by filling out the Split Transaction
window as shown in Figure 11-16, you do end up recording both the $1,000 of
income and the $1,000 of expense.

Don’t worry. [ won’t ask why you're carrying around $1,000 in cash.

Updating cash balances

You can update a register’s cash balance to reflect what you actually have
in petty cash, your wallet, under the mattress, in the cookie jar, or wherever
else you keep your cash by taking the following steps:

1. Display the cash account register.

2. Click the Update Balance button.

Quicken displays the Update Account Balance: Cash Account dialog box,
shown in Figure 11-17.

Uipdate Account Balance: Cash Account
|
. This Account Last Updated: MA2
F'Ql"e 1 1 _1 7: 1 - Enter the current balance for this account
The Update Update Balance to: 24.05
Account st Bt B/ 72005
Balance:
Ca Sh 2 . Choose a category for the balance adjustment.
Account Category for Adjustment: ise: E
dialog box. [ o | [ ceed | [ hep |
|

3. Enter the actual cash balance in the Update Balance To text box.
4. Enter a date in the Adjustment Date text box.

5. Choose the category that you want to update in the Category For
Adjustment drop-down list box.

After you click the arrow to the right of the drop-down list box, you get a
list of all the categories that you have set up.

6. After you finish, click OK.

Quicken updates the cash account’s balance.

And that, my friend, is that.



Chapter 12
Other People’s Money

In This Chapter

Tracking loans, mortgages, and other debts

Setting up liability accounts

Calculating the principal and interest portions of a payment
Recording loan payments

Handling mortgage escrow accounts

Adjusting principal and interest breakdowns

Scheduling automatic loan payments

A popular, financial self-help writer thinks that one of the secrets to finan-
cial success is using other people’s money: the bank’s, the mortgage
company’s, the credit people’s, your brother-in-law’s. . . . You get the idea.

Me? I'm not so sure that using other people’s money is the key to financial
success. But borrowing other people’s money can turn into a nightmare.

Quicken can help you here. No, the folks at Intuit won’t make your loan pay-
ments for you. But in a way, they do something even better. They provide you
with a tool to monitor the money you owe other people and the costs of your
debts.

Should Vou Bother to Track Vour Debts?

[ think that tracking your debts — car loans, mortgages, student loans, and so
on — is a good idea when lenders fail to tell you the amount that you're paying
in annual interest or the amount you owe after each and every payment.
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If your lenders are doing a good job at keeping you informed, I don’t think that
using Quicken for this purpose makes much sense. Heck, it’s their money.
They can do the work, right?

Let me make one more observation. If lenders have half a clue, they send you
a United States 1098 tax form at the end of every year. The number shown on
that form equals your tax deduction if the interest stems from a mortgage,
business, or investment loan. Note that personal interest expenses aren’t
deductible anymore, so you shouldn’t track them unless you really want to
be mean to yourself.

How Do Vou Get Started?

To track other people’s money with Quicken, you must set up a liability
account. Setting up one of these babies is easy. Just remember that you must
set up a liability account for every loan or debt you want to track: one account
for your mortgage, another for your car loan, still another for your student
loan, and so on.

Setting up a liability account
for an amortized loan

An amortized loan is one on which you make regular, equal-sized payments.
Over time, the principal portion of each payment pays off, or amortizes,
the loan principal. If you borrowed money to purchase a house, a car, a
Winnebago, or anything else that’s really expensive and that you pay off
over several years, chances are that your loan is of the amortizing variety.

Setting up a loan account requires a couple of dozen steps. But none of the
steps is difficult. And none takes that much time to complete. As long as you
have your loan information handy — the loan amount, interest rate, balance,
and so on — setting up this type of account is a snap.

Here’s the recipe for setting up a liability account:

1. Click the Property & Debts Center button.
Quicken displays the Property & Debts Center window.
2. Click the Add Loan button in the Property & Debts Center window.

Quicken displays the Loan Setup dialog box. Click the Summary tab to
see the dialog box exactly as it’s shown here (in Figure 12-1).

3. Provide some basic background information. Then click Next.



|
Figure 12-1:
The Loan
Setup

dialog box.
|

|
Figure 12-2:
Another
Loan Setup
dialog box.
|
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Chapter
Loan Setup
EasyStep I Summary
Loan Type
& Bomow Maney " Lend Monep
Account
& New Account I
& \ E
Have Any Payments Been Made?
¥ ‘Yes " No

Use the Loan Type option buttons to specify whether you're borrowing
money or lending money. Use the New Account box to name the new loan
account something clever like “mortgage” or “car loan.” And use the Have
Any Payments Been Made? option buttons to indicate, well, whether
you've started making payments yet. After you click Next, Quicken dis-
plays another set of boxes and buttons, as shown in Figure 12-2.

Loan Setup
EasyStep I Summary
Loan Intarmation
Opening Date: [E/13/2005
Original Balance: [100,000.00
Driginal Length: 30 YVears -
Campaunding Period: tdanthly =
Payment Period
Monthly -
(" Other Period ’7

4. Enter the date that you borrowed the money in the Opening Date text
box or, if your loan has a grace period (like a student loan), enter the
date when your loan enters the repayment period.

Quicken needs to know this date so that it can calculate the interest the
loan started to accrue when you borrowed the money. The program sug-
gests the current system date as the Opening Date, but this is probably

wrong.
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5. Enter the original loan balance.

Enter the original loan amount into the Original Balance text box. You
can get this amount, if you're unsure, from the original loan documents.

6. Enter the loan term in years in the Original Length text box.

If you set up a 30-year mortgage, for example, type 30. You have to per-
form one tiny trick when entering this figure: If you set up a loan that
includes a balloon payment, enter the number of years over which the
loan will be fully paid — not the number of years used for calculating
the loan payment. For example, loan payments may be calculated based
on a 30-year term, but the loan may require a balloon payment at the
end of seven years. In this case, type 7 in the Original Length text box.

7. Indicate how often the bank calculates loan interest.

Use the Compounding Period box to specify how often the bank calculates
interest on the loan. The interest compounding period usually equals the
payment period.

8. Describe how often you make a loan payment by using the Payment
Period options.

If you make regular monthly payments, for example, select the Standard
Period option button and then open the Standard Period drop-down list
box and select Monthly. If you can’t find an entry in the Standard Period
drop-down list box that describes how often you make payments, select
the Other Period option button and then type the number of payments
you make each year in the Payments Per Year text box.

9. Click Next.

Quicken displays another set of boxes and buttons in the Summary tab
(as shown in Figure 12-3).

Loan Setup
EasyStep | Summary
Balloon Information
' MNa Balloon Payment
— " Amartized Length
. " Calculate
Figure 12-3:
S Current Balance
ome more (% Cunent Balance: [100.000.00 asof. [BAS/2006 (@
buttons and  Cabuas
boxes you —
can use to (¥ Payment Amaunt [P+ [BaaEd duz o [BA3/2005 [
describe the © Cakulae Inorest Re: F07
amortized
loan,
|
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10. Describe the balloon payment — if you have one.

The balloon payment option buttons and boxes let you alert Quicken to
any balloon payment you must make in addition to the last regular loan
payment. If the loan doesn’t have a balloon payment, ignore this stuff
and make sure that the No Balloon Payment option is selected.

If the loan does have a balloon, select the Amortized Length option
button; then use the Amortized Length text box and drop-down list
box to specify the number of years or months (or whatever) the loan

is amortized over. If you know that you have a loan payment (and know
the loan payment amount) but don’t know what the amount is or when
it occurs, select the Balloon Information’s Calculate option button.

11. Enter the Current Balance if you’ve made any payments.

If you indicated that you have already made payments on the loan, spec-
ify how much you still owe on the loan after making the last payment by
using the Current Balance text box. If you don’t know the current balance,
call the lender and ask for it. If you haven’t made any payments yet, skip
to Step 12. You know the drill by now. Just move the cursor to the text
box and pound a few number keys.

12. Enter the date as of which the current balance is, well, current.

Use the As Of field to indicate the date for which you’ve entered the cur-
rent balance. All the standard date entry and date editing tricks apply to
this text box. You can press the + and - keys, for example, to move the
date ahead and back by one day. And you can click that icon at the right
end of the As Of text box to display a pop-up calendar.

13. Specify the interest rate.

Enter the loan’s interest rate into the Interest Rate text box in the Payment
section of this window. The loan interest rate, by the way, isn’t the same
thing as the APR, or annual percentage rate. You want to enter the actual
interest rate used to calculate your payments. Enter the interest rate as
a decimal amount. For example, don’t type 7%, type 7.625. You should be
able to get this rate from the lender or the prospective lender.

14. Describe the payment in more detail — if necessary.

If you've entered all the loan information that Quicken has requested in
the preceding steps, you can just select the Payment’s Calculate option
button. Quicken then calculates the loan payment by using the loan bal-
ance, term, balloon payment information, and interest rate you've already
entered. If you haven’t entered all this information — say you left out the
balloon payment information because you don’t know what it is — select
the Payment Amount (P+I) option button and then enter the loan principal
and interest amount into the Payment Amount (P+I) text box. If necessary,
edit the next payment date in the Due On drop-down list box.
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|
Figure 12-4:
The Set Up
Loan
Payment
dialog box.
|

15.

Click Done.

If you asked Quicken to calculate anything for you, a dialog box pops up
telling you that Quicken did so. Click OK. Make sure that the Quicken
calculations make sense and then click Done again. Quicken displays
the Set Up Loan Payment dialog box (shown in Figure 12-4).

Set Up

Loan Payment

Payment

—
Current [nterest Rate: B.0%
Principal and Interest: 593.655 Cancel

Other

Tratg

Type:

Payee: |E\g Mational Bank of Pine Lake

Memo

Mest Payment Date: £/13/2005

Category for Interest: ||ﬂlElESl Exp lz‘

=

amaunts in payment: U.DU-—| Edit.. |
Full Payrent: 599.55

actioh

Payrent ~| — | PaymentMethod...

[Martgage # 123456723

16.

17.

18.

Verify the principal and interest payment calculated by the program.

If it’s wrong, you can keep going, but let me point out a minor yet annoy-
ing problem. You probably entered one of the loan calculation inputs
incorrectly, such as the loan balance, the loan term, or the interest rate.
Fortunately, these errors are only a minor bummer. Later in this chapter
(in the “Fixing loan stuff” section), I describe how to restart.

[Optional] Indicate any amounts you pay besides principal and interest.

Click the Edit button. Quicken displays the Split Transaction dialog box
(see Figure 12-5), which you can use to describe any additional amounts
the lender requires you to pay. In the case of a mortgage, for example, you
may be required to pay property taxes or private mortgage insurance.
After you enter the information and click OK, Quicken calculates the full
payment and redisplays the Set Up Loan Payment dialog box (refer to
Figure 12-4).

Indicate how you make payments in the Type drop-down list box.
Select one of the payment transaction types listed in the Type drop-
down list box. Payment means that you hand-write checks; Print Check

means that you print checks by using Quicken; and Online Pmt means
that you use Quicken Online Banking to make electronic payments.



Chapter 12: Other People’s Money 20 1

Split Transaction
Enter multiple categories to itemize this transaction; use the Memao field to record more details.
Category Memo Amount
1. TaxProperty property tax 125 00 A
z |
3 Mext Edt ~
4
5
E.
7
8
)
10
11
12
L
H . |14
Figure 12-5_. o
The Split [ v
1 Split Tatal: 125.00
Trgnsactlon [ o« Cancel |[ Help Remeinder 0.00
d|a|0g bOX Hint: Use the Adjust button at ight to recalculate Transaction T il 12500
the total.
|
If you print checks by using Quicken and want to put the payee’s address
on the check, click the Address button in the Set Up Loan Payment dialog
box. Quicken displays a dialog box that you can use to input the payee’s
address, as shown in Figure 12-6. When you finish providing name and
address information, click OK and go get another cup of coffee. When
you come back, Quicken will have redisplayed the Set Up Loan Payment
dialog box.
19. Type the lender’s name in the Payee text box.
The payee is just the name of the person or business that loaned you the
money.
Edit Address Book Record
Payee | Contact T Secondary I Personal I Miscellaneous ]
Payee: Big Mational Bank. of Pine Lake
Street: 123 btain Street
City: Fine Lake
State hfE
|
Zip Code: 93053
Figure 12-6: Ty e,
The Edlt Al L Include this Payee in
Address _ —
Book I~ QuickFil List
Record
dialog box.
Groups: Maone
|
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20.

21.

22.

23.

[Optional] Type a memo description.

Does the lender always get mixed up when you send the check? Stick the
loan account number in the check’s Memo text box. I refrain from using
this text box to comment on the fairness of the bank’s interest rate, to
mock the intelligence of the loan payment processors, or to perform
other emotionally gratifying, but generally unproductive, acts.

Type the date of your next loan payment in the Next Payment Date
text box.

Enter the interest category.

Open the Category for Interest drop-down list and select the appropriate
category.

Quicken lets you schedule (have Quicken automatically enter) or memo-
rize (just have Quicken remind you to enter) loan payments and elec-
tronic payments. [ assume that you don’t want to be doing this kind of
stuff — at least not yet. If 'm assuming incorrectly, click the Payment
Method button. Then fill out the dialog box that appears. It’s not all that
difficult. If you're still confused, I explain how you can use the Calendar
to schedule loan payments later in this chapter.

With the Set Up Loan Payment dialog box displayed, click OK.

Quicken removes the Set Up Loan Payment dialog box and asks whether
any asset is associated with the loan. If you want to associate an asset
with your loan, Quicken walks you through the steps for setting up an
asset account. But you know what? Don’t worry about setting up an asset
account. It actually isn’t worth it. Just click No. Quicken displays the
Property & Debts Center. You probably want to see the new liability
you've set up in its own register, so click the new account. Quicken
displays the register (as shown in Figure 12-7).

By the way, | want to apologize to you for describing a 23-step process. |
couldn’t do anything about it, but I feel bad anyway.

Fiving loan stuff

Nobody’s perfect, right? You may have made a tiny little mistake in setting up
either the loan or the loan payment. This mistake doesn’t need to be a major
financial or personal crisis, however. Just use the View Loans window to iden-
tify the incorrectly described loan and then make your corrections (as shown
in Figure 12-8). To display the View Loans window, just choose Property &
Debt>Loans.
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Quicken 2005 Premier - qdata? - [Liability: Mortgage] [BE[%]
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help

@ 4 4 P @ =2

Back  Update Reports  Setup  Services Quicken.com Custamize

| Quicken Home ﬁ | Liability: Mortgage Register
Delete  Find  Transfer  Update Balance View Reportw Options »  How Do I?
)| Cash Flow Center Datef A Ref PayesfCategaryMema Increase Cl Decrease EBalance
Checking soaes | | |5/13/2005 Opering Ealance 100,000 00 100,000 00 =
Cash Account 39,41 [Meortgage] -
<
Savings .00 5/13jz00¢ [E] 7= Payee Increare Decreans . .
Category Memo Enker Edit Split;
Credit Card -24,720,57

-$24,452.50

¥ Investing Center

$0.00

= | Property & Debt

1)
-$100,000.00

|
Figure 12-7: |
fahilitye Ending Balance: 100,000.00
The Liability: neling Betance
Net Worth  -$124,452.50
Mortgage | ———
. | Financial Overview Q | l_l Download Transactions | ‘ Scheduled Transactions (0 Due) ‘ El |
register. | .
Account Lisk Ell, Explore your home loan options - apply in Quicken!
|

If you have multiple loans set up, click the Choose Loan (x) button and select
the loan you want to change from the drop-down list that appears. Quicken
gives you all the dirt on the selected loan in the View Loans window.

[- View Loans: Mortgage =)o

Prinkt  How Do I7

Mew  Delete Choose Loan {x) =

l Payment Schedule l Payment Graph

Edit Loan...

Opening Date: 5/1312005

Loan Amount: 100,000.00 Edit Payment...

Payment Amount: 593,55
Make Payment..,

Current Interest Rate: 6.0%

Rate Changes. ..

Original Length: 30 Years

Figure 12-8:
gTh V Payment Frequency:  Monthly payee! Big National ...
lew g
evie Compounding Period:  Monthly Current Balance:  100,000.00
Loans R.Ema\n\ng Pmts: 360
. Final Pmt Date: 5132035
window.
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\\3

|
Figure 12-9:
The Loan
Rate
Changes
dialog box.

Hey, can I mention one other thing about the View Loans window? See those
two tabs labeled Payment Schedule and Payment Graph? You can probably
guess what they do, but if you click the Payment Schedule tab, an amortiza-
tion schedule shows the interest and principal portions of each loan payment.
If you click the Payment Graph tab, Quicken displays a line chart that shows
how you pay off the loan balance over time. You may want to take a minute
and experiment with these two tabs. They're pretty neat.

Changing loan or loan payment information

If you want to change something about the loan, click the Edit Loan button.
Quicken displays the Edit Loan dialog box. It works like the Loan Setup dialog
boxes in Figures 12-1 and 12-2. Make the changes and click OK.

To change something about the payment, click the Edit Payment button.
Quicken displays the Edit Loan Payment dialog box. Make your changes and
click OK.

Working with adjustable rate loans

Before I wrap up this discussion, let me mention a couple other things. If you
have a variable rate loan, you can click the Rate Changes button to display
the Loan Rate Changes dialog box (shown in Figure 12-9). This dialog box has
a very simple purpose: It lists the interest rates you entered for a loan and
the dates these interest rates were used in loan calculations.

Loan Rate Changes
Mew Edit Delete

Print  Close

Date

Rate
b.0%

Principal and Interest

599.55

If you want to record new interest rates — because you have a variable rate
loan and the interest rate changes, for example — follow these steps in the
Loan Rate Changes dialog box:

1. Indicate that you want to record a new interest rate.
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|
Figure 12-10:
Changing a
loan’s
interest rate.
|

Click the New button in the Loan Rate Changes dialog box or right-click
in the dialog box and choose New from the shortcut menu that appears.
Quicken displays the Insert An Interest Rate Change dialog box, shown
in Figure 12-10.

Insert an Interest Rate Change

Effective Date: B/13/2005

Interest Rate: ‘ | Cancel |

Riegular Payment; ‘

2. Provide the effective date of the interest rate change.

Use the Effective Date text box to indicate when the new interest rate
becomes effective. You can either type in a date or open the drop-down
list box and select a date from the calendar.

3. Give the new interest rate.

Type the new interest rate in the Interest Rate text box. When you move
the selection cursor to a new box, Quicken refigures the loan payment
and sticks the new loan payment figure in the Regular Payment text box.

4. Click OK.

Removing and adding loans

You can delete (remove) and add loans by using the Loan Summary tab of the
View Loans window (refer to Figure 12-8).

Delete a loan that you no longer need or shouldn’t have added in the first place
by clicking the Choose Loan (x) button and selecting the loan account. Then
click the Delete button. Quicken then warns you that you're about to delete
your loan and asks you whether you’d like to save the account for your
records. Saving the account keeps the account available in your Accounts
window but eliminates it from your View Loans window. You can hide the
saved account later if you’d like it to disappear from your Accounts window.
(To do so, choose Toolse>Account List, click the Manage Accounts tab when
Quicken displays the Account List window, and then check the Hide In Quicken
box for the account.)

You can add loans from the View Loans window, too (refer to Figure 12-8). To
do so, click the View Loans window’s New button. Quicken displays the Loan
Setup dialog box and walks you through the sequence of steps that I describe
earlier in “Setting up a liability account for an amortized loan” to set up the
loan. For example, you fill out both the Loan Setup dialog box (refer to Figures
12-1 and 12-2) and the Set Up Loan Payment dialog box (refer to Figure 12-4).
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Delivering a Pound of Flesh (Also
Known as Making a Payment )

After you set up a liability account, you're ready to hand over a pound of
your flesh — that is, make a payment. Before you say that this phrase is just
some sort of populist bull-dweeble, [ want to remind you that this metaphor
comes from Shakespeare’s The Merchant of Venice, in which a loan is guaran-
teed with a pound of human flesh. Ouch.

Recording the payment

After you set up the loan and the loan payment, you're ready to record the
payment in (drum roll, please) the register.

I'm trying to make the old Quicken register more exciting for you because
you’re probably becoming pretty darn familiar with it. And familiarity, as they
say, breeds contempt.

Anyway, complete the following steps to record a payment:

1. Display the View Loans window by choosing Property & Debt~>Loans.
2. Display the loan you want to pay.

To do so, click the Choose Loan (x) button at the top of the dialog box
and select the loan from the drop-down list.

3. Click the Make Payment button.

Quicken displays a message box that asks whether the payment you're
making is a regular payment (one the lender expects) or an extra pay-
ment (perhaps to amortize the loan more quickly). After you select the
payment type, Quicken displays either the Make Regular Payment or the
Make Extra Payment dialog box. Figure 12-11 shows the Make Regular
Payment dialog box; the Make Extra Payment dialog box looks almost
exactly the same.

Make Regular Payment
Account to Lse: Type of Tranzaction:
I [Checking | |Fiint Check | 0K
Figure 12-11: Payee: Diate: Cancel
The Make [Bia National Bark of Pine Lake || (_Address.. | [6/13/2005
R I Categary: Amount;
egular | D St | D
Payment Memo: Number
dia |0g box [Martgage # 123455789 | |
|
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4. Describe the loan payment.

I'm not going to give you the blow-by-blow account here. If you’ve gotten
this far, you don’t need my help. (Mostly, as you know, you just type stuff
in boxes.)

5. Click OK.

Quicken enters the loan payment in the liability register and bank
account register. You're done.

Handling mortgage escrow accounts

[ should talk about one minor mortgage record keeping annoyance — mortgage
escrow accounts.

If you have a mortgage, you know the basic procedure. Although your mort-
gage payment may be $599.55 a month, your friendly mortgage company
(while insisting that it trusts you completely) makes you pay an extra $125 a
month for property taxes and other such things. In other words, even though
you’re paying only $599.55 a month in principal and interest, your monthly
payment to the mortgage company is, according to this example, $724.55
($599.55 + $125).

The mortgage company, as you probably know, saves this money for you in
an escrow account or a set of escrow accounts. A couple of times a year, the
mortgage company pays your property taxes, and a time or two a year, it pays
your homeowner’s insurance. If you have private mortgage insurance, it may
pay this fee every month as well. And so it goes.

The question, then, is how do you treat this stuff? As with most things, you
can take the easy way, which is rough, dirty, and unshaven, or the hard way,
which is precise, sophisticated, and cumbersome.

You can choose whichever method you want. It’s your life.

The rough, dirty, and unshaven method

Suppose that you do pay an extra $125 a month. You can treat this extra $125
as another expense category, such as Tax Property or Other Housing or
Property Expenses. (I'm just making up these categories. If you can think of
better ones, use your own.)

Nice. Easy. No fuss. These words and phrases pop into my head when I think
about the rough, dirty, and unshaven method of mortgage escrow record
keeping. Figure 12-12 shows a sample Split Transaction window filled out this
way. If the Split Transaction window seems like too much fuss, mosey on over
to Chapter 4 where I give you the rundown on using it.
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Figure 12-12:
A mortgage
payment
with an
escrow
account
treated as
an expense.
|

Split Transaction
Enter multiple categories to itemize this transaction; use the Memao field to record more details.
Category Memo Amount
1. [Mortgage] E| 99 53 ~
2 Interast Exp Hext Edit = 500/ 00
3. TaxProperty property tax 125 00
4
5
E.
7.
8
&
10
1
1z
13
14
18
6. »
Split Total: 72455
| 0 | | Cancel || ek Remainder: 0.00
I—}Ijlnt Llsle the Adjust buttan at right to recalculate Transaction Total 72455
the total.

[ use the rough, dirty, and unshaven method. Let me make a confession,
though. This approach doesn’t tell you how much moolah you have stashed
away in your escrow accounts. It also doesn’t tell you how much you really
spend in the way of homeowner’s insurance, what you're entitled to claim as
a property tax deduction, or how much they’re bleeding you for private mort-
gage insurance.

To get these figures, you have to peruse the monthly and annual mortgage
account statements — that is, if you get them. Or you have to call the mort-
gage lender and rattle a cage or two.

Still, with all its shortcomings, I like the easy-to-use, rough, dirty, unshaven
method.

The precise, sophisticated, and cumbersome approach

You say you can’t live with the uncertainty, the stress, the not knowing? Then
[ have another approach just for you.

You can set up an asset account for each escrow account for which the mort-
gage company collects money.

You set up asset accounts as you set up a checking account. And, in fact, you
should think of escrow accounts as, essentially, special checking accounts
into which your lender deposits money collected from you so that it can pay
your property taxes and insurance.
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Because I explain this “setting up a checking account” process in Chapter 1,
I'll just cover it quickly. You set up an asset account with its starting balance
equal to the current escrow account balance. To do so, follow these steps:

1. Choose Tools=>Account List to display the Account List window.

2. Click the Add Account button to indicate that you want to create a
new account.

3. As you step through the seemingly interminable account setup
process, identify the account as an asset account and give it a name.

4. Tell Quicken how much money is in the account as of a specific date.

If you've set up an account or two in your time, this process should take
you about 40 seconds.

After you set up your asset account and record its current balance, you're
ready to cruise. Record payments in the escrow as account transfers when-
ever you record the actual loan payment.

You need to do one other thing. When you set up an escrow account, you must
record the payments that the bank makes from your escrow account to the
county assessor (for property taxes) and to the insurance company (for things
such as homeowner’s and private mortgage insurance). You don’t know when
these payments are really made, so watch your monthly mortgage account
statements.

When the mortgage company disburses money from the escrow account to
pay your first property tax assessment, for example, you need to record a
decrease equal to the payment for property taxes and then categorize the
transaction as a property tax expense. This process isn’t tricky in terms of
mechanics. The account increases after every loan payment and decreases
after a disbursement.

Basically, the Asset Account register mirrors the Checking Account register.
The only difference is that the Payment and Deposit fields in the latter are
labeled Decrease and Increase in the former. To get to this account’s register,
click its QuickTab underneath the Property & Debt Center button.

This second approach doesn’t seem like all that much work, does it? And if

you use this approach, you can track escrow balances and escrow spending
precisely. You can, for example, pull your property tax deduction right from
Quicken. Jeepers, maybe I should try the sophisticated approach next year.
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Vour Principal-Interest Breakdown
Won't Be Right

Figure 12-13:
The Update
Account
Balance:
Mortgage
dialog box.
|

Not to bum you out, but your principal-interest breakdown will often be wrong.
You may calculate interest expense as $544.55 when your bank calculates it as
$544.56. A few pennies here, a few pennies there, and pretty soon your account
balance and interest expense tallies are a few pennies off.

So you can’t change the world

You can try calling the bank, telling whomever you talk to what a bozo he
(or she) is, and then demanding that someone there correct your balance.
(If this approach works for you, let me know.)

Or (and this method is really more practical) you can adjust your records to
agree with the bank’s records. Here’s how:
1. Display the register for the liability.

To get to this account’s register, you just click its QuickTab underneath
the Property & Debt Center button.

2. Click the Update Balance button.

(Go ahead. Tap your keys very hard if you're angry that the bank won’t
adjust its records.) Quicken displays the Update Account Balance dialog
box, as shown in Figure 12-13.

Update Account Balance: Mortgage

This Account Last Updated: MA2

‘| . Enter the current balance for this accourt
Update Balance tor 93,900 45
Adiustment Date: 5/13/2005

2. Choose a category for the balance adjustment.
Category for Adiustment: Interest Exp E
[ @ | [ cane | [ Hem |

3. Enter the correct account balance (that is, the one that the bank says
is correct).

Type the correct figure in the Update Balance To text box. (The amount
probably comes from the year-end or month-end loan statement.)



4. Enter the last day of the month or year for which you’re making the
adjustment.

Enter a transaction date in the Adjustment Date text box. (You must use
a transaction date that sticks the adjustment transaction — which fixes
the principal-interest split — into the right month or year.)

5. Enter your interest expense category.

Type the correct category name in the Category For Adjustment text
box. (To see a list of categories, open the drop-down list box.)

6. Record the adjustment.

7. When the Update Account Balance dialog box correctly describes the
needed adjustment, click OK.

Think this adjustment business is kooky?

Does the whole adjustment transaction business make sense to you? At times,
it can seem kind of backwards, so let me throw out a quick observation.

As you record loan payments, you split the loan payment between the interest
expense category and a principal account transfer that reduces the liability.
Here’s what'’s tricky: When the liability gets reduced either too much or not
enough, you must fix the liability balance and the principal-interest split.

Let me give you an example. Suppose that over the course of a year, you record
$0.17 too little interest expense and, therefore, record $0.17 too much principal
reduction, despite your best efforts to be accurate. You need to increase the
liability account balance by $0.17 in this case, but you also need to increase the
interest expense figure by $0.17. By entering the interest expense category in
the Category for Adjustment field, Quicken does these adjustments for you.
Pretty cool, huh?

Automatic Loan Payments

Quicken has a couple of nifty features called Scheduled Transactions and the
Calendar that can help you with automatic loan payments.

The Calendar and Scheduled Transactions features may be useful in other
instances as well. For example, a business may use the Scheduled Transactions
and Calendar features to schedule and plan employee payroll checks, tax
returns, and deposits. But I think that they’re both most useful in the case

of a loan. So I talk about both of them here.

Chapter 12: Other People’s Money 2’ 1
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|
Figure 12-14:
The
Calendar
window.
|

Scheduling a loan payment

If a loan payment occurs regularly, you can set it up as a scheduled payment.
When you do so, Quicken automatically records the payment for you based
on a schedule.

Consider this example. Suppose that on the fifth day of every month your
mortgage company taps your checking account for your mortgage payment.
(You, of course, have already authorized it to do so. The mortgage company
can’t take your money willy-nilly.) You can tell Quicken to record the mortgage
payment on the fifth of each month. Kind of handy, right?

Follow these steps to set up such a scheduled transaction:

1. Choose Cash Flow=>Calendar or press Ctrl+K.

Quicken displays the Calendar window, shown in Figure 12-14. The figure
shows a calendar for the current month and, optionally, a list of memo-
rized payees.

Note: If you can’t see the list of transactions along the right edge of the
Calendar window, choose Optionse>Memorized Payees List.

Calendar 2E)] %]
< Prev Month — Mext Month > Go To Date Add Mote  Select Accounts Print  Options =  How Do I7
DECEMBER 2005 Drag and drop these on the
lendar,
SUN MON TUE WED THU FRI SAT || ceenaer
27 28 29 30 1 2 3
Birthday
4 5 6 T 2 9 10 Corner Store
Florencia’s Cantina
Movies Galore
Opening Balance  -12,345.00
11 12 13 14 15 16 17 Opening Balance 4,16
Salt Mine, LLC 500,00
XK¥Z Property Man...  -250.00
18 19 20 21 22 23 24
25 26 27 28 29 30 31
Account Balances Checking
Savings
#inthousands Credit Card
® Cash Account
Y ———————————— Total
5
10
15
e W2E T2 WdIME BT W9 AL AT A5 1N 12ne 121 1223 1225 IM2T 1ME
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|
Figure 12-15:
The New
Transaction
dialog box.
|

2. Display the first month for which you want to schedule the transaction.

Using the Prev Month and Next Month buttons, select the starting month
for the scheduled transaction. You can also click the Go To Date button.
If you do so, Quicken displays a dialog box that you can use to specify
the precise date you want to schedule a payment for.

. Identify the scheduled transaction and date.

Select the transaction for which you want to create a schedule. In Figure
12-14, for example, you may want to schedule the loan payment to Big
National Bank to fall on the 7th. To do so, select Big National Bank from
the payee list by clicking it.

Then drag the Big National to the 7th. When you release the mouse
button, Quicken displays a dialog box that asks you to confirm the
principal and interest breakdown.

You won’t know whether the breakdown is correct until you see the bank
statement, so click OK. Quicken displays the New Transaction dialog box
(see Figure 12-15).

Mew Transaction
Account to use: Type of Transaction:
|Check\ng j |F'rint Check j [n] 4
Payee: Date: Cancel
[Big National Bark of Pine Lake Address.. | [8/7/2005
Category: Amount; =F
| E | =
temo: Mumber:
[Mortgage # 123456783 \ [

. Identify the account from which the payment should be made.

Open the Account To Use drop-down list box and then select the appro-
priate account.

. Verify that the transaction type is Payment.

Open the Type Of Transaction drop-down list box and select Payment.
(Of course, if you were setting up some other type of payment, you
might choose something else.)

. Verify that the Payee, Date, and Memo fields are correct.

They probably are. But I have kind of a compulsive personality. Because
I've been telling you to check all this other stuff, I thought I'd also suggest
that you check these three fields.

. Click OK.

Quicken adds the payee’s transaction to the calendar.
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|
Figure 12-16:
The
Scheduled
Transaction
List window.
|

Working with scheduled transactions

By dragging payees to the calendar, you add transactions to the register one
at a time. However, Quicken also allows you to automatically schedule the
adding of transactions.

To create these scheduled transactions, you choose the Tools=>Scheduled
Transaction List command. Quicken displays the Scheduled Transaction List
window (see Figure 12-16).

To create a scheduled transaction, click the Create New button and select
Scheduled Transaction to display a dialog box that you use to describe
automatically scheduled transactions (see Figure 12-17). Note that you

can automatically schedule any kind of transaction — loan payments, insur-
ance premiums, child support, or whatever. (I'm describing the automatically
scheduled transactions feature here, though, because loan payments are the
most common way to use this Quicken feature.)

To schedule a transaction, describe the account to use, the transaction
method, the payee, category, amount and so on. You shouldn’t have any trou-
ble figuring out what goes into these boxes. They're the same boxes you use
to record a check into the register.

[— Scheduled Transaction List =IEE

Create Mew » Edit  Delete Options = How Do 17

Monthly Eills & Deposits All Types

E May 2005 m [v Show graph v Show calendar

Paid Date Mame(Payes Payments Deposits  Method  Account  Web ActionyStatus
5/13f2005 | Carner Store -20.00 Payment | Checking Enter| Edit| Skip

Far account: Checking May 2005

& T oW T

i

61 B2 BB T BO BT B3 BAE BAY BMA BI21 B22 B2G BIZF B2 B
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The Create
Scheduled

Transaction
dialog box.

|
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After you describe the transaction, use the Scheduling options to describe
the payment schedule. The Start On box, for example, lets you describe when
the first payment occurs. The Remind Me options let you tell Quicken when
you want to be reminded about the payment. The Frequency options let you
describe the payment pattern: every month on the 13th, the second Friday of
every month, and so on (see Figure 12-17). You can also use the Ending On
boxes to identify when the payments stop.

Create Scheduled Transaction
Account to use: Transaction method: Web page address [optional):
|Ehecking j |F‘ayment j

Payee:

| \i‘ Amount

{+ |0.00 =
LCategory:
[ (2] Split. (" Estimate fram last j paymerts
Memo: F
Scheduling
Stator:  [E/13/2008  [m|  [RemindMe =] B = doysinadvance
Frequency:  [Monthly - @ Day [13 of every [1 rmonth(s]

" The |Second =/ |Friday | ofevery |1 manth(s]
Ending an, * Moenddate  On ’7 " After ’_ limes
(T O I

Checking out the Calendar

The bar along the top of the Calendar (refer to Figure 12-14) provides some
other tools that you may want to use. 'm not going to spend much time on
them; you’ll have more fun trying them out yourself than you would reading
about them. Nevertheless, let me give you a bird’s-eye view:

v The Add Note button lets you post a note on a calendar day. You use this
feature to create reminder notes that will also appear in the Alerts area
of the Cash Flow Center. For example, you may want to post a note saying
“Remember Wedding Anniversary” on the big day. After you click this
button, Quicken displays a dialog box in which you type the message.
Then you click Save My Butt. The program also marks the calendar day
with a little yellow square — a miniature stick-on note. Click the square
to read the message.
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v The Options button displays a menu of commands that let you specify
which transactions should appear in the Calendar, add an account bal-
ances graph to the Calendar window, and fiddle with the memorized
transactions list. The transactions shown in that list box along the right
edge of the Calendar window, by the way, are memorized transactions.
(Chapter 4 briefly discusses memorized transactions.)

v The Close button removes the Calendar from the Quicken desktop. But,
shoot, you probably figured that out already, didn’t you?



Chapter 13
Mutual Funds

In This Chapter

Knowing when to use Quicken investment record keeping
Setting up a mutual fund investment account

Recording your initial mutual fund investment

Buying mutual fund shares

Recording mutual fund profits

Selling mutual fund shares

Adjusting your mutual fund shares and price information

M utual fund record keeping is something that more of us need to think
about. More of us are investing as the population ages and we prepare
for retirement. And with the prevalence of battered 401(k) and brokerage
accounts, many of us need to more closely monitor our mutual funds.

Fortunately, Quicken provides great tools for managing your mutual fund
investments. And this chapter talks about those tools. But first, I should talk
about whether you even need to do this.

Deciding to Use Investment Features

The Quicken investment record keeping feature lets you do three important
things:

v Track your interest and dividend income

v Track real and potential capital gains and losses

v Measure an investment’s performance by calculating the annual return
from an investment
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If you're a serious investor, these things probably sound worthwhile. But
before you invest any time learning how Quicken investment record keeping
works, be sure that you need all this power.

Are your investments tax-deferred?

If your investments are tax-deferred — if, for example, you're using individual
retirement accounts (IRAs), 401(k)s, or Keoghs — you don’t really need to
track investment income and capital gains and losses. Tax-deferred invest-
ments have no effect on your personal income taxes in the United States. You
get a tax deduction for the money you stick into IRAs, for example, and any-
thing you take out is taxable. (Or in the case of a Roth IRA, you don’t get a
deduction for amounts you stick into the account, but then you also don’t get
taxed on amounts taken out of the account — which means that you don’t
need to closely account for Roth IRA investments at least for tax accounting
reasons.)

With tax-deferred investments — like deductible IRAs, 401(k)s, and Keoghs —
you record all that you should need to know via your checking account. Checks
earmarked for investment are categorized as IRA Deductions, for example,
while investment account withdrawals deposited into your checking account
are categorized as IRA Distributions. In other words, you don’t need to set up
special accounts for tracking your investments. Your bank accounts track
everything you need to keep track of.

Are you a mutual fund fanatic?

If you're a fan of mutual funds, you don’t need Quicken to measure the funds’
annual returns. Fund managers provide these figures for you in quarterly and
annual reports. In fact, part of what you're paying the mutual fund manager
for is record keeping and performance management.

Some investors don’t need Quicken

Let me give you an example of someone who doesn’t need to use the Quicken
program’s investments feature — me. Once upon a time, I bought and sold
common stocks, fooled around with half a dozen mutual funds, and learned
firsthand why junk bonds are called junk bonds. (Apparently, junk bonds are
more risky? And so fluctuate wildly in value?) Over the last few years, though,
I've simplified my financial affairs considerably.
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[ don’t invest directly in stocks, bonds, or mutual funds these days; instead, 1
stick money into an IRA. My investments don’t produce taxable dividends or
interest income, nor do they produce taxable or tax-saving capital gains or
losses. Money I put into the IRA is tax-deductible. And money I ultimately
take out of the IRA will be taxable.

I'm also sticking with a handful of mutual funds, but I don’t need to calculate
the annual return — that’s what mutual fund managers do. So I don’t need to
figure, for example, what my shares of Vanguard Total Stock Market Portfolio
(my favorite mutual fund) delivered as an annual return when I include both
the 3 percent dividend and the 10 percent price drop.

Because I don’t need to track investment income, or track capital gains and
losses, or calculate the progress of my investment portfolio, I don’t need
Quicken investment record keeping for my personal use.

Many investors do need Quicken

Of course, many people — including mutual fund investors — do benefit from
Quicken investment record keeping. If you routinely buy stocks and bonds,
you probably want to calculate your annual returns. What’s more, if you try
to monitor your capital gains and losses intelligently — and you should —
you want to know both what you originally paid for your securities and what
they’re worth currently.

The size of your investment portfolio isn’t an issue. For example, | have two
daughters who are saving money for college. (Actually, in a cruel twist of fate,
I am saving; they’re simply accumulating.) Although Beth and Britt haven’t
saved much money, and although they use mutual funds to keep things simple,
they do three things that cause nightmarishly complex record keeping for their
poor, overworked, and grossly underpaid accountant — Dad. They reinvest
their quarterly dividend income, pay annual maintenance fees, and coerce
their parents into adding more and more money to their investment portfolios.

What’s the big deal? All three things adjust the basis in the fund. And when
Beth and Britt sell their mutual fund shares, their gain (or loss) will be deter-
mined by subtracting the basis (the purchase price and all out-of-pocket costs)
from the sales proceeds.

The bottom line: Though Beth and Britt don’t have much money, the Bob
Cratchit of this little story needs to use Quicken to track their investments.
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Tracking a Mutual Fund

If you need to track a mutual fund investment, you need to know how to set
up a mutual fund account and then record your investment activities.

Even if you don’t invest in mutual funds, you shouldn’t skip this section. Under-
standing how mutual fund record keeping works makes tracking other, more
complicated investments — like stocks, bonds, Krugerrands, and commodity
options — much, much easier for you.

Setting up a mutual fund
investment account

Setting up an investment account to track a mutual fund works the same way
as setting up any other account:

1. Click the Investing Center button.

The Investing Center button, as a careful examination reveals, appears in
that row of buttons along the left edge of the window. Quicken, ever the
faithful companion, displays the Investing Center window. You may need
to click the My Data tab if it isn’t shown by default.

2. Click the Add Account button on the Investing Center window.

Quicken dutifully displays the first Quicken Account Setup dialog box
that you use to add a new Quicken account. You've seen this dialog box
a million times by now. It just asks you to name the financial institution
holding your investment account.

3. Identify the financial institution; then click Next.

Name the financial institution (bank, brokerage firm, or mutual fund
management company) holding your mutual fund investment account.
As you type the name, Quicken displays a list of companies that match
what you type. When you see the right name, click it and then click Next.
And, oh, if you don’t see the right name, indicate that you just want to
use the name you’ve typed and not a name from the list.

Note: If you select a financial institution that supports online setup,
Quicken displays a dialog box that asks whether you want to set the
account up manually or use a new, special online method. 'm assuming
here that you’ll set up the account manually.
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Figure 13-1:
The second
Quicken
Account
Setup

dialog box.
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After you complete Step 3, Quicken displays the second Quicken
Account Setup dialog box (shown in Figure 13-1).

Quicken Account Setup

What type of investment account would you like to add?

" Standard Brokerage
Use this for stocks, mutual funds, bonds, stock options. and stock purchase plans,

" IRA or Keogh

Use this for traditional Individual Retirement Accounts, Foth IRA's, Education IR&'s, Keogh plans,
529 plans, and SEP-IR&'s,

" 401(k] or 403(b]
Use thiz 401([k) and 403(b) retirement plans.

Use this for single mutual funds purchased directy from a mutual fund company. Dividends are
reinvested and there is no cash balance.

4. Identify the account type.

Use the dialog box shown in Figure 13-1 to indicate that you want to
create a mutual fund account.

Note: Quicken lets you set up a 401(k)-type account. Although I recom-
mend that you not bother tracking tax-deferred investments — especially
when someone else already does the record keeping for you — you can
set up an account for a 401(k) account. And then you can use that account
to monitor the account’s performance. The steps [ describe here for work-
ing with a mutual fund investment are the same basic steps you use for
working with a 401(k) account.

5. Click Next and then name the investment; then click Next again.

Quicken displays the third Quicken Account Setup dialog box (shown in
Figure 13-2). Move the cursor to the Name This Account text box and type
a name for the mutual fund. If you're investing in the Vanguard Index 500
Trust mutual fund, you might type Vanguard Index.

After you click Next, Quicken displays the fourth Quicken Account Setup
dialog box.

6. Provide the last statement date; then click Next.

The fourth Quicken Account Setup dialog box asks for the date of the
statement you’re using to enter your mutual fund shares, cost, and value
information. This date is the starting date, in essence, for your mutual
fund record keeping with Quicken. Enter the date and then click Next.
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Figure 13-2:
The third
Quicken
Account
Setup
dialog box.

Figure 13-3:
The fifth
Quicken
Account

Setup
dialog box.

Quicken Account Setup

Tell us about this account.

Mame this account: [\/anguard Index

Example: dcme Brokerage

I5 this a tax-deferred account?  ( Yes @ No

Mext

Back | |

7. Provide the ticker symbol; then click Next.

All this fifth dialog box does is collect the mutual fund’s ticker symbol
so that you can download share prices several times during the day and
drive yourself half mad with anxiety (see Figure 13-3). If you don’t know
the ticker symbol, click the Ticker Symbol Lookup button to display a
Quicken.com Web page that lets you find the ticker symbol.

Quicken Account Setup

What securities are in this account?

Enter a ticker symbol for each security in pour account,

w |f your computer is connected ta the Intemet, Quicken uses the ticker symbol to download security details for you.
1f you don't know the ticker spmbol, click Ticker Sypmbol Lookup.

w |f you are not connected to the Intemet, just enter a secuiity name. “Y'ou can add mare details later.

Ticker*

Secuiity Name [optional]

Ticker Symbol Lookup

* Required for downloading security details. Do not include bonds--add bond purchases later (in the transaction
list. click Enter Transactions.]

Cancel

Back | | Mext

After you click Next, Quicken displays the sixth Quicken Account Setup

dialog box, shown in Figure 13-4.

8. Provide a total shares count.

Enter the number of shares you hold in the mutual fund.
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|
Figure 13-4:
The sixth
Quicken
Account
Setup

dialog box.
|

|
Figure 13-5:
The
investment
window.
|

Quicken Account Setup

Enter your current holdings information.

This information will be used to et up your initial security holdings. For each security. enter the total number of
shares pou own and select a security type (if the security iz not a stock or mutual fund, click Other - you can

edit the security later),

Ticker  Security Mame

1004

‘When you are finished. Quicken will give you a chance to enter cost basis information.

Total Shares

Stock
[ (o)

tutual Fund

Other
s

Back

| | Mext

9. Click Next.

Quicken displays a dialog box summarizing the mutual fund investment
that you've just entered. If something seems amiss, click the Back button
to find the Quicken Account Setup dialog box where you entered some
incorrect bit of information. If everything seems okay, click Done. Quicken
displays an investment summary window for the new mutual fund invest-

ment (as shown in Figure 13-5).

Quicken 2005 Premier - gdataZ - [Wanguard Index] ==
File Edit Tools Online Cash Flow Investing Property & Debt Planning Tax Reports Help
3l B T 5 " T
@ @ A P L @ =3
Back  Update Reports  Setup  Services Quicken, com Customize
Quicken Home ﬁj Vanyuard Indez Summary | Performance & Analysis | Transactions
Enter Transactions | Set Up Download | How Do I?
)| Cash Flow Center
[ Checking 9,577.26 | | Holdings Options ¥
Cash Account 39.41
H 1 |S/18f2008
Savings 0,00 Shaw s of 1181
Credit Card -24,720.57
-$15,303.90 GainjLoss
. Name QuotefPrice Shares Markst Value Cost Basis Gain/Loss (%)
& e entes B vanquard Inds... 4 1000 0,00 Enter * #
Yanguard Index 0.00 4 3
$0.00 Totals! 0.00 0.00 0,00% 0.0%
*Placeholder Entries for missing data are used in these calculations,
~ | Property & Debt
Download Historical Prices
Acct Rec 1,000,000
Mortgage -99,900.45 Account Attributes Options + Account Status Options +
Payrol-FiH -18.00 Account Name Wanguard Index Security ¥alue $0.00
anrn::-:lSCARE jé:g Tax-Deferred Mo Cash Balance $0.00
ayral- 498, 9-79 lES Single: Mutual Fund? Ves Total Market Yalue $0.00
e Description Last Transaction 5/15/2005
Financial Institution Wanguard Group Last Reconcile one
Account Number Qutstanding Txns ko Compare 0
Transaction Download Avallable
Wievs on Quicken.cam Available
MNet Worth  -%114,283.55 titeb Page(s):
Financial Overview g Edit Account Details | Change Online Services =
M Hide Amounts % ‘Want ko track your business expenses the easy way?
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Recording your initial investment

After you set up a mutual fund investment account and describe the security,
you can record an initial purchase of fund shares.

Of course, you need to know the original price of those first shares. So dig
through that kitchen drawer where you stuff bank statements, financial
records, and those kooky birthday cards from Aunt Enid.

When you find the proper paperwork that shows the number of shares you
purchased and the price per share, here’s what you do:
1. Open the investment account, if it isn’t already open.

Display the Investing Center window; then open the investment account
by clicking the account name.

2. Tell Quicken you want to enter cost basis data.

Click the Enter hyperlink to the right of the mutual investment account.
Quicken displays the Enter Missing Transactions dialog box, shown in
Figure 13-6.

[ Enter Missing Tr. i

Enter Missing Transactions for Yanguard Index 500

This security iz missing all or part of its transaction history. When you downloaded or manually entered tranzactions, the tatal number of
shares in those transactions did not equal the tatal number of shares you own. Quicken has added a Placehalder Entry to account for
missing tranzactions.

To get complete performance reporting and tax calculations, enter the missing transactions now.

V. d Index 500 T i as of 5/15/2005

Date Transaction Descriplion
Erier MEodpr Faaiscoiins e comolahe ooaf Aawd

|
Figure 13-6:

The Enter Holdings as of 5/15/2005 Shares Cost

.. Total shares you own: 1.000 *

M I1Ssin g Shares from transactions [above] 0 000

Tra ns- Shares in Placeholder Entry 1.000 Unknown

a Ctl ons ‘ Enter Missing Transaction... | | Estimate Average Cost...
dialog box.

|

3. Click the Enter Missing Transaction button.

Quicken displays the Add Shares dialog box, shown in Figure 13-7. If you
don’t see the Add Shares dialog box — something Quicken seems to get
confused — select Shares Added from the Enter Transaction drop-down
list box.



|
Figure 13-7:
The Add
Shares
dialog box.
|
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[Ed Add - Shares Added

Enter trangaction |Add5harssAddEdj Enter the addition of shares of a security ta this account

without affecting the cash balance.

Add - Shares Added:

Transaction date:  [7/4/2005 Security name: | \i‘
Account: Humber of shares:

Mema:

Price paid; per share

Tokal cost 0.00
Date acquired: 74472005

[required for calculating tax]

| Cancel H Clear H Help Enter/MNew || Enter/Daone

Note: For you history buffs, let me mention that an investment record-
keeping tool available in old versions of Quicken, the investment register,
is no longer available in the newest version of Quicken. This makes me a
bit nostalgic. Was it really such a bad feature that they had to kill it? That
seems a little harsh to me. But no sense crying over spilt coffee. Once
you and I are used to the new, register-less way of doing things, I think
we’ll both be happier and more productive.

. Enter the date you first purchased the fund shares into the Transaction

Date field.

Move the cursor to the Transaction Date field and enter the date by using
the MM/DD/YY format. Enter January 1, 1992, for example, as 1/1/92.
You may also select the date from the pop-up calendar.

. [Optional] Enter a memo description.

If you want to tie the purchase to a confirmation order number, for
example, enter the data into the Memo field. | suppose that you could
use this field to record anything: Kilroy was here. Save the Whales.
Don’t tread on me.

. Indicate the size of your purchase.

To enter the total number of shares, move the cursor to the Number of
Shares field. (Fractional shares are okay.)

. Indicate what you paid per share.

With the cursor on the Adjusted Cost Basis field, enter the amount you
paid for the lot. After you supply Quicken with the adjusted cost basis, it
calculates the total cost.
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|
Figure 13-8:
The Enter
Missing
Transactions
dialog box
after one
enters all
the missing
trans-
actions.
|

8. Record the initial purchase of mutual fund shares by clicking Enter.

Quicken redisplays the Enter Missing Transactions dialog box (see
Figure 13-6).

9. Repeat Steps 2 through 8 if necessary.

You need to repeat Steps 2 through 8 to record any other lots you pur-
chased. For example, if you own 1,000 shares of Vanguard Index 500 but
you accumulated these shares by buying 200 shares five different times,
you need to record five separate lots of 200 shares a piece. The first time
through Steps 2 through 8, you record the first lot of 200 shares. The
second time through the steps, you record the second lot of 200 shares.
The third and subsequent times through the steps, if you're setting up

a mutual fund investment account that you didn’t really need to set up,
you ask yourself why you didn’t listen to me when I said you don’t need

and therefore don’t want to do this for tax-deferred investments.

After you describe each lot that makes up your holdings of the mutual fund

investment, the Enter Missing Transactions dialog box shows that there aren’t

any placeholders for missing transactions because the shares placeholder
and the cost placeholder should both equal zero (see Figure 13-8). You can
click Done.

If you make a mistake in entering a transaction, you can click the Edit or
Delete buttons to the right of the transaction to change or remove the erro-
neous data.

Enter Missing Transactions

Enter Mizsing Transactions for ¥anguard Index 500

This security is missing all or part of its transaction histoy. 'When you downloaded or manually entered transactions, the total number of
shares in thoze tranzactions did not equal the total number of shares you own. Quicken has: added a Placeholder Entry to account for
migsing ransactions.

Ta get complete performance reporting and tax calculations, enter the missing ransactions now.

d Index 500 T ions as of 5/15/2005
Transaction  Description
Bought 20
Bought

Edit| Delete|
10412000 Bought 200 shares @15 Edi Delete
4414200 Bought 200 shares @ 14 Edi Delete
1243172003 Bought 200 shares @ 16 E dit Delete]
Holdings as of 5/15/2005% Shares Cost
Total shares you own: 1.000 13.400.00
Shares from transactions [sbove] 1.000 13.400.00
Shares in Placeholder Entry 0 0.00
‘ Enter Mizsing Transachion | |




|
Figure 13-9:
The Shares
Bought
dialog box.
|
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Buying investments

As you purchase shares — by sending a check to the mutual fund manage-
ment company or by reinvesting dividends and capital gain distributions —
record the transactions for the investment account.

By writing a check
If you buy shares by writing a check, display the investment window (such as
by clicking the Investment Center button and then the investment account)
and then record the purchase by following these steps:
1. Click the Enter Transactions button.
Quicken displays the dialog box used to enter investment transactions.
2. Select Shares Bought from the Enter Transaction drop-down list box.

Quicken displays the Shares Bought version of the investment transac-
tion entry dialog box, as shown in Figure 13-9.

[E Buy - Shares Bought

Enter transaction: |§g}g cSharesBought j Enter the purchase of shares of a security [subtiact the cost
from my cash balance).

Buy - Shares Bought:
Transaction date:  [5/16/2005 Security name: [ ]

Account: Mumber of shares:
Price paid per share

Merma: Commission 0.00
Total cost 0.00

+ From hd

| Cancel H Clear H Help Enter/New || Enter/Dane

3. Enter the purchase date into the Transaction Date field.
4. [Optional] Enter a Memo description.

5. Enter the bank account on which you’ll write the check that pays for
the shares.

Select the account name from the From drop-down list box.
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6. Indicate the size of your purchase by using the Shares and the Price
fields.

Tell Quicken the size of your investment by giving the number of shares
purchased and the price paid per share.

7. Enter the commission or fee that you paid.

Move the cursor to the Commission field and enter the commission or
fee you paid to purchase the shares. (The amount shown in the Total
Cost field includes this figure.)

8. Record the purchase.

Click the Enter/New button if you want to record the transaction and
enter another new transaction. Or, click the Enter/Done button if you
want to record just the single transaction. Quicken records your pur-
chase of new shares. You are now a capitalist. Congratulations.

By reinvesting dividends, interest, or capital gains

When you reinvest your dividends, interest, or capital gains, you also must
record your reinvestment transactions. Essentially, you’re buying new shares
using the dividend or capital gain proceeds you could have received. To
record the reinvestment of mutual fund distributions, display the investment
window (such as by clicking the Investment Center button and then clicking
the investment account) and then follow these steps:

1. Click the Enter Transactions button.
Quicken displays the dialog box used to enter investments transactions.

2. Select Income Reinvested from the Enter Transaction drop-down
list box.

Quicken displays the Income Reinvested version of the investment
transaction entry dialog box, as shown in Figure 13-10.

3. Enter the purchase date (in this case, the reinvestment date) into the
Transaction Date field.

4. [Optional] Type a brief explanation of the transaction into the Memo
field.

5. Use the Amount and Shares columns to describe the reinvestment.

Take another look at Figure 13-10. No, really, go ahead. I'll wait. See those
rows labeled Dividend, Interest, Short-Term Cap Gain Dist, Mid-Term Cap
Gain Dist, and Long-Term Cap Gain Dist? And see the columns labeled
Amount and Shares? Use these rows and columns to record the amounts
of dividends, interest, and capital gains distributed to you by the mutual
fund and to record the numbers of shares you purchase by reinvesting
these amounts. For example, if you receive $100 of dividends and use this
amount to purchase 2 shares, you enter 100 into the Dividend Amount
box and 2 into the Dividend Shares box.
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Reinvest - | Reinvested
Enter transaction: Reinvest - Income Reinvested j Enter the reinvestment of income. Use for reinvested interest,
dividends, or capital gains distibutions.
Reinvest - Income Reinvested:
Transaction date;  [6/30/2005 Security name: | u
Socot :| Armnount Shares
Diidend: [foo.00 3
Mema: Interest |25 0o ‘D 5
| Sharttermn cap gain dist: [200.00 4
Mid-term cap gain dist: | IEI ‘
EEE— Long-term cap gain dist: | @ ‘
Figure 13-10:
Price per share:
The Income
Reinvested Total 326,00 ES
dla lOg bOX' | Cancel ‘ | Clear | ‘ Help Enter/MNew | | Enter/Daone
|

6. Record the reinvestment transaction.

Click the Enter/New button if you want to record the transaction and
enter another new transaction. Or, click the Enter/Done button if you
want to record just the single transaction.

Figure 13-10 shows $100 of dividends being reinvested in the mutual fund by
buying 2 more shares, $25 of interest being reinvested by buying 0.5 (or half
of a) share, and $200 of short-term capital gains being reinvested by buying

4 shares.

Recording your profits

Every so often, you may receive distributions directly from the mutual fund
company. Retirees, for example, often receive mutual fund dividend checks
and capital gains directly rather than reinvesting the amounts.

To record these kinds of distributions, you follow a process very similar to
those I describe in the preceding set of steps. For example, to record an
income transaction directly into the investment account, follow these steps:

1. Click the Enter Transactions button.

Display the investment window — such as by clicking the Investing Center
button and then clicking the Enter Transactions button. Quicken displays
the dialog box used to enter investment transactions.
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2.

|
Figure 13-11:
The Income

dialog box.
|

Select Income from the Enter Transaction drop-down list box.

Quicken displays the Income version of the investment transaction entry
dialog box, as shown in Figure 13-11.

Inc - Income (Div, Int, etc.)
Enter transaction: |Inc - Income [Div, Int, ete.] ﬂ Enter the receipt of cash income (interest, dividends. or capital

gaing distibutions] that you did NOT reinvest.

Inc - Income [Div. Int. etc.):

Transact